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Legal Notice
Copyright 2009 - 2024 Open Text.

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as may be set 
forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. Open Text shall not be liable for technical or editorial errors or omissions contained 
herein. The information contained herein is subject to change without notice.

For additional information, such as certification-related notices and trademarks, see https://www.microfocus.com/en-us/ 
(https://www.microfocus.com/en-us/).
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About This Guide

This manual provides you information about administering SecureLogin. 

Additional Documentation
For the latest version of SecureLogin guides, see the SecureLogin Documentation portal. 

Contact Information
We want to hear your comments and suggestions about this book and the other documentation 
included with this product. You can use the comment on this topic link at the bottom of each page of 
the online documentation.

For specific product issues, contact Micro Focus Customer Care at https://www.microfocus.com/
support-and-services/.
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1 1Getting Started

NetIQ SecureLogin is an enterprise single sign-on product. It provides authentication solutions to 
web, Windows, host, and legacy application-based single sign-on. It functions as an identity overseer 
for all the systems that users access. 

It is a credential management tool developed to increase an organization’s network security and 
reduces support costs. It securely manages and encrypts the authentication information in a 
directory. It stores user names and passwords and automatically retrieves them for users when 
required.

 Section 1.1, “Recommendations,” on page 13
 Section 1.2, “Administrative Management Utilities,” on page 13
 Section 1.3, “Additional Information,” on page 14

1.1 Recommendations
A thorough understanding of the following subjects is required to configure and administer 
SecureLogin:

 Microsoft Active Directory
 Microsoft Management Console (MMC)
 Microsoft Group Policy Object Management Console (GPMC)
 Microsoft Windows operating systems
 Lightweight Directory Access Protocol (LDAP)

1.2 Administrative Management Utilities
IMPORTANT: The NetIQ iManager product is discontinued and reached end-of-life. Therefore, 
SecureLogin has stopped the iManager support. If eDirectory is deployed as part of OES deployment, 
refer to the OES support cycle of iManager.

It is recommended to use SLManager in place of iManager for administering SecureLogin. 
Limitations of SLManager over iManager: SLManager does not support concurrent connections and 
configured groups.

For any references of iManager on previous versions of NetIQ SecureLogin, see NetIQ SecureLogin 
8.8 Documentation.

In this Section

 Section 1.2.1, “SLManager,” on page 14
 Section 1.2.2, “Microsoft Management Console Snap-In,” on page 14
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1.2.1 SLManager
You can use SecureLogin Manager (SLManager) for any LDAP deployments, such as AD and 
eDirectory.

Starting SLManager

1 On the Start menu, select Programs > NetIQ SecureLogin > SecureLogin Manager. The 
Administrative Management utility is displayed.

NOTE: To use SLManager, Administrative Tools must be installed. Select the Administrative Tools 
option from the custom setup screen during the installation. If Administrative Tools is not 
installed, use the Modify option from the installer to install it and start SLManager. 

2 In Object, specify your object name, then press the Enter key.
You must press the Enter key to submit the entry typed in Object. Clicking OK closes the dialog 
box, but does not accept the entry you typed. The object name must be in the LDAP convention 
(username, objectname) if you are using the LDAP mode and in the eDirectory convention 
(username. objectname) if you are using the eDirectory mode.

1.2.2 Microsoft Management Console Snap-In
Use the Microsoft Management Console (MMC) snap-in for Active Directory deployments.

On the Windows Start menu, select Programs > Administrative Tools > Active Directory Users and 
Computers. MMC is displayed.

1.3 Additional Information 
 Enforcing Users to Change Passwords Before the Grace Login Expires
 Support for Oracle Forms
 Notifications for Single Sign-On Applications
 Indication for an Active SecureLogin User
 Keyboard Shortcuts
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1.3.1 Enforcing Users to Change Passwords Before the Grace Login 
Expires
SecureLogin allows administrators to enforce users to change their password before the grace login 
expires.

For example, SecureLogin is installed in the LDAP mode with eDirectory. When the password expires, 
the authentication process consumes all the grace logins and users cannot log in. To avoid this, 
create the following registry keys:

 GraceDaysBeforePasswordExpire registry of DWORD value. This displays a warning 
message to the users about the number of days remaining for password expiry. 

 DaysForcePasswordChange of DWORD value. This forces the users to change their 
passwords. Although the grace login available, this forces the users to change their password 
before the grace login expires.

For example, if the password policy is set to change every 90 days, the 
GraceDaysBeforePasswordExpire can be set to 5 and DaysForcePasswordChange can be 
set to 3. On the day 85 when users logs in, a message indicating the number of days left before 
password expiry appears. Users can choose to change the password immediately or change it later. 

Similarly, when a users logs in on day 87 another message appears that forces the users to change 
the password. They cannot continue without changing the password. 

NOTE: It is recommended to keep the grace login value greater than 2 as SecureLogin utilizes one 
grace login count for every connection with the directory. 

1.3.2 Support for Oracle Forms
SecureLogin supports single sign-on to Oracle Forms that uses Java 1.7 or 1.8. If any of these Java 
components is added in the machine after installing (or upgrading to) SecureLogin, you need to 
enable SecureLogin to use the newly added Java component. To enable support to the new Java 
component, run the repair option of the SecureLogin installer.

1.3.3 Notifications for Single Sign-On Applications 
When you launch any application that is available for single sign-on, SecureLogin displays a 
notification in the system tray indicating that the application can be selected for single sign-on. If you 
do not want to single sign-on to an application when it is launched then, you can ignore the 
notification and proceed. When you ignore the notification, the color of the icon changes from blue 
to orange indicating that web pages are available for single sign-on. You can view the list of web 
pages by clicking the icon on the system tray and selecting the application to single sign-on. 

1.3.4 Indication for an Active SecureLogin User
You can identify the active SecureLogin user with the help of the visual cue in the task bar. This visual 
cue displays the details of the active user such as First name, Last name, Full name, Distinguished 
name, or Default name based on the preference settings. To modify these preferences, see Display 
Getting Started 15



user name on task bar. These preferences are refreshed every 30 seconds by default. You can also 
modify the refresh time interval by modifying the value of the registry key 
UserbarRefreshInterval. 

In addition, you can add prefix to the user name displayed in the task bar. To add prefix, you must set 
the prefix text as a value for the registry key UserbarPrefix. These registry settings are available 
at HKEY_LOCAL_MACHINE\SOFTWARE\Protocom\SecureLogin.

SecureLogin does not display the logged in user name by default in the task bar. For user name to be 
displayed in the task bar, you must right-click the SecureLogin icon on the notification area (system 
tray) and select Show User bar or you can right-click the task bar and select Toolbars > 
SecureLogin SSO User.

1.3.5 Keyboard Shortcuts 
You can use the keyboard shortcuts to navigate to the required options. 

Key combination Result

Ctrl+Shift+A Launches the New Application window.

Ctrl+L Launches the Create Login window. 

Ctrl+P Launches the New password policy window

Delete Deletes the selected application, login, and password policy.
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2 2Configuration Tasks Before Deploying 
SecureLogin

The names of user IDs, applications, and password policies must be unique. You cannot create an 
application named Error.

Before you deploy SecureLogin, you must complete the following configuration tasks:

 Section 2.1, “Setting User Preferences,” on page 17
 Section 2.2, “Disabling User Access,” on page 17
 Section 2.3, “Updating the Datastore Objects,” on page 18
 Section 2.4, “Changing the Organizational Unit Level Datastore,” on page 18
 Section 2.5, “Changing the Directory Datastore,” on page 19
 Section 2.6, “Deleting or Re-setting User Data,” on page 20

2.1 Setting User Preferences
You can set the user preferences in the Preferences page for any of the administrative management 
utilities. Each user preference has a default value that is implemented until an alternative value is 
set. In directory hierarchies, the preference values are inherited from higher level objects. However, 
the preference values set at the user object level override any values inherited from other objects in 
the directory.

You can restrict users from setting or modifying the preferences.

2.1.1 Changing a Preference Value
1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Preference. 
3 Locate the setting you want to change and specify the appropriate value in the Value column.
4 Click OK. 

2.2 Disabling User Access
By default, a user has permission to change application definitions and predefined applications, 
passwords, and functionality. You do this through the administrative management utilities.

Several options are available for restricting user access by setting preferences at the user, group 
policy, container, or organizational unit level. This includes:

 Full access to all administrative tools.
 Access to selected administrative tools.
Configuration Tasks Before Deploying SecureLogin 17



 Hiding the SecureLogin icon on the notification area (system tray).
 Hiding and password protecting the SecureLogin icon in the notification area (system tray).

If the SecureLogin icon is password protected, anyone attempting to access the SecureLogin Client 
Utility through the SecureLogin icon is prompted to provide the network password. This prevents 
non-authorized users from viewing SecureLogin data. However, an authorized user can use the 
administration tools to modify SecureLogin.

2.3 Updating the Datastore Objects
The SecureLogin datastore includes a range of security features, including storing the single sign-on 
credentials on the user’s smart card, encrypting the datastore by using the Public Key Infrastructure 
(PKI)-based credentials and the Advanced Encryption Standard (AES) encryption algorithm support.

The SecureLogin datastore version 6.0, or later client can read data from the 3.x version of the 
datastore. However, the older versions of SecureLogin cannot read the data from the 6.0 and later 
versions of the datastore. In case of a mixed corporate environment in which some workstations are 
running SecureLogin 8.5, and the other workstations are running previous versions of SecureLogin, 
when a user moves between different versions of SecureLogin on different workstations the data 
gets incompatible. This is particularly a problem in Citrix environments or in large enterprise 
deployments.

If the SecureLogin datastore version 3.x is present when you install SecureLogin 8.5 then, 
SecureLogin detects 3.x data and continues to function correctly.

If you require the new functions, complete the following processes:

1. Choose a section of the tree to upgrade.

For example:
 Container 
 Group
 Organization
 User

2. Make sure that all user workstations in that section of the tree are upgraded with the latest 
SecureLogin client.

The next time users log in, their data is converted to the latest version format and the new functions 
will be available.

2.4 Changing the Organizational Unit Level Datastore
In this Section

 Changing the Organizational Unit Level Datastore in an Active Directory Environment
 Deploying an Upgrade
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2.4.1 Changing the Organizational Unit Level Datastore in an Active 
Directory Environment
Perform the following to set the directory datastore version at the organizational unit level in an 
Active Directory environment:

1 On Microsoft Windows Server or Client: On the Windows Start icon, select Windows 
Administrative Tools > Active Directory Users and Computers.

2 Right-click the required group policy, container, or OU, then click Properties.
3 Click the SecureLogin tab. The SecureLogin page is displayed.
4 Click Manage. 
5 On the left pane, click Advanced Settings. 
6 Click the Datastore tab.
7 From the Select version drop-down list, select the required version. A warning is displayed.

The warning message refers to 3.0 clients that were used by some users who later upgraded the 
datastore mode to version 7.0. 
When a user’s directory data version is upgraded, the datastore information displayed in the 
SecureLogin About box is not updated. To update this information, the user must activate 
Refresh Cache from the Advanced menu of the SecureLogin icon on the notification area 
(system tray).

2.4.2 Deploying an Upgrade
When you are deploying an upgrade across a series of workstations, follow the procedure explained 
in Section 2.5, “Changing the Directory Datastore,” on page 19. The next time when the directory 
server and the workstation caches are synchronized and SecureLogin operates in the new version 
mode.

2.5 Changing the Directory Datastore
When the directory is upgraded, the new features of SecureLogin are not available on the 
workstation. So, users must upgrade to the new version.

You can configure directory datastore version at the group policy, user object, container, or 
organizational unit levels. Set the datastore version at the container or the organization unit levels. 
This helps enterprises to manage the datastore base and minimize the possibility of conflicting 
versions.

If you require to update a single new feature of SecureLogin preference that requires 7.0 datastore, 
you are prompted with a warning before proceeding to change. For example, when you upgrade the 
Use AES for SSO data encryption preference.
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2.6 Deleting or Re-setting User Data
If a user forgets the network password and passphrase answer (if the passphrase system is enabled), 
or if the login credential data has got corrupt, you can delete all the SecureLogin information for that 
user. 

You as an administrator must do this because the user does not have access to the administrative 
management utilities.

Before you delete a user’s datastore object, consider the following important aspects:

To reset the user data: 

1 Launch the Administrative Management utility (SLManager or MMC snap-ins). 
2 Click Delete in the Datastore section. A warning message appears.
3 Click Yes. The Datastore object is deleted.

If you did not delete the SecureLogin cache from the local cache, before you deleted the 
Datastore object data, you get an error message.

NOTE: When SecureLogin is installed in the SecretStore environment, the data will not be 
deleted from the SecretStore datastore.

4 Click Yes.
When you do this, you delete the complete data of the user, including:
 Credentials including usernames and passwords
 Application definitions
 Predefined applications
 Password policies
 Preferences
 Passphrase questions and answers

User Data Re-set Option Action

Select the required directory object only The Delete single sign-on configuration for this datastore 
object option is available at the container, group policy, ou, 
and user object level.

Record (external to SecureLogin) all 
usernames, password, and additional 
required credential information

For example, if you delete a single sign-on-enabled application 
at the ou level, you might also be deleting the credentials for 
all users that reside in that container.

Delete the local cache on the workstation The object or user continues to inherit configuration from 
higher-level objects in the directory even though you deleted 
the user data in the directory cache.

This means that you should delete the local cache on the 
workstation first. This ensures that it does not synchronize 
with the directory cache and re-create the configuration in the 
directory.
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WARNING: The deleted data cannot be retrieved. 

The next time the user logs in, the user is asked to set up a new passphrase question and 
response and re-enter the credentials for each application enabled for single sign-on.
SecureLogin supports setting a cache expiry by using the following registry entry on the client:
HKEY_LOCAL_MACHINE/SOFTWARE/Protocom/SecureLogin
DWORD Value CacheExpiryDays
The value data is the number of days. Do not provide zero (o) because the cache would expire 
immediately on refresh. The cache expiry period is updated at each cache or directory 
synchronization, or each time SecureLogin loads in an online mode.

NOTE: No warning is provided at cache expiry. If a cache is expired, the users cannot access 
SecureLogin in an offline mode until they log in, and create the cache again in an online session.
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3 3Managing Preferences

SecureLogin preferences are tools, options, and parameters used by the enterprise administrators to 
configure the user’s SecureLogin corporate environment. You can restrict a user’s access to 
SecureLogin preferences through administrative management utilities. 

Preferences also include applications that are permitted to be enabled for single sign-on and the 
tools to enable users to access their own SecureLogin management and administration functions.

You can configure user preferences in the Preference properties table using administrative 
management utilities. 

In this Chapter

 Changing Rights for Installing JREs
 Preferences Categories
 Default Preference Values
 Setting User Preferences
 Setting the Preferences
 Configuring the Exclude.ini File

3.1 Changing Rights for Installing JREs
SecureLogin checks for new JREs installed on the client when SecureLogin is launched. If new JREs 
are detected and they are allowed by user’s permissions, the new JREs are enabled for single-sign on 
automatically, without any user prompts or intervention.

The JRE update process requires local administrative rights on the client. If the user is not logged in 
with administrative rights, the update fails without displaying any notification to the user. 

The JREs are updated the next time the user logs in with administrative rights and launches 
SecureLogin on the workstation. 

3.2 Preferences Categories
SecureLogin preferences are divided into the following categories:

 .Net
 Auditing
 General
 Java
 Security
 Web
 Windows
 Wizard
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3.3 Default Preference Values
Each preference value has a default value that is implemented during installation or deployment. 
You can configure alternative values.

Inheriting Preference Values: In corporate directory hierarchies, preference values are inherited 
from higher-level objects. Some lower-level objects can override preferences set at higher-levels. 
Therefore, the preference values set at the user object-level override all higher-level object values.

3.4 Setting User Preferences
You can set SecureLogin user preferences in the Preferences Properties table in the Administrative 
Management utilities (SLManager or MMC snap-ins). 

Each SecureLogin preference has a default value. In directory hierarchies, preference values are 
inherited from a higher-level object, while some lower-level objects can override preference set at 
higher level. For example, preference values set at the user object level override all higher level 
object values.

NOTE: This can be controlled for users by restricting their ability to set preferences.

For more information about inheriting configuration settings, see Distributing Configurations.

3.5 Setting the Preferences
Set preferences for managing SecureLogin in the Administration Management utility:

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Preferences. 
3 Make the changes as required and click OK.

Use the information in the following tables while making the changes:

 Table 3-1, “.Net Preferences,” on page 25
 Table 3-2, “Auditing Preferences,” on page 25
 Table 3-3, “General Preferences,” on page 26
 Table 3-4, “Java Preferences,” on page 34
 Table 3-5, “Web Preferences,” on page 35
 Table 3-6, “Windows Preferences,” on page 39
 Table 3-7, “Wizard preferences,” on page 41
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Table 3-1   .Net Preferences

NOTE: To apply the changes, restart SecureLogin.

Table 3-2   Auditing Preferences

Preference Possible Values Description Default Value

Add application prompts 
for WindowsAutomation 
(DotNet) applications

Yes/No/Default This preference prompts to add a .Net 
application for defining the application 
definition.

If this preference is set to No then, the Add 
Application window is not launched when you 
launch any .Net application.

Yes

Allow single sign-on to 
WindowsAutomation 
(DotNet) applications

Yes/No/Default This preference allows SSO to .Net applications.

If this preference is set to No then, the 
application will not be available for SSO.

Yes

Start the 
WindowsAutomation 
(DotNet) monitor/
automation worker

Yes/No/Default This preference starts the DotNetSSO process.

The Start the WindowsAutomation (DotNet) 
monitor/automation worker preference 
replaces the DISABLE_DOTNETSSO registry 
setting.

Yes

Preference Possible Values Description Default Value

Enable logging to SysLog 
server

Yes/No/Default This preference controls sending the log events 
to SysLog server.

If set to No or Default, log events are not sent 
to SysLog server.

If set to Yes, log events are redirected to SysLog 
server from Windows Event log.

No

Enable logging to 
Windows Event log

Yes/No/Default This preference controls sending the log events 
to Windows Event Log. This includes the entire 
user configuration, both local and inherited.

If set to Yes or Default, log events are sent 
automatically to Windows Event Log.

If set to No, the log events are not sent to 
Windows Event Log.

NOTE: This preference requires SecureLogin 6.0 
datastore if the value is changed.

Yes
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Table 3-3   General Preferences

Preference Possible Values Description Default Value

Allow 
application 
definitions to be 
modified by 
users

Yes/No/Default This preference controls whether users can modify 
application definitions using the Definitions tabs in the 
Applications pane of SecureLogin client.

If this option is set to Yes or Default, the end user can 
view and modify their application definitions.

If this option is set to No, the end user cannot change 
their application definition.

NOTE: If the Allow application definition to be viewed by 
users is set to No, then this option is cannot be edited.

Disabling this preference does not disable the users from 
creating new applications through the wizards.

This preference requires SecureLogin 6.0 datastore if the 
value is changed.

Yes

Allow 
application 
definitions to be 
viewed by users

Yes/No/Default This preference controls whether users can view 
application definitions using the Definitions tabs in the 
Applications pane of SecureLogin client.

If this option is set to Yes or Default, users can view the 
application definition.

If this option is set to No, users cannot view the 
application definition.

Yes

Allow 
credentials to 
be deleted by 
users through 
the GUI

Yes/No/Default This preference controls whether users can delete their 
credentials using SecureLogin client available from 
Manage Logins from the SecureLogin icon in the 
notification area (system tray).

NOTE: If Allow credentials to be modified by users 
through the GUI is set to No, then this option is 
automatically set to No and not editable.

This preference requires SecureLogin 6.0 datastore if the 
value is changed.

If this option is set to Yes or Default, users can delete 
their credentials through the GUI.

If this option is set to No, users cannot delete their 
credentials.

Yes
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Allow 
credentials to 
be modified by 
users through 
the GUI

Yes/No/Default This preference controls whether users can modify their 
credentials using SecureLogin client available from 
Manage Logins from the SecureLogin icon in the 
notification area (system tray).

If this option is set to Yes or Default, users can modify 
their credentials through the GUI.

If this option is set to No, users cannot modify their 
credentials through the GUI. They can only view the 
credentials.

Yes

Allow user to 
set Obscure 
Show Password

Yes/No/
Default

This preference controls whether the user can modify the 
Obscure Show Password option.

If this option is set to Yes or Default, users can modify the 
Obscure Show Password option and change the duration 
of time a password is visible.

If this option is set to No, users cannot modify the 
Obscure Show Password option.

Yes

Allow users to 
(de) activate 
SSO via system 
tray

Yes/No/Default This preference controls whether users can activate or 
deactivate SecureLogin through the SecureLogin icon in 
the notification area (system tray).

If this option is set to Yes or Default, users can switch 
between active and inactive modes of SecureLogin.

If this option is set to No, users cannot switch between 
active and inactive modes.

  If SecureLogin status was active when this 
preference was applied, it remains as active and the 
user cannot de-activate SecureLogin.

 If SecureLogin status was inactive when this 
preference was applied, it remains as inactive and 
the user cannot change SecureLogin status to 
Active.

This preference requires SecureLogin 6.0 datastore if the 
value is changed.

Yes

Allow users to 
backup/restore

Yes/No/Default This preference controls whether users can backup and 
restore their information from the Advanced menu of 
the SecureLogin icon on the notification area (system 
tray).

If this option is set to Yes or Default, users can back up 
and restore their SSO information.

If this option is set to No, users cannot back up and 
restore their SSO configuration.

Yes

Preference Possible Values Description Default Value
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Allow users to 
close 
SecureLogin SSO 
via system tray

Yes/No/Default This preference controls whether users can access the 
Close option from the SecureLogin icon on the 
notification area (system tray).

If the option is set to No, the Close option is shown as 
disabled in the SecureLogin notification area.

If this option is set to Yes or Default, the Close option is 
accessible in the SecureLogin notification area.

NOTE: This preference requires SecureLogin 6.0 
datastore if the value is changed.

Yes

Allow users to 
log off via 
system tray

Yes/No/Default This preference controls if users can log out from a 
session using Log Off User option from the SecureLogin 
icon on the notification area (system tray).

If this option is set to No, the Log Off User option is not 
displayed and accessible in the SecureLogin notification 
area (system tray) icon.

If this option is set to Yes or Default, the Log Off User 
option is displayed and accessible in the SecureLogin 
notification area (system tray) icon.

Yes

Allow users to 
modify names 
of Applications 
and Logins

Yes/No/Default This preference controls whether users can edit the 
names of their Application login credentials using the 
Details tab > Edit function in SecureLogin client.

If this option is set to Yes or Default, the user can edit the 
names of their credentials (either by right-clicking on the 
credential and selecting Rename, or by a slow double-
click on the credential name).

If this option is set to No, the use cannot edit the names 
of the credentials.

Yes

Allow users to 
view and 
change 
preferences

Yes/No/Default This preference controls whether users can view and 
update their preferences.

If this option is set to Yes or Default, users can view and 
change their preferences.

If this option is set to No, users cannot view and change 
their preferences.

NOTE: Create a separate ou for administrators to ensure 
that they are not adversely affected by the general user 
configuration preferences at the ou level.

Yes

Preference Possible Values Description Default Value
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Allow users to 
view and 
modify API 
preferences

Yes/No/Default This preference controls whether users can view and 
modify API options using the Preferences pane of 
SecureLogin client.

The API preference defines the following options for 
users to:

 Enter an API license key.
 Provide API access.

If this option is set to Yes or Default users can view and 
modify the API preference.

If this option is set to No, users cannot view and modify 
the API preference.

NOTE: This preference affects what is displayed in 
SecureLogin client using Change Preferences from the 
Advanced menu.

Yes

Allow users to 
view passwords

Yes/Yes, per 
application/
No/Default

This preference controls whether users can view their 
passwords using Show Passwords in the Application pane 
> Details of SecureLogin client.

If this option is set to Yes or Default, users can view their 
passwords.

If this option is set to No, users cannot view their 
passwords.

NOTE: Allowing users to view their passwords gives them 
an opportunity to view and record passwords if they 
need to reset the SecureLogin configuration.

Yes

Change the 
cache refresh 
interval (in 
minutes)

5 This preference defines the time in minutes the 
synchronization of user data and directory on the local 
workstation.

This preference is available in both SecureLogin client 
and the administrative management utilities (SLManager 
and MMC snap-ins).

 5 minutes

Display splash 
screen on 
startup

Yes/No/Default This preference controls the display of the SecureLogin 
splash screen during startup.

If this option is set to Yes or Default, the splash screen 
appears when SecureLogin starts up.

If this option is set to No, the splash screen is hidden and 
users cannot see the splash screen when SecureLogin 
starts up.

NOTE: This preference requires SecureLogin 6.0 
datastore if the value is changed.

Yes

Preference Possible Values Description Default Value
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Display user 
name on mouse 
over tray icon 

Yes/No/
Default

This preference allows SecureLogin to display the current 
user name when you mouse over the SecureLogin tray 
icon.

When the user logs in to SecureLogin in the offline mode, 
the full qualified distinguished name (FQDN) is displayed 
when you mouse over the SecureLogin tray icon. In the 
online mode, the current user’s full name is displayed.

No

Display user 
name on task 
bar

Disable/First 
name/Last 
name/Full 
name/
Distinguished 
name/Default

This preference controls the display of the logged in user 
name on the task bar.

If this option is set to Disable, the logged in user name is 
not displayed on the task bar.

If this option is set to First name/Last name/Full name/
Distinguished name/Default, based on the selection 
respective value is displayed on the task bar.

NOTE: For the logged in user name to be displayed in the 
task bar, you must right-click the Secure Login icon on the 
notification area (system tray) and select Show User bar 
or you can right-click on the task bar and select Toolbars -
> SecureLogin User.

This preference is available in both the SecureLogin Client 
Utility and all the administrative management utilities 
(SLManager and MMC snap-ins).

Disable

Detect incorrect 
passwords

Yes/No/Default Predefined applications generally include commands to 
respond to incorrect password dialogs. This preference 
enables SecureLogin to respond to incorrect passwords 
for web applications.

If this option is set to Yes or Default, incorrect passwords 
for Web applications are detected.

If this option is set to No, incorrect passwords for Web 
applications are not detected.

This preference is available in both SecureLogin client 
and the administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Disable single 
sign-on

Yes/No/Default This preference controls the users access to running 
SecureLogin.

If this option is set to Yes, access to SecureLogin is 
disabled and it will not start when run either 
automatically at startup or when run manually.

If this option is set to No or Default, access to 
SecureLogin is enabled and will start normally. 

No

Preference Possible Values Description Default Value
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Display the 
system tray icon

Yes/No/Default This preference controls the display of SecureLogin icon 
in the notification area (system tray).

If this option is set to Yes or Default, the SecureLogin icon 
appears on the notification area (system tray).

If this option is set to No, the SecureLogin icon does not 
appear on the notification area (system tray).

NOTE: When the SecureLogin icon is visible, users can 
double-click the icon on the notification area (system 
tray) to launch SecureLogin client.

When the SecureLogin is not visible, users can start 
SecureLogin client through Start > Programs > NetIQ 
SecureLogin > NetIQ SecureLogin.

Yes

Enable cache 
file

Yes/No/Default This preference controls creating and updating of a 
SecureLogin cache file on the local workstation. The 
cache file stores all user configuration data; local and 
inherited.

Set this option to Yes or Default, the cache file is saved 
on the local workstation in the directory that was 
specified during install.

Users with roaming profiles are recommended keep this 
setting as Yes.

Set this option to No if you cannot store cache files 
locally or if this causes conflicts with your organizational 
security policy.

This preference is available in both SecureLogin client 
and the administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Preference Possible Values Description Default Value
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Enable logging 
to Windows 
Event log

Yes/No/Default This preference controls sending the log events to 
Windows Event Log. This includes the entire user 
configuration, both local and inherited.

If set to Yes or Default, log events are sent automatically 
to Windows Event Log.

If set to No, the log events are not sent to Windows Event 
Log.

Only the following events are logged:

 SSO client started
 SSO client exited
 SSO client activated by user
 SSO client deactivated by user
 Password provided to an application by a script
 Password changed by the user in response to a 

change password command
 Password changed automatically in response to a 

change password command.

NOTE: This preference requires SecureLogin 6.0 
datastore if the value is changed.

Yes

Enable the New 
Login Wizard on 
the system tray 
icon

Yes/No/Default This preference controls whether users can create 
multiple logins on the same application using the New 
Login > Add New Login option from the NetIQ 
SecureLogin icon on the notification area (system tray).

If this option is set to Yes or Default, the New Login menu 
option is enabled and users can create multiple logins.

If this option is set to No, New Login menu option is 
disabled and users cannot create multiple logins.

Yes

Enforce 
passphrase use

Yes/No/Default This preference forces users to set up a passphrase 
question and answer when SecureLogin is launched by a 
user for the first time.

If this option is set to Yes, users must complete setting up 
their passphrase before they proceed with any other 
activity on the workstation.

If this option is set to No or Default, users can postpone 
setting up the passphrase. If the users clicks Cancel or 
closes the dialog, then SecureLogin does not start.

No

Enter API 
license key(s)

Specify API 
license key(s)

Specify the API license key(s) provided by SecureLogin to 
activate the API functionality for an application.

You can add more than one API license key.

Specify the 
API license 
key

Obscure Show 
Password 
(seconds)

Integer value in 
seconds

Restricts the password display time when you click the 
Show Password button in the local interface.

30

Preference Possible Values Description Default Value
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Password 
protect the 
system tray icon

Yes/No/Default This preference restricts the users from accessing the 
NetIQ SecureLogin icon menu option (from the 
notification area (system tray) without their network 
login password.

When set to Yes, the SecureLogin icon on the notification 
area password protected.

When set to No or Default, the SecureLogin icon on is not 
password protected.

This preference is available in both SecureLogin client 
and the administrative management utilities (SLManager 
and MMC snap-ins).

NOTE: Always select the Synchronize NDS password with 
Universal Password option when NMAS is used.

No

Provide API 
Access

Yes/No/Default This preference controls the API functionality use.

If this option is set to Yes, the API access is enabled.

If this option is set to No or Default, the API access is 
disabled.

This preference is available in both SecureLogin client 
and the administrative management utilities (SLManager 
and MMC snap-ins).

No

Stop walking 
here

Yes/No/Default This preference controls the inheritance of settings from 
higher level containers or organizational units.

If this option is set to Yes, the inheritance of settings from 
higher level containers or organizational units is disabled.

Set the option to Yes during phased upgrades when 
higher levels might have a different version of 
SecureLogin implemented.

If this option is set to No or Default, the inheritance of 
settings from higher level containers or organizational 
units is enabled.

This preference does not apply when SecureLogin is 
installed in eDirectory environment. The Corporate 
redirection functionality; that is, the inheritance settings 
from higher level container or organizational units is 
bypassed in an eDirectory environment.

No

Preference Possible Values Description Default Value
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Table 3-4   Java Preferences

Use Passphrase 
Policy

Yes/No/Default This preference controls if users can set passphrase 
policies using administrative management tools.

If this option is set to Yes, then the users can set or edit 
the passphrase policies using any of the supported 
administrative management tools (iManager, MMS, or 
slManager).

If this option is set to No or Default, the users cannot set 
or edit the password policies.

Preference Possible Values Description Default Value

Add application 
prompts for Java 
applications

Yes/No/Default This preference prompts to add a Java application for 
defining the application definition.

When set to No, the Add Application window is not 
launched when you launch any Java application.

Yes

Allow single 
sign-on to Java 
applications

Yes/No/Default This preference controls whether SecureLogin allows SSO 
for Java applications.

If the preference is set to Yes or Default, SecureLogin 
prompts the user to enter credentials (if none already 
exist), or submits existing credentials on the Java 
application login page.

If this option is set to No, Java applications are not 
enabled for SSO.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Preference Possible Values Description Default Value
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Table 3-5   Web Preferences

Preference Possible Values Description Default Value

Add application 
prompts for 
Internet Explorer

Yes/No/Default This preference controls the display of the Web login 
detection wizard and confirmation dialog box when a 
Web application is detected and recognized by Internet 
Explorer.

If you select Yes or Default, the user is initially 
prompted to enable the application and enter the 
credentials for the application (if not done previously). 

NOTE: Setting the preference to Yes when displayed to 
users depends on the settings of the “Wizard mode” 
on page 41 preference.

On subsequent runs of the application, the user is not 
prompted for credentials and SSO occurs seamlessly.

If you select No, SecureLogin skips enabling the 
application for SSO, the user is never be prompted to 
enable the application.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Add application 
prompts for 
Mozilla Firefox

Yes/No/Default This preference controls the display of Web login 
detection wizard and confirmation dialog box when a 
Web application is detected and recognized by Mozilla 
Firefox.

NOTE: Setting the preference to Yes when displayed to 
users depends on the settings of the “Wizard mode” 
on page 41 preference.

If you select Yes or Default, the user is initially 
prompted to enable the application and enter the 
credentials for the application (if not done previously). 
On subsequent runs of the application, the user is not 
prompted for credentials and SSO occurs seamlessly.

If you select No, SecureLogin skips enabling the 
application for SSO for this instance. You are prompted 
to enable the application when you launch it the next 
time.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes
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Add application 
prompts for 
Google Chrome

Yes/No/Default This preference controls the display of Web login 
detection wizard and confirmation dialog box when a 
Web application is detected and recognized by Google 
Chrome.

NOTE: Setting the preference to Yes when displayed to 
users depends on the settings of the “Wizard mode” 
on page 41 preference.

If you select Yes or Default, the user is initially 
prompted to enable the application and enter the 
credentials for the application (if not done previously). 
On subsequent runs of the application, the user is not 
prompted for credentials and SSO occurs seamlessly.

If you select No, SecureLogin skips enabling the 
application for SSO on this instance. You are prompted 
to enable the application when you launch it the next 
time.

This preference is available in both SecureLogin Client 
Utility and administrative management utilities 
(SLManager and MMC snap-ins).

Yes

Add application 
prompts for 
Microsoft Edge

Yes/No/Default This preference controls the display of Web login 
detection wizard and confirmation dialog box when a 
Web application is detected and recognized by 
Microsoft Edge.

NOTE: Setting the preference to Yes when displayed to 
users depends on the settings of the “Wizard mode” 
on page 41 preference.

If you select Yes or Default, the user is initially 
prompted to enable the application and enter the 
credentials for the application (if not done previously). 
On subsequent runs of the application, the user is not 
prompted for credentials and SSO occurs seamlessly.

If you select No, SecureLogin skips enabling the 
application for SSO on this instance. You are prompted 
to enable the application when you launch it the next 
time.

This preference is available in both SecureLogin Client 
Utility and administrative management utilities 
(SLManager and MMC snap-ins).

Yes

Preference Possible Values Description Default Value
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Add application 
prompts for web 
pages on 
mutation

Yes/No/Default This preference controls the display of Web login 
detection wizard and confirmation dialog box when a 
Web application includes mutation events.

NOTE: Setting the preference to Yes when displayed to 
users depends on the settings of the “Wizard mode” 
on page 41 preference.

If you select Yes or Default, the user is not prompted to 
enter the credentials on the subsequent web pages 
that include mutation events but initially is prompted 
to enable the application and enter the credentials for 
the application (if not done previously).

If you select No, SecureLogin skips enabling the 
application for SSO for the web pages that include 
mutation events.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

No

Allow HTML 
Authentication 
single sign-on to 
Google Chrome

Yes/No/Default This preference defines SSO access to HTML 
Authentication requests using Google Chrome.

If you select Yes or Default the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin skips enabling the 
application for SSO for this instance. You are prompted 
to enable the application when you launch it the next 
time.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Allow HTML 
Authentication 
single sign-on to 
Microsoft Edge

Yes/No/Default This preference defines SSO access to HTML 
Authentication requests using Microsoft Edge.

If you select Yes or Default the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin skips enabling the 
application for SSO for this instance. You are prompted 
to enable the application when you launch it the next 
time.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Preference Possible Values Description Default Value
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Allow HTML 
Authentication 
single sign-on to 
Mozilla Firefox

Yes/No/Default This preference defines SSO access to HTML 
Authentication requests using Mozilla Firefox.

If you select Yes or Default the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin skips enabling the 
application for SSO for this instance. You are prompted 
to enable the application when you launch it the next 
time.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Allow single sign-
on to Internet 
Explorer

Yes/No/Default This preference defines SSO access to web application 
using Internet Explorer.

If you select Yes or Default, the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin does not prompt for 
credentials (if none exist or are incorrect) and does not 
submit credentials into the application.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Allow single sign-
on to Mozilla 
Firefox

Yes/No/Default This preference defines SSO access to Web application 
using Mozilla Firefox.

If you select Yes or Default the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin does not prompt for 
credentials (if none exist or are incorrect) and does not 
submit credentials into the application.

This preference is available in both SecureLogin client 
and administrative management utilities (SLManager 
and MMC snap-ins).

Yes

Allow single sign-
on to Google 
Chrome

Yes/No/Default This preference defines SSO access to Web application 
using Google Chrome.

If you select Yes or Default the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin does not prompt for 
credentials (if none exist or are incorrect) and does not 
submit credentials into the application.

This preference is available in both SecureLogin Client 
Utility and administrative management utilities 
(SLManager and MMC snap-ins).

Yes

Preference Possible Values Description Default Value
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Table 3-6   Windows Preferences

Enable DHTML 
monitor on web 
pages

Yes/No/Default This preference enables SSO for web pages that require 
DHTML script. You can enable or disable the DHTML 
setting. 

For DHTML applications that depend on mutation 
events, Add application prompts for web pages on 
mutation must be set to Yes to SSO to the application.

Yes

Enable WebSSO 
defined 
applications as 
allowlist

Yes/No/Default This preference allows user to enable WebSSO defined 
applications as allowlist. 

When set to No or Default, the allowlist rules are not 
applied.

When set to Yes, the allowlist rules are applied, that is, 
other web applications are not taken into 
consideration for Wizard auto prompting and Single 
Sign-On (SSO). 

You can use Add Application to override the preference 
and still consider applications for Wizard auto 
prompting and SSO.

No

Start the Flash 
monitor/
automation 
worker

Yes/No/Default This preference starts the flash SSO process. No

Preference Possible Values Description Default Value

Add application 
prompts for 
Windows 
applications

Yes/No/Default This preference controls the display of a Windows 
login detection and confirmation message when a 
Windows application is detected and recognized.

If you select Yes or Default, the user prompted to 
enable the application and to enter the credentials 
for the application (if not done previously). 

On subsequent runs of the application, the user is 
not prompted for credentials and SSO occurs 
seamlessly.

This preference is available in both SecureLogin 
client and administrative management utilities 
(SLManager and MMC snap-ins).

Yes

Preference Possible Values Description Default Value
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NOTE: To apply the changes, restart SecureLogin.

Allow single sign-on 
to Windows 
applications

Yes/No/Default This preference defines SSO access to Windows 
applications.

If you select Yes or Default the specified credentials 
are saved and the application is enabled for SSO.

If you select No, SecureLogin will not prompt for 
credentials (if none exist or are incorrect) and will 
not submit credentials into the application.

This preference is available in both SecureLogin 
client and administrative management utilities 
(SLManager and MMC snap-ins).

Yes

Allow single sign-on 
to Windows 
applications using 
DotNet automation 
worker

Yes/No/Default This preference allows single sign-on to Windows 
applications using the DotNet automation worker.

If this preference is set to No or Default, the 
windows application is not single signed-on by the 
DotNet automation worker.

If the preference is set to Yes, Windows applications 
are single signed-on by the DotNet worker.

Start the Windows 
32bit (WinSSO32) 
monitor/
automation worker

Yes/No/Default This preference starts the WinSSO32 process. Yes

Start the Windows 
64bit (WinSSO64) 
monitor/
automation worker

Yes/No/Default This preference starts the WinSSO64 process for 
Windows on a 64-bit machine.

Yes

Preference Possible Values Description Default Value
40 Managing Preferences



Table 3-7   Wizard preferences

3.6 Configuring the Exclude.ini File
You can configure the exclude.ini file to exclude applications or classes of applications that do 
not require SSO. For example, exclude an anti-virus application because it does not require SSO. 
Configure the exclude.ini file to achieve the following outcomes:

 Exclude heavy applications that might cause performance issues.
 Exclude the classes that do not require SSO to improve the performance of applications.

IMPORTANT: SecureLogin does not process the applications or classes specified in exclude.ini 
for SSO even if the application definition is published for these applications.

Preference Possible Values Description Default Value

Show Add 
Application wizard 
with minimal 
actions 

Yes/No/Default This preference controls displaying the prompt for 
SSO with minimum options.

If you set this preference to Yes, the Add Application 
wizard displays the following options:

 Yes, I want to single sign using 
the default selections done by the 
wizard.

 Cancel, I do not want to single 
sign this screen at this time.

 No, never prompt me to single sign 
this screen.

If you set this preference to No then, the default 
options are displayed to SSO to the application.

No

Skip the wizard 
process and use 
defaults for new 
forms

Yes/No/Default This preference controls the wizard process.

If you set this preference to Yes, then the default 
wizard selections are applied for all the pages of the 
application and you can switch between the panes 
instead of making changes sequentially.

No

Wizard mode Administrator/
User/Disabled

This preference controls that access to the 
application definition wizard.

If this option is set to Administrator, it gives users’ 
complete access to the application definition wizard. 
Users can create their own application definitions.

If this option is set to User, users are only allowed to 
create new login credential sets for new applications 
using the auto-detection settings.

If this option is set to Disabled, the application 
definition wizard is not launched.

NOTE: This preference requires SecureLogin 6.0 
datastore if the value is changed.

Administrato
r
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By default, SecureLogin does not process the following executables for SSO for optimal performance:

msdev.exe
slbroker.exe
tlaunch.exe
slproto.exe
notes.exe
nswebsso.exe
nwadmn32.exe
nwadmnnt.exe
nwadmn95.exe
loginw95.exe
setup.exe
nwtray.exe
loginw32.exe
scrnlock.scr
wfica32.exe
mmc.exe
slwinsso.exe
slmanager.exe
sllock.scr
Perform the following steps to configure the exclude.ini file:

1 Create an exclude.ini file in the C:\Program Files\NetIQ\SecureLogin directory.

IMPORTANT: If you are using Notepad to create or edit the file, set the encoding to Unicode.

2 Specify the application executables or classes in the exclude.ini file in the following format:

Include
executable1.exe
executable2.exe
Classes
class1
class2
Nodefault
Exclude
default1.exe
default2.exe

In this example configuration of exclude.ini, SecureLogin will perform the following tasks:

1. SecureLogin will process executable1.exe and executable2.exe for SSO.
2. SecureLogin will not process class1 and class2 for SSO.
3. SecureLogin will not process default1.exe and default2.exe for SSO. It will override the 

default configuration.
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4 4Managing Passphrases

In this Chapter

 About Passphrases
 Creating a Passphrase Question
 Resetting a Passphrase Answer
 Changing the Passphrase Prompt
 Changing a Passphrase

4.1 About Passphrases
Passphrases are an important security component in the implementation of SecureLogin. 
Passphrases are unique question and answer combinations created to verify and authenticate the 
identity of a user. In a directory environment, you can create passphrase questions for users. Users 
can select one of these questions and provide an answer for it. You can also permit users to provide 
a question of their choice and the answer for it. 

Passphrases protect user credentials from unauthorized use. For example, in an Microsoft Active 
Directory environment, an administrator can reset the users network password and then log in as 
that user and gain access to the users information.

However, this cannot happen when you are using SecureLogin. If someone other than the actual 
users tries to reset the network password, SecureLogin triggers the passphrase question. The user 
must provide the correct answer before successfully logging in. Even an administrator cannot access 
the user’s single sign-on-enabled applications without knowing the user’s passphrase answer. 

When SecureLogin is launched for the first time on a user’s workstation, the Passphrase Setup dialog 
box is displayed. 

NOTE: In a Microsoft Windows Vista or higher environment, when you log in to SecureLogin in an 
offline mode with an incorrect password, you are prompted to provide the passphrase answer. 
If an incorrect passphrase answer is specified, you are prompted to retry the authentication. 
However, if you again provide a wrong password, instead of seeing a prompt for the passphrase 
answer, you are prompted to specify the password (that is, instead of the passphrase dialog box, 
the password dialog box is displayed). Close and relaunch SecureLogin to be prompted for the 
password first, then prompted for the passphrase answer if the incorrect password is specified

 SecureLogin using the Novell Client does not support non-password-based NMAS logins if the 
passphrase options are disabled. This is not supported because SecureLogin either fails to open 
the local cache or opens the local cache file without any password. 

 Also, Offline authentication does not work if you do a non-password-based NMAS 
authentication with the Passphrase Security System disabled. This is because SecureLogin in 
offline mode accepts only passphrases for non-password-based NMAS authentication. This 
scenario occurs only if SecureLogin is installed in Novell Client mode.
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Passphrase Authentication
Passphrases are used to authenticate when:

 A user is working either remotely or offline in an eDirectory or non-Microsoft Active Directory 
LDAP environment. 

 Someone other than the actual user resets the network password. 

Benefits of Passphrases
 An individual cannot access a user’s credentials by resetting the network password.
 Passphrases can be used in conjunction with SecureLogin Self-Service Password Reset, which 

enables users to reset their network password after answering the passphrase question.
 You can use this functionality to disable access to user credentials if the computer is stolen.

NOTE: You can disable the passphrase security system, but it also removes the features mentioned in 
the preceding section. 

4.2 Creating a Passphrase Question
As an administrator, you can perform the following actions:

 Create one or more passphrase questions for users to select.
 Enable users to create their own passphrase question and answer.
 Set up a combination of both. 

To create a passphrase question:

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Advanced Setting. The advanced setting options are deployed. 

By default, User-defined passphrase questions is selected. Deselect this option if you do not 
want users to create their own passphrase question and answer. 

3 Click New.
4 In the Enter a new passphrase question dialog box, provide your passphrase question. 
5 Click OK. The question you provided is displayed in the Corporate passphrase questions field. 

This passphrase question is displayed to all users associated with the selected object. 
6 Repeat steps 3 to step 5 to create additional passphrases.

IMPORTANT: Ensure to click OK after you create the passphrase question to save the changes and 
exit the page. 

The passphrase answer is specified by the users when they set up the passphrase question and 
answer. Passphrase answers must contain a minimum of six characters. However, you can change 
the policy to suit your security requirement. For more information, see Changing a Passphrase 
Policy.

It is recommended to not apply strict policies to passphrase answers as it make them harder to 
remember. Instead, use a multi-value question, such as What is you driving license number 
plus Your Mother's name? and set a passphrase policy based on that.
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4.3 Resetting a Passphrase Answer
If a user forgets the passphrase answer, you must reset the user’s SecureLogin configuration to 
ensure that the user’s data is secure. This deletes all user-specific information, including user names 
and passwords.

For more information, see Section 2.6, “Deleting or Re-setting User Data,” on page 20.

IMPORTANT: When you set up a user’s passphrase question and answer policies, we recommend 
that you keep them simple so that the user can easily remember the answer.

4.4 Changing the Passphrase Prompt
You can change the passphrase prompt that users see in the Passphrase Setup dialog box the first 
time they log in.

1 Launch the Administrative Management utility (SLManager or MMC snap-ins). 
2 Click Advanced Settings. The Advanced Settings options are displayed.
3 Under Customized Passphrase Prompt, select Modify the passphrase prompt window text. The 

Custom prompt is now active.
4 Specify the new prompt.
5 Click OK to save the changes and close the Administrative Management utility. Log in as a new 

user to view the customized prompt.

4.5 Changing a Passphrase
Users can change their passphrase answer depending on how you configure SecureLogin. 

1 Right-click the SecureLogin icon in the notification area (system tray), then select Advanced > 
Change Passphrase. The Passphrase dialog box is displayed.

2 Specify the passphrase answer in the field.
3 Click OK. 
4 In Enter a question, select or specify a passphrase question.
5 In Enter the answer, specify the new passphrase answer.
6 In Confirm the answer, retype the new passphrase answer.
7 Click OK.

NOTE: Users who do not have access to the SecureLogin icon cannot change their passphrases. You 
can temporarily enable access to the icon to allow the user to change the passphrase with the 
Display the system tray icon preference setting.
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5 5Managing Passphrase Policies

 Section 5.1, “About Passphrase Policies,” on page 47
 Section 5.2, “Changing a Passphrase Policy,” on page 47
 Section 5.3, “Enabling the Passphrase Security System,” on page 48
 Section 5.4, “Checking the Passphrase Security System Status,” on page 50
 Section 5.5, “Passphrase Security System Scenarios,” on page 51

5.1 About Passphrase Policies
A passphrase is an integral part of the security architecture of SecureLogin. It can be used to secure 
single sign-on data when a user authenticates to applications. 

A policy is used to restrict the format and content of passphrase answers, including length, whether 
numeric characters are required, and whether passphrases must be uppercase or lowercase. For 
example, you could set Begin with an uppercase character to Yes and Maximum uppercase characters 
to 1, and Prohibit characters to Disallow spaces. You could also require all passphrase answers to start 
with uppercase and have the rest of the characters as lowercase.

You can set passphrase policies using any of the supported administrative management tools (MMS 
or slManager).

5.2 Changing a Passphrase Policy
The passphrase policy now applies to all users inheriting configuration from the selected object. You 
can change or disable it at any time.

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Advanced Settings. 
3 Select Use a passphrase policy.
4 Click Edit Policy. 
5 In the Setting Description column, click the policy rule you want to edit, then in the Value 

column, specify the required value.
For example, if you think that users might find it easier to remember basic rules for all 
passphrases instead of remembering exactly how they typed a passphrase when they created it, 
you could require all passphrases to contain a minimum of 6 characters and a maximum of 12 
characters. Set Minimum length to 6 and set Maximum length to 12.
By default, passphrase responses are required to contain a minimum of six characters. For 
security reasons, any passphrase policy you implement must also contain a minimum of six 
characters.

6 Click OK. The new values are added to the Value column.
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5.3 Enabling the Passphrase Security System
This section contains information about the following:

 Section 5.3.1, “Enabling the Passphrase Security Using PKI Encryption,” on page 49
 Section 5.3.2, “Enabling the Passphrase Security Using PKI Encryption,” on page 50

The Enable Passphrase Security System option determines if users can use a passphrase to decrypt 
single sign-on data. 

If the passphrase system is not used, this exposes the users’ single sign-on data if a third party can to 
reset the users network password. It is strongly recommended you enforce passphrase system on 
users environment.

To view or modify this preference:

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Preferences. 
3 Select Security > Enable passphrase security system, select Yes or Hidden.
4 Click Apply.
5 Click OK.

You can set the Enable Passphrase Security System preference to Yes or Hidden depending on the 
enterprise security requirements. 

If the Enable Passphrase Security System is set to Yes, (which is the default preference) the user is 
prompted to set the passphrase question and answer when SecureLogin is launched for the first 
time.

If the Enable Passphrase Security System is set to Hidden, the user is not prompted to set the 
passphrase question and answer when SecureLogin is launched for the first time.

WARNING: If you change the preference from Hidden to Yes, users must answer the passphrase 
questions to use SecureLogin. Typically, users are not prompted to create a passphrase after the first 
login.

Without any message indicating the change in the preference, users are prompted for the 
passphrase answer. So, avoid changing the preference. 

You have two options depending on what you specified. 

 Users can create both the passphrase question and answer. 
 You predefine a list of questions and answers, and the user selects from the list. 

When users have set a passphrase, the application generates a random key, and a one-way hash of 
the passphrase answer encrypts this key. Later, the application key encrypts the new key. This key 
protects users’ SecureLogin credentials and passwords so that even someone with Supervisor rights 
to the network and access to Microsoft Management Console (MMC) is unable to view a user's 
passwords to applications.

After the passphrase is set, every time a user logs in to the network, SecureLogin loads seamlessly. 
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Typically, the prompt to create a passphrase is never seen after the first login. However, if an 
administrator resets the user's directory or network, the next time SecureLogin launches, users must 
answer the passphrase question before SecureLogin continues. This prevents other users from 
changing the user's directory password, logging on as the user, obtaining access to the SecureLogin 
data, and using it to run applications. 

5.3.1 Enabling the Passphrase Security Using PKI Encryption
You cannot toggle the Enable Passphrase Security System setting when the users forget their smart 
card unless they had previously set a passphrase or had it randomly generated using the Hidden 
option.

If users are required to authenticate to the network by using passwords, Enable Passphrase Security 
System must be set either to Yes or Hidden. 

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Preferences. 
3 Under Security, select  Yes or Hidden in Enable passphrase security passphrase. 
4 Click Apply.
5 Click OK.

If you select Yes, users must select a passphrase question and answer when they log in to 
SecureLogin for the first time. When the passphrase system is enabled, users are prompted to 
answer their passphrase question if their password has been reset by the administrator. 

NOTE: With the Use smart card to encrypt SSO data option selected (either PKI credentials or Key 
generated on smart card), you can use the passphrase to decrypt single sign-on data if the user’s 
smart card is damaged or lost. 

This setting must be used in conjunction with the Lost card scenario preference set to Allow 
passphrase and Store credentials on the smart card preference set to No. You can toggle these 
preferences if the user’s smart card is forgotten providing the user’s passphrase has already been 
set. The user is prompted to answer the passphrase question before SecureLogin loads. 

For more information, see Section 8.5, “Lost Card Scenarios,” on page 70.

If the Hidden preference is selected, users are not prompted to set a user-defined passphrase. A user 
key is generated automatically with any input from the user.

The Enable Passphrase Security System cannot be set to No unless Use smart card to encrypt SSO data 
is set to PKI credentials. 

If users are required to authenticate to the network by using passwords, the Enable passphrase 
security system option must be set to Yes or No or Hidden.

IMPORTANT: With the passphrase security system set to Hidden, a directory administrator can reset 
a user’s directory password, log in as the user, and access the user’s single sign-on data because they 
are not prompted to answer a passphrase question.
Managing Passphrase Policies 49



5.3.2 Enabling the Passphrase Security Using PKI Encryption
If the Use smart card to encrypt SSO data is set to PKI credentials, the user’s single sign-on data is 
encrypted by using the public key from the selected certificate and the private key and stored on a 
PIN-protected container on the user’s smart card. Both, the user’s directory datastore and the local 
cache are now protected by the PKI credentials.

The single sign-on data can be encrypted by using the private key that is PIN-protected and stored on 
the user’s smart card for added security. Only the user who has the physical possession of the smart 
card and knowledge of the PIN can decrypt the single sign-on data.

To set the Use smart card to encrypt SSO data preference:

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Preferences. 
3 Select Security > Use smart card to encrypt SSO data > PKI credentials, Key Generated On Smart 

Card, or No. 
4 Click Apply.
5 Click OK.

If the Use smart card to encrypt SSO data is set to PKI credentials, the Enable passphrase security 
system can be set to No.

If the Use smart card to encrypt SSO data is set to No, the user’s passphrases are completely disabled 
and the user’s smart card is always required to decrypt the single sign-on data.

IMPORTANT: If your enterprise chooses to disable the passphrase security system:

 You can still access a user’s credentials by resetting the network password.
 The functions of using the passphrases in conjunction with SecureLogin Self Service Password 

Reset (SLSSPR) is disabled. The SecureLogin Self Service Password Reset enables a user to reset 
his or her network passwords after answering the passphrase questions. 

The supported directory modes for disabling the passphrase security system are:

 Active Directory
 LDAP-compatible
 eDirectory (if SecretStore is used)

For information about the scenarios that a user might experience when the Enable passphrase 
security system option is set to No, see Passphrase Security System Scenarios.

5.4 Checking the Passphrase Security System Status
On the notification area (system tray), right-click the SecureLogin icon > About. 

The status appears next to the Database Mode and is listed as PP Enabled or PP Disabled.
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5.5 Passphrase Security System Scenarios
The information provided in this section describes the user experience in environments where the 
passphrase security system has been enabled and disabled.

Scenario 1: The passphrase security system is disabled in a previously enabled 
environment
When the passphrase security system is disabled in an environment where it was previously 
enabled, the following message appears to users the next time they log in.

If the user clicks OK, the disabling of the passphrase security system is approved and the user is 
prompted for the current password. The approval is complete when the user provides the password.

If the user click Cancel, the passphrase security system disabling is delayed and the user is prompted 
with the message until he or she clicks OK to approve the change.

NOTE: Users must answer the passphrase answer to prevent the administrators to toggle this 
preference and allow an unauthorized user access SecureLogin. 

Scenario 2: The passphrase security system is re-enabled in a previously disabled 
environment
If the passphrase security system is re-enabled, the Passphrase Setup dialog box is displayed (similar 
to when a user logs in for the first time after installing SecureLogin.)

If the user clicks OK, the user resets the passphrase question and answer.

If the user clicks Cancel, there is a delay in enabling the passphrases for the user’s workstation. The 
user is prompted at subsequent log ins until he or she specifies a passphrase question and answer.

Scenario 3: The passphrase security system is disabled and the user has changed his 
or her passwords (restrictions for moving user objects)
If you reset the user’s password when the passphrase security system is disabled:

 In an LDAP-compatible and eDirectory (with SecretStore) modes, you cannot move the user 
object to another organizational unit until that user has logged in to SecureLogin on his or her 
workstation. You must move the object back to its previous location to enable the user to run 
SecureLogin.

 In an Active Directory mode, you can move the user object within the directory. If the user 
object is moved, you must move the object back to its previous location to enable the user to 
run SecureLogin.

Scenario 4: Forgotten Passphrase
 If a user forgets SecureLogin data, including his or her passphrase or passphrase answer, you must 
delete the user’s existing SecureLogin datastore. 

After the datastore is deleted, the user’s corporate applications, credentials, preferences, and user 
policies are permanently removed. You must then reset the user’s corporate password before he or 
she can log in and reconfigure the applications by using SecureLogin.
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The next time SecureLogin starts, he or she must manually log in. SecureLogin then detects that a 
passphrase is not set and prompts the user to set up the passphrase before continuing. You can 
create a list of predefined list of passphrases questions.

After the user has set a new passphrase, he or she must re-enter the application user names and 
passwords. If it is not done, an unauthorized could breach security by clearing the passphrase, 
entering a new passphrase, and accessing the actual user’s credentials.

You might need to reset the user’s application passwords as they might have forgotten them.
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6 6Managing Credentials

 Section 6.1, “About Credentials,” on page 53
 Section 6.2, “Creating a User Login and Credentials,” on page 53
 Section 6.3, “Deleting a User Login and Credentials,” on page 54
 Section 6.4, “Linking a Login to an Application,” on page 54

6.1 About Credentials
The first time a user logs in after creating an application definition and activating it for single sign-on, 
the user is prompted to provide credentials in a SecureLogin dialog box. SecureLogin then stores and 
associates these credentials with the application definition and uses it in subsequent logins.

Because individual application requirements determine the credentials that users must enter when 
manually logging in, only those credentials are stored and remembered by SecureLogin. For 
example, if users have an application that only requires username and password, SecureLogin 
encrypts and stores the username and password for subsequent logins. Alternatively, some 
applications require the user to enter domain and database names, IP addresses, and select various 
options on Web pages. SecureLogin can handle all these on behalf of the user.

You can display and manage these credentials in the Logins page of the Administrative Management 
utility and the My Logins pane of the SecureLogin Client Utility.

Credentials stored in a directory environment apply to all associated objects. For example, if users 
access an application located on a specific domain, and they are required to manually select or 
provide the domain address, then the domain must be configured as a credential in the Logins pane 
at the organizational unit level. Thereby, users need not manually provide the domain location when 
they log in. You can then change the domain at any time without notifying users.

Application credentials such as e-mail, finance system, human resource system, and travel system 
are typically stored for user objects and apply only to (and can be used by) the particular user. For 
example, John’s application credentials are encrypted and stored against John’s user object and only 
available to him. When he starts an application, SecureLogin retrieves, decrypts, and enters the 
credentials on behalf of John.

6.2 Creating a User Login and Credentials
Logins and credentials are typically created automatically as part of the application definition, but 
you can manually create and edit them, if required.

To create logins and credentials: 

1 On the notification area (system tray), double-click the SecureLogin icon. 
2 Click My Logins. The existing Logins are displayed.
3 Click New. 
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4 In the Name/Id field, specify a Name/ID for the login.
5 Click OK. The Login name/ID is added to the My Logins pane.
6 From the My Logins on the left pane, select the login you have created.
7 Click New. The Create Credential dialog box is displayed.
8 In the Name field, specify a name for the new credential.
9 Click OK. The new credential is added to the Login details.

10 In the Value column, specify a value for the credential.
11 Click Apply. The new credential variable and its value are displayed.

6.3 Deleting a User Login and Credentials
An admin can delete the single sign-on configuration for a user using the SecureLogin Manager 
(SLManager). This includes deleting the applications, logins, and credentials of a user. Perform the 
following task to delete the single sign-on configuration:

1 Launch SLManager.
2 Click the username for which you want to delete the single sign-on configuration.
3 Click Advanced Settings.
4 Click Datastore.
5 In the Single sign-on configuration pane, click Delete.

IMPORTANT: If SecretStore is configured with SecureLogin, you must delete the logins and 
credentials of the user from the SecretStore vault. For more information, see Removing a Secret in 
the SecretStore Administration Guide.

6.4 Linking a Login to an Application
You can link a login to an application in the appropriate Login pane. For example, if users are logging 
in to Microsoft Outlook using a set of credentials and they are also logging in to Outlook Web Access, 
then they can share or link the credentials to the Web login application definition.

To link a login to an application:

1 In the notification area (system tray), double-click the SecureLogin icon on the system tray. The 
SecureLogin Client Utility is displayed.

2 Click My Login and the login that you want to an application. 
3 Click Link icon. The Applications List dialog box displays the list of enabled predefined 

applications and application definitions.
4 Select the application that you want to link.
5 Click OK. The linked application is added. 
6 Click OK to save changes and close the SecureLogin Client Utility.
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7 7Managing Password Policies

SecureLogin provides the password policy functionality to enable you to efficiently and effectively 
manage user passwords to comply with your organization's security policies.

This section provides information about the following:

 Section 7.1, “About Password Policies,” on page 55
 Section 7.2, “Password Policy Properties,” on page 56
 Section 7.3, “Creating a New Password Policy,” on page 58
 Section 7.4, “Linking a Policy to an Application,” on page 59

7.1 About Password Policies
You can create password policies at a container, OU, Group Policy, and user object level. Policies set 
at the container or organizational unit level are inherited by all associated directory objects. 
Password policies set at the user object level override all higher-level policies. Password policies are 
linked to application definitions through scripting and are not applied to directory objects. You can 
do this by creating a password policy in the Password Policies pane, then linking the policy to the 
application definition by editing the application script and adding the RestrictVariable command. For 
more information about linking a password policy, see Linking a Policy to an Application. 

Password policies are comprised of one or more password rules applicable to one or more single 
sign-on enabled applications and to specific directory objects. You can configure password policies in 
the Password Policy Properties tables of the Administrative Management utilities. 

SecureLogin remembers the passwords and handles password changes after they expire on the back-
end application. For example, after 30 days or when users decide to change their password. The 
SecureLogin password management functionality includes the capability to set password expiry 
duration and generate passwords that comply with specified password policies. 

Password policies are typically created to match existing password policies. You should consult 
application owners before changing an existing password policy.

To determine requirements and parameters of the password policy and applications the password 
policy applies to, test complex policies on a test user account to ensure that they are viable.

7.1.1 Using Application Definition Wizard to Create Password Policy
You can create password policies through the application definition wizard while enabling 
application for single sign-on. For more information about using the application definition wizard, 
see the NetIQ SecureLogin CE 24.3 (v9.2) Application Definition Wizard Administration Guide .

However, you cannot use the wizard to edit or delete password policies.
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7.2 Password Policy Properties
Organizations and applications often have rules about the content of passwords, including the 
required number and type of characters. The Password Policy Properties table helps you to create 
and enforce these password rules through a password policy, and apply this policy to one or more 
applications.

Table 7-1   The Password Policy Properties Table

Policy Value Description

Minimum length Whole number Defines the required minimum number of characters. 

Maximum length Whole number Defines the required maximum number of characters. 

Minimum punctuation 
characters

Punctuation 
characters

Defines the minimum number of punctuation characters 
allowed in a password.

Maximum punctuation 
characters

Punctuation 
characters

Defines the maximum number of punctuation characters 
allowed in a password.

Minimum uppercase 
characters

Whole number Defines the minimum number of uppercase characters allowed 
in a password.

Maximum uppercase 
characters

Whole number Defines the maximum number of uppercase characters allowed 
in a password.

Minimum lowercase 
characters

Whole number Defines the minimum number of lowercase characters allowed 
in a password.

Maximum lowercase 
characters

Whole number Defines the maximum number of lowercase characters allowed 
in a password.

Minimum numeric 
characters

Whole number Defines the minimum number of numeric characters allowed in 
a password.

Maximum numeric 
characters

Whole number Defines the maximum number of numeric characters allowed in 
a password.

Disallow repeat 
characters

No/Yes/Yes, 
case insensitive

Disallows the use of repeated characters, or the use of the same 
successive characters.

If this option is set to No, characters can be repeated. This is the 
default value. 

If this option is set to Yes, same alphabetic characters in a 
different case are considered as different characters. For 
example, A and a are different.

If this option is set to Yes, case insensitive, the successive use of 
the same alphabetic characters in a different case is not 
allowed. 
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Disallow duplicate 
characters

No/Yes/Yes, 
case insensitive

Disallows the use of the same non-successive characters. 

If this option is set to No, duplicate characters are allowed. This 
is the default value. 

If this option is set to Yes, the same alphabetic characters in a 
different case are considered as different characters. For 
example, A (uppercase) and a (lowercase) are different.

If this option is set to Yes, case insensitive, duplication of the 
same alphabetic characters in a different case is not allowed. 

Disallow sequential 
characters

No/Yes/Yes, 
case insensitive

Disallows the use of successive characters in an alphabetical 
order. 

If this option is set to No, sequential characters are allowed. 
This is the default value.

If this option is set to Yes, sequential characters in a different 
case are considered as non-sequential. For example, a and b 
and non-sequential. 

If this option is set to Yes, case insensitive, sequential 
characters in different cases is disallowed. 

Begin with an 
uppercase character

No/Yes This parameter requires a password to start with an uppercase 
character.

The default value is No.

If this option is set to Yes, all other policies that indicate that a 
password must begin with a particular character or in a specific 
manner are disabled.

IMPORTANT: Only one type of character can be designated as 
the first value of a password.

End with an uppercase 
character

No/Yes Enforces the use of an uppercase letter at the end of a 
password. 

The default value is No.

If this option is set to Yes, all other policies that indicate that a 
password must end with a particular character or in a specific 
manner are disabled.

Prohibited characters Keyboard 
characters

Defines a list of characters that cannot be used in a password.

NOTE: There is no need of a separator in the list of prohibited 
characters. For example, @#$%&*

Begin with any Alpha 
character

No/Yes This parameter requires a password to start with an 
alphabetical letter that is, [a-z] or [A-Z]. 

The default value is No.

If this option is set to Yes, it automatically disables all other 
policies that specify what the first character of the password 
should be.

Policy Value Description
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7.3 Creating a New Password Policy
1 Access the Administration Management Utility.
2 Click Password Policies. The Password Policies page is displayed.
3 Click New. The New Password Policy dialog box is displayed.

It is important to use a unique name for all logins, applications, and password policies. Password 
policies cannot have the same name as any other SecureLogin attribute. Typically, organizations 
employ the naming convention ApplicationNamePwdPolicy, for example, LotusNotesPwdPolicy.

Begin with any number No/Yes Enforces the use of a numeric character as the first character of 
the password. 

The default value is No. 

If this option is set to Yes, it automatically disables all other 
policies that specify what the first character of the password 
should be.

Begin with any symbol No/Yes This parameter requires a password to start with a symbol. 
These characters are:

~!@#$%^&*()_+|-=\\{}[]:\\";'<>?/,.`

The default value is No.

If this option is set to Yes, it automatically disables all other 
policies that specify what the first character of the password 
should be.

End with any Alpha 
character

No/Yes Enforces the use of an alphabetic character as the last character 
of the password. 

The default value is No.

If this option is set to Yes, it automatically disables all other 
policies that specify what the password should end with.

End with any number No/Yes Enforces the use of a numeric character as the last character of 
the password. 

The default value is No.

If this option is set to Yes, it automatically disables all other 
policies that specify what the password should end with.

End with any symbol No/Yes This parameter requires a password to end with a symbol. These 
characters are:

 ~!@#$%^&*()_+|-=\\{}[]:\\";'<>?/,.`

The default value is No.

If this option is set to Yes, it automatically disables all other 
policies that specify what the password should end with.

Policy Value Description
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4 In the Enter a name for the new password policy field, specify a name for the policy. The new 
policy is added under the Password Policies.

5 Click OK. The new password policy is added.
6 Click the new password policy. The Password policy properties table is displayed.

The table contains Description and Value columns. Most policy rules are not enforced and do 
not have a default value. Values are either Yes, No, or a whole number. 

7 In the Description column, locate the policy you want to change, then either select the 
appropriate value from the drop-down list or enter the required text field values in the adjacent 
Value column.

8 Click Apply to save changes.
9 Click OK to close the Administrative Management utility.

IMPORTANT: Password policies are linked to applications by using the SecureLogin application 
definition command RestrictVariable. You can use this command to apply password 
policies to one or more applications.

7.4 Linking a Policy to an Application
You can set or select a password policy, while enabling applications for single sign-on using the 
application definition wizard. You can also link the password policies to applications by using the 
SecureLogin application definition command RestrictVariable. With this command, you can 
apply the password policies to one or more applications, as in the example below. 

The following definition restricts the $Password variable to the Finance password policy. The user’s 
password must match the policy when he or she saves the credentials. When the password requires 
changing, the application generates a new password based on the policy randomly because Random 
is included in the definition at ChangePassword.

# Set the Password to use the Finance Password Policy
RestrictVariable $Password FinancePwdPolicy
# Login Dialog Box
Dialog
   Class #32770
   Title "Login"
EndDialog
Type $Username #1001
Type $Password #1002
# Change Password Dialog Box
Dialog
   Class #32770
   Title "Change Password"
EndDialog
Type $Username #1015
Type $Password #1004
ChangePassword $Password Random
Type $Password #1005
Type $Password #1006
Click #1
The following example uses an application definition to restrict the ?NewPwd variable to the Finance 
password policy. The user’s current password ($Password) is saved and used when the application 
starts for the first time and prompts the user to enter the credentials. When the password expires, 
the password policy is enforced on any new password.
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# Set the Password to use the Finance Password Policy
RestrictVariable ?NewPwd FinancePwdPolicy
# Log on Dialog Box
Dialog
Class #32770
Title "Log on"
EndDialog
Type $Username #1001
Type $Password #1002
Click #1
# Change Password Dialog Box
Dialog
Class #32770
Title "Change Password"
EndDialog
Type $Username #1015
Type $Password #1004
ChangePassword ?NewPwd Random
Type ?NewPwd #1005
Type ?NewPwd #1006
Set $Password ?NewPwd
Click #1
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8 8Managing Smart Card Integration

Network authentication is the verification of a user's login credentials before granting access to a 
network or operating system. Users typically authenticate to a network using one of the following 
methods:

 Password
 Biometric device (fingerprint or iris scan)
 Smart card and PIN
 Token

When a user authenticates successfully and the operating system loads, SecureLogin starts and 
manages the login credentials to the user's single sign-on-enabled applications. 

If you want to enforce biometric, smart card, or token authentication at the application (or 
transaction) level, AAVerify can be used with SecureLogin to prompt the user to re-authenticate 
before SecureLogin retrieves their credentials and logs in to single sign-on enabled applications. 

You can also integrate network authentication methods such as ActivIdentity’s SCPL with 
SecureLogin to manage user’s Windows login credentials (user name, password, and network 
selection). SCPL provides secure and convenient network log in by allowing a user to simply insert 
the smart card and enter the PIN to gain network access. SCPL retrieves the user's Windows 
username and password from the smartcard and automatically enters these into the Windows 
Graphical Identification and Authorization (GINA)/Credential Provider interface after a user enters 
his or her PIN.

The use of a smart card with SecureLogin is based on the enterprise preference to have users utilize 
a smart card to log on and store their single sign-on data or to encrypt their directory data using a 
Public Key Infrastructure (PKI).

To continue working with SecureLogin, you must manually add the entry and set the value to File.

The secondary store entry under HKLM/Protocom/SecureLogin/Security is deleted when the 
installer is modified to remove smart card support. To continue working with SecureLogin, you must 
manually add the entry and set the value to File. 

If you are using smart card authentication for the Citrix login prompt, enter the smart card PIN 
manually, because the PIN is not cached for the Citrix server authentication.

This section provides information about the following:

 Section 8.1, “How SecureLogin Uses Smart Cards,” on page 62
 Section 8.2, “Installing SecureLogin for Smart Cards,” on page 66
 Section 8.3, “Configuring SecureLogin for Smart Cards,” on page 68
 Section 8.4, “Using PKI Encryption for the Datastore and Cache,” on page 69
 Section 8.5, “Lost Card Scenarios,” on page 70
 Section 8.6, “Smart Card with DAS Integration,” on page 74
 Section 8.7, “Disconnected Login using NESCM,” on page 75
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 Section 8.8, “SecureLogin in Kiosk Mode,” on page 76
 Section 8.9, “Enable Pin Caching for Smart Card,” on page 77
 Section 8.10, “Changing Smart Card Login Password on Expiry,” on page 77

8.1 How SecureLogin Uses Smart Cards
 Section 8.1.1, “Prerequisites,” on page 62
 Section 8.1.2, “Using Smart Card to Log In to Workstation,” on page 62
 Section 8.1.3, “Strong Authentication Methods,” on page 62

8.1.1 Prerequisites
SecureLogin supports ActivClient 6.x and 7.x, and Microsoft BaseCSP MiniDriver only. ActiveClient 
6.2 is supported on 32-bit and 64-bit system on all platforms.

To enable smart card support with SecureLogin, the Use smart card option must be selected during 
installation, regardless of the administrator’s intended preferences for setting the SecureLogin 
security preference Require smart card is present for SSO and administration operations.

IMPORTANT: Contact NetIQ Support for information about other cryptographic service providers.

See Installing SecureLogin for Smart Cards for more information about enabling smart card support 
during installation and deployment.

NOTE: When you use eDirectory to create a certificate for a smart card user, ensure that the key 
usage options Digital Signature and Key Encipherment are selected.

8.1.2 Using Smart Card to Log In to Workstation
SecureLogin allows a user to alternate their log in method by using smart card.

However, a user can only log in by using a smart card to access the SecureLogin credentials only if 
the smart card option is selected during installation. 

If the smart card option is not selected during installation, a user attempting to access SecureLogin 
on the workstation is forced to log in with his or her username and network password.

8.1.3 Strong Authentication Methods
 “Advanced Authentication” on page 63
 “One Time Password” on page 65
 “Smart Card Password Login” on page 66
 “Smartcard Application Reauthentication” on page 66
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Advanced Authentication
SecureLogin uses the AAVerify script command to enforce strong security for applications that 
cannot provide such a mechanism natively. AAVerify can also be implemented to provide user 
authentication to applications that have no existing authentication interface. Use this command in 
conjunction with NetIQ Advanced Authentication Framework or NetIQ Modular Authentication 
Services (NMAS) to force users to log in to the configured application with a smartcard.

For details of the AAVerify application definition command, see the NetIQ SecureLogin CE 24.3 
(v9.2) Application Definition Guide.

 “New Functionality in the AAVerify Command” on page 63
 “The New ?IsPin Variable” on page 63
 “Recommended Configuration” on page 64
 “Example Application Definition” on page 64
 “Reauthenticating a Predefined Web Application” on page 65

New Functionality in the AAVerify Command
The existing version of the AAVerify command relies on NMAS. Any NMAS supported method, such 
as smartcard, can be deployed in the backend to process any re-authentication requests. In Active 
Directory environments, this support is provided by NetIQ Advanced Authentication Framework.

The AAVerify command provides a secure method to re-authenticate users. Thus proving the users 
identity before injecting the SecureLogin credentials into sensitive applications. 

To process the reauthentication request, the AAVerify command takes the method by which users 
are currently logged in and their directory connectivity status.

If users have logged in with a username and password, they are prompted to reauthenticate by using 
the password, regardless of whether they are offline or online.

If users have logged in with a smart card, they are prompted to reauthenticate by using the original 
smart card PIN, regardless of whether they are offline or online.

AAVerify is independent of NMAS and can be used to enforce strong re-authentication by using a 
smart card and PIN or password without installing NMAS.

This command caters to a mixed environment where one of the following conditions exists:

 A user logs in to a number of workstations by using a combination of both smart card or 
password authentication

 Several users log in to one workstation by using smart card or password authentication.

The New ?IsPin Variable
?IsPin is a new SecureLogin variable available in the Microsoft Active Directory mode only.

This variable is automatically generated when a user logs in. It stores the information based on 
whether the user has logged in to the workstation by using a smart card and PIN or a password.
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When the ?IsPin variable is called from an application definition, it indicates the following:

 If the returned value is true, the user has logged in by using a smart card, and only the PIN value 
is passed through to SecureLogin.

 If the returned value is false, the user has logged in with a password.

NOTE: The ?IsPin variable is updated only at a login and is not updated at a screen unlock.

Recommended Configuration
Use smart card option is normally based on your preference to have the SecureLogin users utilize a 
smart card to store the single sign-on data or to encrypt their user’s directory data by using a PKI. 

If you decide to allow users to log in to their workstations by using a smart card and reauthenticate 
against their smart card, then Use smart card option must be selected during the installation 
regardless of the option set for Require smart card is present for SSO and administration operations.

NOTE: It is recommended to use a smart card configuration policy to lock the screen on card removal 
to ensure that the smart card belongs to the currently logged-in user.

Example Application Definition 
The following application definition shows how to call the AAVerify command based on the login 
method. It uses the Notepad application. After the Notepad application is started, AAVerify is 
invoked to prompt the user to reauthenticate, using the login method for the workstation.

Dialog
Class Notepad
EndDialog
OnException AAVerifyFailed Call AAVerifyFailed
OnException AAVerifyCancelled Call AAVerifyCancelled
If ?isPin Eq "true"
  AAVerify -method "smartcard" ?result
Else
  AAVerify -method "password" ?result
EndIf
ClearException AAVerifyFailed
ClearException AAVerifyCancelled
Type $username
Type \n
Type $password
Type \n
Sub AAVerifyFailed
   MessageBox "Reauthentication failed."
   EndScript
EndSub
Sub AAVerifyCancelled
MessageBox "Reauthentication cancelled."
EndScript
EndSub
## EndSection: "Login Window"
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Reauthenticating a Predefined Web Application
If the new AAVerify command is used to reauthenticate a Web browser-based application or if the 
Prompt for device authentication for this device option is enabled for Web applications, then the 
predefined application definition for the Web browser must be applied for that particular user to 
avoid confusion when prompting for reauthentication.

One Time Password
The use of multiple passwords places high maintenance overheads on large enterprises. This results 
in significant cost where users use and manage multiple logins. The calls to helpdesk to reset 
forgotten password, providing all password when a new employee joins, or deleting the logins when 
an employee quits can be high in cost.

A one time password (OTP) reduces the cost, particularly with regard to calls to the help desk to 
reset a forgotten password, or to ensure that all passwords are provisioned when a new user starts, 
or deleted when existing user leaves the organization. 

SecureLogin integrates with ActivIdentity’s one time password authentication functionality and 
provides you access to the GenerateOTP application definition command, which can be used to 
generate synchronous authentication and asynchronous authentication soft token support for smart 
card user authentication.

If you are using One Time Password capability on 32-bit applications running on 64-bit operating 
system in the Active Client 7.x environment, set the following registry keys:

Location Type Name

HKEY_LOCAL_MACHINE\SOFTWARE\ 
Protocom\SecureLogin\Security\

String StorageDeviceInterfaceLibraryPKCS11-Wow64

Set to: Explanation

C:\Program Files (x86)\HID 
Global\ActivClient\acpkcs211.dll

Path to ActivClient

Location Type Name

HKEY_LOCAL_MACHINE\SOFTWARE\ 
Protocom\SecureLogin\Security\

String StorageDeviceInterfaceLibraryPKCS11-2

Set to: Explanation

C:\Program Files\HID Global\ActivClient\acpkcs211.dll Path to ActivClient
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Smart Card Password Login
ActivIdentity’s Smart Card Password Login (SCPL) provides smart card-based Windows login that is 
not PKI-based. SCPL, when used in conjunction with SecureLogin, stores and manages a user’s 
Windows login and SecureLogin credentials. It provides efficient network login by allowing a user to 
simply insert their smart card and enter their PIN.

Smartcard Application Reauthentication
You can configure SecureLogin to reauthenticate an application using the SecureLogin Administrative 
Management Utility or application definition wizard. To use this, enable Prompt for device re-
authentication for this application and configure the Re-authentication method.

IMPORTANT: Basecsp.dll supports only smart card authentication. It does not support smart 
card re-authentication even in Kiosk mode. To allow re-authentication, use acpkcs.dll.

For more information, see Chapter 11, “Reauthenticating Applications,” on page 89.

8.2 Installing SecureLogin for Smart Cards
 Section 8.2.1, “Client Setup,” on page 66
 Section 8.2.2, “Server Side Administration Preferences,” on page 67
 Section 8.2.3, “Minimum Requirements,” on page 67
 Section 8.2.4, “Supported Configurations,” on page 67

8.2.1 Client Setup
During the installation of SecureLogin the smart card option can be selected by the administrator to 
enable a SecureLogin user to utilize a smart card to encrypt their directory data using a Public Key 
Infrastructure (PKI) token.

Existing ActivClient smart card settings are used by SecureLogin if they are detected unless the 
administrator chooses otherwise.

Location Type Name

HKEY_LOCAL_MACHINE\SOFTWARE\ 
Protocom\SecureLogin\Security\

String StorageDeviceInterfaceLibraryPKCS11

Set to: Explanation

C:\Program Files\HID Global\ActivClient\acpkcs211.dll Path to ActivClient
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The administrator can optionally select an alternative cryptographic service provider (Microsoft 
Crypto API) from a drop-down list. SecureLogin supports ActivClient, and Microsoft BaseCSP 
MiniDriver smart card middleware. Contact NetIQ Support if your organization uses any other 
cryptographic service provider.

8.2.2 Server Side Administration Preferences
SecureLogin is a highly configurable and flexible product, with numerous preferences and options, 
that allow the system administrator to implement and enforce corporate directory policy across an 
enterprise.

Corporate policies may include, but are not limited to, enabling strong application security, how SSO 
data is encrypted and stored, how password and passphrase policies are implemented and enforced, 
and setting of management procedures for lost smart card scenarios.

In the case of strong security requirements, administrators should be fully aware of the implications 
of linking the use of SecureLogin to a smart card and disabling the passphrase functionality.

Various combinations and permutations of configuring SecureLogin for use with smart cards are 
covered in following sections.

8.2.3 Minimum Requirements
For information about the minimum requirements for using smart cards with SecureLogin, see the 
SecureLogin CE 24.3 (v9.2) Installation Guide for your directory environment.

8.2.4 Supported Configurations
SecureLogin supports the following smart card middleware: 

 ActivClient 6.x and 7.x
 Microsoft BaseCSP MiniDriver

NOTE: SecureLogin might work with other smart card vendor middleware but those are not tested 
and are not supported.

While installing SecureLogin with smart card option selected, select the appropriate cryptographic 
service provider and PKCS#11 dynamic link library file path. If the appropriate version of PKCS#11 
library file is not present during installation, SecureLogin installs without smart card support. 
However, if a required library file is missing errors can occur.

 For example, if the PKCS#11 wrapper library file aetpksse.dll is missing, the  Access to smart 
card failed message is shown when Access Manager attempts to access the smart card. To avoid 
this error, ensure that the aetpksse.dll file is available at C:\WINDOWS\system32\.
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PKCS 11 Library Path

If smart card middleware is installed after SecureLogin is installed, the registry key settings for 
cryptographic service provider and PKCS#11 dynamic link library file path must be changed 
manually; to activate smart the card support, uninstall or re-install SecureLogin.

NOTE: Manually configuring a third-party smart card PKCS #11 link library assumes a high level of 
understanding of the crypto-graphic service provider’s product. System administrators are 
encouraged to use the ActivClient smart card support with SecureLogin whenever possible.

For more information about installing SecureLogin for use with smart cards and cryptographic 
tokens, see the SecureLogin CE 24.3 (v9.2) Installation Guide for your directory environment.

8.3 Configuring SecureLogin for Smart Cards
No two organizations have the same environment and requirements. SecureLogin includes a number 
of options that determine SecureLogin's behavior, such as how single sign-on data is encrypted (that 
is, using the smart card or a passphrase question and answer) and how to handle scenarios such as 
lost cards. 

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Preferences. 
3 In the Setting Description column, go to Security and select the appropriate preferences. 
4 Click Apply > OK.

Using AES for SSO Data Encryption
This option determines the level and standard of encryption used to encrypt single sign-on data 
stored on the smart card by allowing the use of AES instead of triple DES.

If you select No, a 168-bit key used with triple DES (EDE) in Cipher-Block Chaining (CBC) mode is used 
to encrypt the user's single sign-on credentials.

NOTE: The input key for DES is 64 bits long and includes 8 parity bits. These 8 parity bits are not used 
during the encryption process, resulting in a DES encryption key length of 56 bits. Therefore, the key 
strength for Triple DES is actually 168 bits. 

If you select Yes, a 256-bit key used with AES (EDE) in the CBC mode is used to encrypt the user's 
credentials.

Smart Card Middleware PKCS 11 Library path

ActivClient 6.2 C:\Program 
Files\ActivIdentity\ActivClient\acpkcs211.dll

ActivClient versions previous to 6.2 C:\Windows\Sytem32\acpkcs211.dll
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If a previous version of SecureLogin has been implemented with passphrases enabled and if this 
option is set to Yes, users must answer with a passphrase before data can be decrypted and 
reencrypted by using AES.

8.4 Using PKI Encryption for the Datastore and Cache
If PKI credentials are used to encrypt SecureLogin data with the passphrase security system off (set 
to No), you should consider implementing a key archive/backup and recovery. If key archive/backup 
and recovery is not implemented and the passphrases security system is not enabled, the users can 
never decrypt their SecureLogin data if they lose their smart card because the private key is stored 
on the lost smart card. 

Without private key recovery, you have to clear the user's SecureLogin data store before they can 
use SecureLogin again. This is a high security solution but is inconvenient to end users as they cannot 
access SecureLogin without the smart card.

 Section 8.4.1, “Choosing a Certificate,” on page 69
 Section 8.4.2, “Certificate Selection Criteria,” on page 70
 Section 8.4.3, “Current Certificate,” on page 70

8.4.1 Choosing a Certificate
When a smart card is configured to use PKI credentials to encrypt single sign-on data, SecureLogin 
retrieves the serial number of the current certificate and locates the certificate in the certificate 
store as specified in the relevant SecureLogin preferences. SecureLogin then loads the associated 
private key and attempts to decrypt the user key with the private key.

If the decryption fails or the certificate is not located, a smart card is present, and a certificate that 
matches the selection criteria is not located, then SecureLogin assumes that a recovered smart card 
is in use. It then attempts to decrypt the user key with each key pair stored on the card.

IMPORTANT: If you are using PKI encryption and the certificate selection criteria depends on the 
certificate's friendly name, you will need to disable Microsoft certificate propagation.

Because the windows certificate propogation method does not propagate the certificate friendly 
name, you cannot successfully start SecureLogin. 

To disable the Microsoft certificate propogation, set the registry key value to 0.

1. On the Windows Start menu, click Start > Run to display the Run dialog box. 
2. Type regedit then click OK to open the Registry Editor. 
3. Browse to the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion\Winlogon\Notify\ScCertProp 
4. Create a DWORD Value named Enabled.
5. Set the value of the DWORD to 0.
6. Exit the Registry Editor.
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8.4.2 Certificate Selection Criteria
The Certificate Selection Criteria preference allows you to select an encryption or authentication 
certificate to encrypt the user's single sign-on information in the directory. 

The certificate selection criteria determines which certificate to select if multiple certificates are in 
use (for example, if an enterprise has configured an Entrust certificate for single sign-on encryption 
and a Microsoft certificate for login and or, authentication). 

If only one certificate is used, the field is blank and the certificate is detected automatically and set 
to User Certificate. When entering certificate selection criteria, no special formatting is required and 
the search string is not case sensitive. Wildcards are not used and a search matches if the search text 
is a substring of the certificate subject field. SecureLogin attempts to match against certificate 
subject, issuer, and friendly name in the following order:

1. Certificate Subject
2. Certificate Issuer
3. Friendly Name

Example 8-1   For example if the subject is

CN=Writer,OU=Users,OU=Accounts,OU=APAC,DC=Novell,DC=Int
Then Writer is a valid search value, as are Accounts, APAC, and Int. The prefixes CN=, OU=, or DC= are 
not required.

Similarly, if the Certificate Issuer is

CN=IssuingCA1,OU=AD,DC=undiscovered,DC=com
Then IssuingCA1 is a valid search value, as are AD, undiscovered, and com.

8.4.3 Current Certificate
This preference displays the certificate that is currently being used by SecureLogin to encrypt a 
user's single sign-on data.

8.5 Lost Card Scenarios
 Section 8.5.1, “Lost Card Scenario Preference,” on page 71
 Section 8.5.2, “Requiring a Smart Card,” on page 71
 Section 8.5.3, “Allowing a Passphrase,” on page 72
 Section 8.5.4, “Passphrases for Temporary Access,” on page 72
 Section 8.5.5, “Using a Card Management System,” on page 72
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8.5.1 Lost Card Scenario Preference
The Lost Card Scenario preference determines how SecureLogin handles a user forgetting, losing, or 
damaging a smart card. The Lost Card scenario preference can only be used if, the Enable passphrase 
security system preference is also enabled (set to either Yes or Hidden). 

NOTE: For users upgrading from SecureLogin version 5.5, setting Enable passphrase security system 
to Hidden is equivalent to setting the old Disable passphrase security system to Off.

If a smart card is used to encrypt single sign-on data and the card is lost, stolen, or damaged. Also, if 
the key archive/backup and recovery is not used, the user will not have access to their single sign-on 
data unless the Enable passphrase security system preference is set to Yes or Hidden.

 If Enable passphrase security system is set to Yes, the user has previously set a passphrase, and 
Lost card scenario is set to Allow Passphrase, then the user is prompted to answer with his or 
her passphrase before SecureLogin is available.

 If Enable passphrase security system is set to Hidden, the user is not prompted for the answer 
and SecureLogin loads seamlessly.

Allow Passphrase
This preference allows the user to start SecureLogin using their passphrase if their smart card is not 
available. The Enable passphrase security system preference must be set to Yes or Hidden for this to 
work. Hidden replaces a user-generated passphrase with a system-generated passphrase, effectively 
removing the need for the user to remember the passphrase answer. 

IMPORTANT: For the user to decrypt data using their passphrase, the passphrase must already have 
been set. Administrators cannot simply toggle the Enable passphrase security system preference on 
the day the user forgets their smart card unless the user has previously set a passphrase (or had it 
randomly generated using Hidden).

NOTE: Administrators can manually disable inheritance of higher-level preferences by selecting Yes 
in Stop walking here in SecureLogin Administrative Management Utility > Preferences > General.

Default
The default preference is to allow the user to start SecureLogin using their passphrase, unless it 
inherits a Lost card scenario preference from a higher-level container.

8.5.2 Requiring a Smart Card
The Require smart card preference prevents users from starting single sign-on without their smart 
card. This option is for high security implementations where organizations want to tie the user's 
single sign-on credentials to the user's smart card. The user cannot single sign-on using the 
username and password without the smart card.
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IMPORTANT: If the Require smart card option is changed while the user is logged in, refreshing the 
cache using the Advanced > Refresh Cache option from the taskbar does not refresh Lost card 
scenario. 

The user must log out and log in again (or restart SecureLogin) for the new option to take effect.

8.5.3 Allowing a Passphrase
The Allow passphrase preference must be used in conjunction with the Enable passphrase security 
system option. It allows the user to start SecureLogin by using a passphrase if the smart card is not 
available. The passphrase security system must be set to Yes or Hidden for this setting to apply. 

The Hidden option replaces a user-generated passphrase with a system-generated passphrase, 
effectively removing the need for the user to remember the passphrase answer.

IMPORTANT: For the user to decrypt data using a passphrase, the passphrase must already be set. 
You cannot simply toggle the Enable passphrase security system setting to on the day the user forgets 
a smart card unless the user has previously set a passphrase (or had it randomly generated by using 
the Hidden option).

The Default option allows the user to start SecureLogin by using a passphrase if the smart card is not 
available through the Allow Passphrase preference. Alternatively, this option inherits the Lost Card 
scenario preference set by the higher-level container. 

You can manually disable inheritance of higher-level options by selecting the Yes option for Stop 
walking here (SecureLogin Administrative Management utility > Preferences > General options.)

8.5.4 Passphrases for Temporary Access
There is another option available that permit access if a user loses or forgets his or her smart card. 
For example, If a user loses or forgets his or her smart card and the Lost card scenario option is set to 
Require smart card, you can grant temporary access to systems by resetting the user's password. The 
user is then required to log in and enter the passphrase. This option is possible only if the Enable 
passphrase security system is turned on. 

However, the user should not expect easy or automatic access to the system. Users should 
understand that, a strong and secure solution has been implemented and that they have the 
responsibility of looking after their own smart cards. 

8.5.5 Using a Card Management System
Enterprise server or web-based card management system (CMS) software enables corporations to 
implement and easily manage smart card-based identity management, provisioning, and 
authentication devices and enforce policy across geographically-dispersed locations.

These systems provide a complete and flexible solution to manage the issuance, administration, and 
configuration required for the successful and seamless smart card integration.
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NetIQ CMS provides a complete and flexible solution to manage the issuance, administration and 
configuration required for a successful and seamless smart card integration with SecureLogin and 
Smart Card Password Login (SCPL). It can be configured to perform key escrow, archive and recovery 
as described throughout this document.

 “Restoring a Smart Card Using Card Management System” on page 73
 “Accessing Without a Card Management System” on page 73
 “PKI Credentials” on page 74
 “Key Generated on Smart Card” on page 74

Restoring a Smart Card Using Card Management System
The use of a CMS is crucial if an enterprise opts to deploy corporate smart cards with a very high 
level of security. This would include disabling the Enable passphrase security system preference 
combined with Store credentials on smart card (set to Yes) and Use smart card to encrypt SSO data 
(set to PKI credentials or Key generated on smart card). 

In the event of a lost or damaged smart card, the user can never decrypt their single sign-on data 
because the key stored on the smart card is not recoverable.

You must then reset the user's corporate passwords and issue a new smart card (with a new key pair) 
before the user can log in and reconfigure the single sign-on applications using SecureLogin again. 

The user must manually enter all application credentials into SecureLogin the first time he or she 
logs in after the data was cleared from the directory.

Enterprises should consider implementing key escrow, archiving, or backup through a suitable CMS 
to allow a user's encryption key to be recovered in the event of a lost or damaged smart card. 

It is recommended that you extensively test the CMS and smart card restoration techniques before 
selecting the high security options described above.

The procedure to reset a user’s data store is described in Deleting or Re-setting User Data. 

Accessing Without a Card Management System
If an enterprise opts to deploy corporate smart cards without a suitable card management system 
(CMS), you can still create a very high level of security by setting Enable passphrase security system 
to No and then selecting the Use smart card to encrypt SSO data preference to PKI credentials or Key 
generated on smart card. However, in the event of a lost or damaged smart card the user can never 
decrypt the single sign-on data because the key stored on the smart card is not recoverable.

WARNING: Deleting the user's single sign-on datastore permanently deletes the users data in the 
directory. This would include any local applications, credentials, preferences, and password policies 
that are not being inherited from some other object in the directory. 

If you still decide to delete the user's existing single sign-on configuration data store, delete it from 
the Advanced Setting > Datastore tab of the user object in the directory management tool.

The administrator must then reset the user's corporate password and issue a new smart card (with a 
new key pair) before the user can log on and reconfigure their single sign-on enabled applications.
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The user will have to re-enter all their application credentials into SecureLogin the first time it is used 
after having them deleted from the directory.

PKI Credentials
If the Use smart card to encrypt SSO data preference is set to PKI credentials and Enable passphrase 
security system is set to No, then in the event of a lost or damaged smart card the user will never be 
able to decrypt the single sign-on data because the key stored on the smart card is the only key that 
can be used for decryption. This key is not recoverable unless key archiving and recovery was 
implemented.

If a CMS-based key archive is used, then the encryption key needs to be recovered to the new smart 
card, the single sign-on data unencrypted, and an administrator needs to chose a new certificate to 
encrypt the user’s data. 

If you are using the enterprise CMS-based recovery system, you must issue the user a replacement 
smart card based on a CMS backup of the user's original key.

Key Generated on Smart Card
Similarly, if the Use smart card to encrypt SSO data preference is set to use Key generated on smart 
card, then in the event of a lost or damaged smart card the user can never decrypt the single sign-on 
data because the key stored on the smart card is not recoverable.

You should consider setting the Enable passphrase security system option to Yes when the Key 
generated on smart card option is used to provide an alternative mechanism for decrypting single 
sign-on data if the smart card is lost/stolen/damaged. 

Using the enterprise CMS-based recovery system, the administrator must issue the user a 
replacement smart card based on a CMS backup of the user's original key. The replacement card 
includes the recovered private key and a new key pair so data can be decrypted using the old key and 
re-encrypted using the new key.

8.6 Smart Card with DAS Integration 
With SecureLogin, you can enable users to log in to SecureLogin separately by using the smart card 
credentials

1 On the Windows desktop, click start > Run to display the Run dialog box.
2 Enter regedit, then click OK to open the Registry Editor.
3 Browse to the HKEY_LOCAL_MACHINE\SOFTWARE\Protocom\SecureLogin\NSLADAuth.
4 Create DWORD NSLADAuth and set the value of NSLADAuth to 1.
5 Exit the Registry Editor.
6 Log out from the workstation and log in again.
7 Launch the SecureLogin. 

This feature can be effectively used for Desktop sharing using DAS. To enable smart card with DAS 
you have to use on-cardmon and card-insert elements.
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This feature enable users to log in by using the Smart Card credentials in Desktop Automation 
Services, the on-cardmon element is modified. The card-insert and LoginAction attributes 
are added to the on-cardmon element. For more information, see on-cardmon.

8.6.1 Fast user switch using Smart Card in Active Directory Mode
The changes in smart card and Desktop Automation Services allow for switching of users using a 
smart card in Active Directory mode.

1 Log in to the workstation where you want to launch SecureLogin.
2 Configure actions.xml to hide and unhide the desktop using the smart card fast user switch.
3 Insert the smart card.

The SecureLogin PinPrompt dialog box is displayed prompting you to enter a valid PIN.
4 Enter the valid PIN.

SecureLogin is launched successfully for the smart card user.

8.7 Disconnected Login using NESCM
With this feature enabled, LDAPAuth encrypts and stores the Windows workstation or the AD 
domain user password locally and retrieve it when required, hence the user need not re-enter the 
workstation password from the next login onwards. 

With NESCM as the login method, this feature is supported in the LDAP Gina or Credential Provider 
mode with eDirectory. When logging in with NESCM in either online or offline mode, just entering 
the PIN is sufficient.

8.7.1 Registry Settings
To enable Disconnected Login using NESCM, create the following registry settings:

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE\SOFTWARE\No
vell\Login\LDAP

DWORD DisconnectedRequired 1

DWORD LDAPAuthNMASSelected 1

DWORD UsePasswordFieldforNMAS 1

String LDAPAuthNMASSequence Enhanced 
Smart Card

DWORD DoNotShutdownNSL 1

HKEY_LOCAL_MACHINE\SOFTWARE\Pr
otocom\SecureLogin

DWORD TryRegCredInOffline 1
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8.8 SecureLogin in Kiosk Mode 
In the Active Directory mode, by default SecureLogin uses the workstation logged in session to login 
to SecureLogin. User can also login to SecureLogin using different credentials by updating the 
registry setting:

1 On the Windows desktop, click start > Run to display the Run dialog box.
2 Enter regedit, then click OK to open the Registry Editor.
3 Browse to the HKEY_LOCAL_MACHINE\SOFTWARE\Protocom\SecureLogin\NSLADAuth.
4 Create DWORD NSLADAuth and set the value of NSLADAuth to 1.
5 Exit the Registry Editor.
6 Log out from the workstation and log in again.
7 Launch the SecureLogin. 

This feature can be effectively used for desktop sharing using DAS. To enable smart card with DAS 
you have to use on-cardmon and card-insert elements. For more information about these new 
attributes, see “on-cardmon” on page 155 in Administering Desktop Automation Services.

NOTE:  This feature is not supported with SecureLogin installed in the ADAM mode.

8.8.1 Kiosk Mode Using Smart Card
The changes in smart card and Desktop Automation Services allows switching of users using smart 
card in Active Directory mode.

1 Log in to the workstation where you want to launch SecureLogin.
2 Insert the smart card and Launch SecureLogin.
3 Enter the valid PIN.

The SecureLogin is launched successfully for the smart card user.

8.8.2 Kiosk Mode Without Using Smart Card
If the user's smart card is invalid or not present, then they can login to SecureLogin with a different 
credential. 

1 Log in to the workstation and launch the SecureLogin.
2 Enter the valid credentials

The SecureLogin client is launched successfully.

NOTE:  If the Active Directory user password is expired, user has to change the password through the 
Windows settings before logging in to Novel SecureLogin. In this case, SecureLogin will not prompt 
the user to change an expired password.
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8.9 Enable Pin Caching for Smart Card
To enable pin caching for smart card, update the registry settings as follows:

1 Browse to HKEY_LOCAL_MACHINE\Software\Protocom\SecureLogin.
2 Create a new DWORD value EnableSmartCardPinCache.
3 Set this value to 1.

8.10 Changing Smart Card Login Password on Expiry
In the eDirectory mode, when a user logs in using NESCM (Novell Enhanced Smart Card Method) and 
the user password is expired, SecureLogin detects the expired password and changes automatically 
on behalf of the logged in user. To enable this, update the registry settings:

1 Browse to HKEY_LOCAL_MACHINE\Software\Protocom\SecureLogin.
2 Create a new DWORD value ChangePasswordOnExpiry.
3 Set this value to 1.

NOTE: This feature is supported only with SecureLogin installed in eDirectory Novell Client mode 
without selecting Novell SecretStore Client.

The ChangePasswordOnExpiry feature does not work with complex eDirectory password policy 
settings in SecureLogin.
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9 9Support for Windows Hello for Business

Windows Hello for Business replaces passwords with multi-factor authentication on users’ devices. It 
consists of an authentication method that is tied to the device and uses a biometric or PIN. 
SecureLogin supports integrating Windows Hello for Business. After the integration, you can use the 
Windows Hello for Business method to protect the SecureLogin icon and reauthenticate 
applications. 

SecureLogin can access the datastore using a biometric or PIN. When Windows Hello for Business is 
configured in your environment, SecureLogin provides users a seamless single sign-on experience to 
their devices.

NOTE: If you want to change the login method from password to Windows Hello for Business or vice 
versa, you must provide the passphrase to update the login method.

Using Windows Hello for Business with SecureLogin, you can achieve the following goals:

 Access user data store using biometric or PIN.
 Protect the SecureLogin icon. See Protecting the SecureLogin Icon by Using Windows Hello for 

Business.
 Reauthenticate users. See Reauthenticating Users by Using Windows Hello for Business.

IMPORTANT: To use Windows Hello for Business, ensure that AES is configured for the data 
encryption. The Triple DES encryption is not supported for Windows Hello for Business.

9.1 System Requirements for Windows Hello for Business
This section provides the minimum requirements fro Windows Hello for Business to work with 
Securelogin. 

Table 9-1   System Requirements

Directory  Active Directory
 Active Directory Lightweight Directory Services

Deployment  On-premise
 Hybrid

Encryption  AES

Methods  PIN
 Biometrics
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9.2 User Data Migration from 3DES to AES Encryption
Perform the following steps to migrate the user data from 3DES to AES encryption for SecureLogin to 
work seamlessly:

1 Login as an administrator to the client machine where SLManager is installed.
2 Navigate to the user profile either by providing the object domain name or by browsing the 

navigation tree.
3 Validate that the Use AES for SSO data Encryption security preference is set to Yes.
4 Login as the user in the Windows client machine. If the user is already logged in, log off and re-

login.

9.3 Protecting the SecureLogin Icon by Using Windows 
Hello for Business
Instead of protecting the SecureLogin icon with the network password, you can use Windows Hello 
for Business to protect the SecureLogin icon. Perform the following steps:

1 Click Preferences > General.
2 Select Yes for Password protect the system tray icon.
3 Click Apply > OK. 

9.4 Reauthenticating Users by Using Windows Hello for 
Business
You can configure Windows Hello for Business to reauthenticate users. Users can then use biometric 
or PIN to reauthenticate to the application. You can configure the Windows Hello method for 
reauthentication in one of the following ways:

 Using the Administrative Management Utility
 Using the Application Definition Wizard
 Using the AAVerify Command

Security Preference  Set Use AES for SSO data encryption to Yes
 Set Use Windows Hello to encrypt SSO data to 

Yes
80 Support for Windows Hello for Business



10 10Enabling Terminal Emulator Applications

This section provides information about enabling applications for single sign-on (SSO), enabling 
terminal emulator applications, and SSO support for MEDITECH applications.

In this Chapter

 Enabling Terminal Emulator Applications
 Support for the MEDITECH Predefined Application

For more information about enabling SSO for Windows, Web, and Java applications, see the NetIQ 
SecureLogin CE 24.3 (v9.2) Application Definition Wizard Administration Guide .

10.1 Enabling Terminal Emulator Applications
You can configure terminal emulators for SSO in the application definition editor in the 
Administrative Management utility, in the SecureLogin Client Utility, and the Terminal Launcher tool.

To enable a terminal emulator for SSO, you must run the terminal launcher application (tlaunch.exe), 
and link the emulator definition to the terminal emulator application definition.

Terminal Launcher allows you to configure emulator definitions for use with SecureLogin. 

 Section 10.1.1, “Creating and Saving a Terminal Emulator Session File,” on page 81
 Section 10.1.2, “Building a Terminal Emulator Application Definition,” on page 82
 Section 10.1.3, “Running a Terminal Launcher,” on page 83
 Section 10.1.4, “Creating a Terminal Emulator Desktop Shortcut,” on page 84
 Section 10.1.5, “Setting Terminal Launcher Command Line Parameters,” on page 85

NOTE: Contact NetIQ Support for information about using a ViewNow terminal emulator.

In the following sections, Eicon Aviva is used. Although these procedures apply to most terminal 
emulators, the application definition and other configuration information might differ for each 
emulator application. Contact Support for help.

10.1.1 Creating and Saving a Terminal Emulator Session File
Prior to enabling any terminal emulator for SSO, include or create a session file that provides all the 
required settings for the server connection and any other parameters required for deployment to 
users. Terminal Launcher should be configured to run this session file when launching the emulator. 

Any modifications to the session must be saved to this file. The session file can be saved locally or on 
the server. 
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In most environments, the session file exists and you need to configure Terminal Launcher to point 
to the relevant file.

1 Start the terminal emulator application. 
2 Connect to the required host.
3 Change the terminal emulator settings as required.
4 Save the session. The default directory is usually the application’s installation directory.
5 On the Connection menu, click Disconnect.The session file remains loaded, but you are 

disconnected from the host.
6 On the File menu, click Save [session name] to save changes to the session file.
7 Exit the terminal emulator application.

10.1.2 Building a Terminal Emulator Application Definition
1 Open the SecureLogin Client Utility of SecureLogin by double-clicking, or by selecting Start > 

Programs > NetIQ SecureLogin > NetIQ SecureLogin.
2 Select File > New > Application. The New Application dialog box is displayed.
3 Select New Application Definition.
4 In the Type list, click Terminal Emulator.
5 In the Name field, specify a name for the application definition (in this example, Eicon Aviva), 

then click OK. The new application definition is added to the Applications pane.
6 Select the new application definition. The Details tab is displayed.
7 Click the Definition tab. The application definition editor is displayed.
8 Delete the default text: # place your application definition here
9 In this example for Attachmate, type the following in the text box:

WaitForText "WELCOME TO ATTACHMATE"
Type @E
WaitForText "ENTER USERID -"
Type $Username
Type @E
WaitForText "Password  ===>"
Type $Password
Type @E
WaitForText " Welcome to Attachmate"
WaitForText "***"
Delay 1000
Type @E 
You must type the screen syntax accurately in the application definition editor. Else, it will fail to 
operate. Wherever possible, copy the text directly from the emulator screen to the editor.

10 Click the Details tab.
11 Ensure that the Enabled option is selected.
12 Click OK.
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10.1.3 Running a Terminal Launcher
Terminal applications are invoked by the terminal launcher when configured properly. After you 
create the application definition in the management utility, you must use Terminal launcher to link it 
with the appropriate emulator definition. 

By setting tlaunch to point to the new application and the emulator definition, you can click the 
Create Shortcut button to create a shortcut that links everything together. Clicking the shortcut 
tlaunch launches the emulator with the configured session file. When tlaunch can communicate 
with the emulator, it invokes the application definition to interact with the host session.

IMPORTANT: For successfully using Terminal Launcher on Windows XP SP3, the screen resolution 
must be 1024 by 768 pixels. 

1 Select Start > Programs > NetIQ SecureLogin > Terminal Launcher. The Terminal Launcher dialog 
box is displayed.
This release of NetIQ SecureLogin provides two Terminal Launcher shortcuts: one each for 32-
bit and 64-bit. To launch Terminal Launcher 32 or Terminal Launcher 64, click Start > All Programs 
> NetIQ SecureLogin > Terminal Launcher 32 or Terminal Launcher 64.
Use Terminal Emulator 32 to interact with 32-bit emulators. Use Terminal Emulator 64 to 
interact with 64-bit emulators.

2 In the Available applications list, click the required application definition (in this example, Eicon 
Aviva).

3 Click Add to move the selected application to the Login to list.
4 Click Edit Available Emulators. The Available Emulators dialog box is displayed.

If you launch Terminal Launcher as a normal user on Microsoft Windows Vista or higher, the 
Edit Available Emulator button is dimmed. You must have administrator rights to edit the 
TLaunch.ini file. To edit the TLaunch.ini file:
4a Click Start > All Programs > NetIQ SecureLogin, select Terminal Emulator 32 or Terminal 

Launcher 64.
4b Right-click on Terminal Launcher 32 or Terminal Launcher 64, then select Run as 

administrator.
5 In Available Emulators, click your emulator definition. In this example, Eicon Aviva.
6 Click Edit. The HLLAPI Emulator Configuration dialog box is displayed.
7 In the Emulator Path field, specify the emulator executable’s location.
8 In the Home Directory field, specify the emulator’s home directory.
9 In the HLLAPI DLL field, specify the file name and path.

10 In the Session Files field, select and delete the current session files.
11 Click Add. The Emulator Session File dialog box is displayed.
12 Browse and select the configured session file.
13 Click OK to close the Emulator Session File dialog box. 
14 Click OK to close the HLLAPI Emulator Configuration dialog box.
15 Click Done to close the Available Emulators dialog box.
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16 (Optional) Edit the tlaunch.ini or tlaunch64.ini file and add the following new 
parameters to launch the second Terminal Emulator without any delay:
 ConnectionRetryDelay: Use this parameter to define the retry delay (in milliseconds). 

By default, the minimum value is 100 milliseconds.
 ConnectionRetries: Use this parameter to define the number of retries. By default, the 

minimum number of retires is 20.
17 In the Terminal Launcher window, ensure that Eicon Aviva is selected in Emulator.
18 Save the changes and click Launch.

You can start emulator applications from within Terminal Launcher; however, users might not have 
access to Terminal Launcher or you might need to create multiple definitions for different hosts or 
sessions. To simplify this process for users, create a desktop shortcut by using Create Shortcut.

For SecureLogin to interact with the emulator, the emulator must be invoked by tlaunch. tlaunch 
launches the emulator and invokes the NSL script to interact with the terminal session. If a user were 
to launch the emulator directly then tlaunch would not be running and no interaction would occur.

10.1.4 Creating a Terminal Emulator Desktop Shortcut
1 Select Start > Programs > NetIQ SecureLogin > Terminal Launcher. 
2 Click Create Shortcut. 
3 Select Location > Desktop.
4 Select the appropriate options from Options. Quiet mode and Suppress errors are the default 

options.
5 In the Command Line field, ensure that the following parameters are included (in this example, 
/auto /e"Attachmate" /pAttachmate /q /s):

6 Add additional parameters as required. For more information, see Section 10.1.5, “Setting 
Terminal Launcher Command Line Parameters,” on page 85

7 Click Create. The shortcut is created on the desktop. You can deploy it to users in the preferred 
mode for your organization.

8 Click Close to close the Terminal Launcher dialog box.
9 Double-click the short cut.

Parameter Description

/auto Indicates to Terminal Launcher that the following is a 
parameter requesting the execution of a terminal emulator 
application that is configured for SSO.

This parameter is mandatory.

/e[application name] Initiates the execution of the terminal emulator.

/p[Terminal Launcher config 
name]

Initiates execution of the application created in Terminal 
Launcher.

/q Quiet mode (no Cancel dialog box).

/s Suppress errors.
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10 In the Enter login credentials fields, specify your username and password.
11 Click OK.

SecureLogin stores the user's login credentials and uses them to log in to the host through the 
emulator session. Subsequently, double-clicking the desktop shortcut logs the user directly on to the 
host without any further user interaction.

10.1.5 Setting Terminal Launcher Command Line Parameters
To run the required terminal emulator, Terminal Launcher command line parameters are included in 
the desktop shortcut command. See Creating a Terminal Emulator Desktop Shortcut.

Table 10-1   Terminal Launcher Command Line Parameters

Parameter Description

/auto Indicates to Terminal Launcher that the following is a parameter requesting the 
execution of a terminal emulator application that is configured for SSO.

For example: C:\<....>\TLaunch.exe /auto /pApplication1
NOTE: This parameter is mandatory.

/p[platform/
application/
Application 
Definition 
name]

Initiates the execution of the terminal emulator as listed in Terminal Launcher Login 
to.

To run multiple applications from the same command, add /p[TL application/
Application Definition name]

You can run up to 15 applications simultaneously from the shortcut command line.

For example: C:\<....>\TLaunch.exe /auto /eAttachmate /
pApplication1 /pApplication2
NOTE: You must type the emulator name exactly as it appears in the Terminal 
Launcher Available Emulators drop-down list.

/b Specifies the background authentication mode.

/c Allows the application to close in case of any errors.

For example: C:\<....>\TLaunch.exe /auto /c /Application
Application refers to the terminal emulator application configured for SSO.

/e[emulator 
name]

The parameter /e[Terminal Launcher config name] initiates the execution 
of the terminal emulator as listed in Terminal Launcher Available Emulators. 

NOTE: You must type the emulator name exactly as it appears in the Terminal 
Launcher Available Emulators list.

/h[hllapi short 
name]

Commands TLaunch.exe to connect to the specified HLLAPI session.

/k[executable 
name]

Quits the specified executable prior to launching the terminal emulator.
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/l Disables the terminal emulator execution. This parameter is required when multiple 
instances of terminal emulator are running and you want to disable a few selected 
instances.

/m Enables multiple concurrent connections to specified sessions. This parameter is 
required for background authentication.

/n Starts the selected terminal emulator without executing a SecureLogin application 
definition. 

For example: C:\<....>\TLaunch.exe /auto /n
NOTE: This parameter does not function with VBA emulators.

It overrides /p option. 

/n[number 1-15] Starts the specified number of terminal emulator sessions without executing 
SecureLogin application definition.

For example: C:\<....>\TLaunch.exe /auto /n3
NOTE: This parameter does not function with VBA emulators.

It overrides /p option.

/q Quiet Mode (no Cancel dialog bSox).

For example: C:\<....>\TLaunch.exe /auto /q
/s Suppress errors.

/t Unlimited timeout during connection. 

For example: C:\<....>\TLaunch.exe /auto /eAttachmate /
pBackground /b /t /m /hA /s /q

/w Allows terminal emulator to wait for an application or process to complete before 
executing the next process.

/x [Shared 
Access Rights]

Setting EHLLAPI shared access for read and write permission between multiple 
EHLLAPI sessions.

For example: C:\<....>\TLaunch.exe /auto /eAttachmate /
pBackground /b /t /m /hA/s /q /xSUPER_WRITE

Parameter Description
86 Enabling Terminal Emulator Applications



Table 10-2   List of session options for EHLLAPI shared access support 

10.2 Support for the MEDITECH Predefined Application
SecureLogin supports MEDITECH 3.x and 4.x. It is dependant on the mandatory presence of the 
MEDITECH mrwscript.dll. The .dll file is provided by MEDITECH and must be installed during 
the installation of the MEDITECH application on the workstation.

NOTE: If you are an existing customer of Meditech, you can obtain the mrwscript.dll as part of 
your MEDITECH support agreement. 

/hwnd Use this parameter to pass an application handle to the terminal launcher. This 
parameter indicates the application window the terminal launcher should interact 
with.

For example: This is an application definition script that uses GetHandle command 
to get the handle and passes it to TLaunch.exe using the /hwnd parameter.

GetReg "HKLM\Software\Microsoft\Windows\CurrentVersion\App 
Paths\SLProto.exe\Path" ?SLLocation
If ?SLLocation eq "<NOTSET>"
EndScript
EndIf

GetHandle ?PuttyHWND
Strcat ?TLaunch ?SLLocation "tlaunch.exe"
Strcat ?TLaunchHWND "/hwnd" ?PuttyHWND
Run ?TLaunch "/auto" "/ePutty" "/l" "/pPutty - Detection and
Login" "/t" "/q" "/s" ?TLaunchHWND

Parameter Description

/xWRITE_WRITE By default the application has write access and allows only supervisory application to 
concurrently connect to its presentation space (WRITE_SUPER). 

Using WRITE_WRITE parameter allows other applications with predictable behavior 
to share the presentation space.

For example: C:\<....>\auto /e"Attachmate" /Tlaunch_script /q /s 
/xWRITE_WRITE

/xSUPER_WRITE Allows other applications to have write access permissions, while the originating 
application may only perform supervisory functions.

/xWRITE_SUPER Allows other applications to perform supervisory functions, while the originating 
application has complete control of the session.

/xWRITE_READ Allows other applications that perform read-only functions to share their session, 
while the originating application has complete control of the session.

/xWRITE_NONE Does not allow any other applications to share the presentation space.

/xREAD_WRITE Allows other applications to write to the session, while the originating application has 
read-only access.

Parameter Description
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During the installation of the predefined MEDITECH application, SecureLogin detects the presence of 
the application and immediately warns, if the file cannot be located. 
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11 11Reauthenticating Applications

When a user runs an application, SecureLogin seamlessly retrieves the user’s application credentials 
and authenticates in the background so that the user is not prompted to specify the password. You 
can also configure SecureLogin to prompt the user for stronger authentication to all or specific 
applications. 

Individual applications can be re-authenticated against any advanced device where SecureLogin is 
used. For example, NMAS™ infrastructure. 

You can configure SecureLogin to request application reauthentication by using one of the following 
methods:

 Using the Administrative Management Utility
 Using the Application Definition Wizard
 Using the AAVerify Command
 Using the Risk Policy of Advanced Authentication

NOTE: For environments that use NMAS, you can add the NMAS method in the Reauthentication 
Method (in the wizard login form definition screen) value by providing a free text string.

11.1 Using the Administrative Management Utility
1 Launch SLManager. 
2 Click Applications. 
3 Double-click the application that you want to use for reauthentication.
4 Click the Settings tab. 
5 Set the value for Prompt for device reauthentication for this application to Yes.
6 In Reauthentication Method, select the device that you will use for reauthentication. 

Click Any if you want the user to choose from any of the available methods.

11.2 Using the Application Definition Wizard
When creating an application definition to handle an application login screen through the 
application definition wizard, you can configure the definition to reauthenticate a user.

For information, see the NetIQ SecureLogin CE 24.3 (v9.2) Application Definition Wizard 
Administration Guide .
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11.3 Using the AAVerify Command
For applications that cannot enforce user authentication natively, use the AAVerify command to 
enforce stronger application-based reauthentication, such as biometric, token, or smartcard 
authentication. 

It is recommended to place the AAVerify command in the application script prior to the normal login 
section. This way the AAVerify command requests the pre-configured strong reauthentication 
method before SecureLogin retrieves and enters the username and password for the application. 

For more information about the AAVerify command, see “AAVerify” in the NetIQ SecureLogin CE 
24.3 (v9.2) Application Definition Guide.

11.4 Using the Risk Policy of Advanced Authentication
If SecureLogin is installed with Advanced Authentication, you can use the risk policy configured in 
Advanced Authentication to login using SecureLogin kiosk and re-authenticate users when they 
access applications containing sensitive data. The risk policy evaluates the risk level during each 
access attempts using contextual information. For example, contextual information can be IP 
address and device information. 

You can define an appropriate action for each risk level in the policy, such as granting access or 
asking for additional authentication. In case of high risk, you can configure to deny access.

For more information about how to configure a risk policy in Advanced Authentication, see 
Configuring Risk Settings in the Advanced Authentication - Administration guide.

Configuring context-aware multi-factor reauthentication for an application involves the following 
steps:

1. In Advanced Authentication: Perform the following actions:
a. Configure a risk policy with required rules.
b. Configure chains for each risk level.
c. Configure or modify the event for SecureLogin, and map the risk policy and chains to the 

event. This event must be the same one that is selected while enabling Advanced 
Authentication for SecureLogin. By default, the Windows Logon event is used.

2. In SecureLogin: Configure to use the default method for reauthentication in the Application 
Definition Wizard for the identified application.

Example
Let’s use the following example to understand the configuration:

Your organization provides a Human Resources portal to all employees. Inside the corporate network 
and within business hours, all employees can access the Human Resources (HR) portal using only 
SSO. 

However, you want the employees to reauthenticate when it is accessed beyond business hours and 
from an external network. 
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To achieve this scenario, perform the following steps:

In Advanced Authentication:

1 Configure a risk policy with IP Address Rule and User Time of Login Rule.
1a Click Risk Settings > Create a Risk Policy icon.
1b Specify the following details:

 Policy Name: Specify the name as SecureLoginPolicy.
 Description: Specify the purpose of this policy.

1c Configure IP Address Rule and User Time of Login Rule in the same sequence as follows. 
The rules are executed in the top to bottom sequence.

1d Set up the risk levels:
 Move the blue slider to 1 to indicate that if one rule fails, the risk is medium.
 Move the green slider to 0 to indicate when no rules fail, the risk is low.
 If both rules fail, then the risk is high.

1e Click Save.

Rule Configuration Steps

IP Address Rule 1. Click Add Rule.
2. Specify the rule name and the description.
3. Select IP Address Rule from Choose a Rule Type.
4. Select Is from Allow if IP address in the list.
5. Select IP address range in Manually enter the Data source.
6. Specify the range of the IP address. 

For example, 10.0.0.0 to 10.255.255.255
7. Click Save.

User Time of Login Rule 1. Click Add Rule.
2. Specify the rule name and the description.
3. Select User Time of Login Rule from Choose a Rule Type.
4. Select Is from User time of login.
5. Select the date range from Monday to Friday.
6. Select the time range from 9:00 AM to 6:00 PM.
7. Click Save.
Reauthenticating Applications 91



2 Configure chains.
2a Create the following chains: 

For more information about chains, see Creating a Chain in the Advanced Authentication 
Administration Guide.

2b Click Save.
3 Modify the Windows logon event.

3a Click Events > Windows logon. 
3b Select MediumRisk and LowRisk chains that you created in Step 2 on page 92.
3c In Risk Policy, select SecureLoginPolicy.
3d Click Save.

For more information about events, see Configuring Events in the Advanced Authentication 
Administration Guide.

In SecureLogin:

1 Right-click the SecureLogin icon in the notification area, and then click Manage Logins.
2 In Applications, select the application for which you want to enable reauthentication.
3 Select the Definition tab.

Chain Steps

For the low-
risk level

1. Click Chains > Add.
2. Specify a name for the chain in Name. For example, LowRisk.
3. Specify a Short name. 
4. Set Is enabled to ON to enable the chain.
5. Select Methods you want to add to the chain. For example, Password.
6. Specify the groups that will use the authentication chain in Roles and 

Groups.
7. Expand Risk Settings by clicking +.
8. In Minimum Risk Level, select Low.
9. Click Save.

For the 
medium risk 
level

1. Click Chains > Add.
2. Specify a name for the chain in Name. For example, MediumRisk.
3. Specify a Short name. 
4. Set Is enabled to ON to enable the chain.
5. Select Methods you want to add to the chain. For example, Password and 

SMS OTP.
6. Specify the groups that will use the authentication chain in Roles and 

Groups.
7. Expand Risk Settings by clicking +.
8. In Minimum Risk Level, select Medium.
9. Click Save.
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4 Click Edit Wizard > Re-authenticate.
5 Click Yes. Enforce re-authentication before accessing this application.
6 In Select from the methods detected, select <Default>.
7 Click OK.
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12 12Managing Application Definitions

 Section 12.1, “Responding to Application Messages,” on page 95
 Section 12.2, “Responding to Login Notifications,” on page 95
 Section 12.3, “Adding Support for Password Changes,” on page 95
 Section 12.4, “Responding to Change Password Notification,” on page 96

12.1 Responding to Application Messages
When building an application definition for an application using the wizard, it is very important to 
respond appropriately to any message that the wizard displays. You must include actions for each of 
these messages in the application definition for SecureLogin to function correctly.

12.2 Responding to Login Notifications
A login notification is a message that the application displays after a user login has submitted. This 
message is meant to notify you of the status of the login request. For example, the login notification 
might indicate that you have successfully logged in or that you have specified a wrong password.

You can define how SecureLogin must handle login notifications in your application definition. 

12.3 Adding Support for Password Changes
Depending on your organization's policies regarding password expiration, users might be required to 
change their passwords on a regular basis. Each time a user's password is changed for an application 
that is enabled for single sign-on, SecureLogin must update the stored credential information so that 
the next time the application is launched SecureLogin can provide the new password information.

To ensure that user password changes are updated in SecureLogin, configure SecureLogin to respond 
to the Change Password dialog box. 

You can configure SecureLogin to automatically generate a new password (according to password 
policy, if required) whenever the Change Password dialog box is displayed. A randomly generated 
password is safer than a user-defined, reusable password.

12.4 Responding to Change Password Notification
A change password notification is a message that the application displays after a user has submitted 
a new password.

This might be a confirmation or error message. This notification is important to SecureLogin because 
it provides the information necessary for SecureLogin to determine if it needs to update the stored 
credentials of the application.
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If a password change notification is not defined, SecureLogin prompts the user to define the 
notification, after changing the password. 
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13 13Distributing Configurations

 Section 13.1, “About Distributing Configurations,” on page 97
 Section 13.2, “Distributing Configurations Within Directory Domains,” on page 98
 Section 13.3, “Setting Corporate Redirection,” on page 98
 Section 13.4, “Configuring Groups Within eDirectory,” on page 100
 Section 13.5, “Copying a Configuration Across Organizational Units,” on page 100
 Section 13.6, “Creating an Active Directory Group Policy,” on page 101

13.1 About Distributing Configurations
SecureLogin preferences, application definitions, password rules, and credentials are collectively the 
SecureLogin configured user environment. You can deploy and maintain this environment at all 
object levels, including import/export by file, copy to another object, and so forth. The SecureLogin 
data can be added to users, containers, groups and even through Group Policy Objects in Active 
Directory environments.

A single sign-on environment that is configured at the container, organizational unit, or Group Policy 
level is inherited by all associated directory objects in the hierarchy.

First, enable applications for single sign-on with one user, then copy the applications to the 
container, OU or Group Policy level for mass deployment. This applies to all SecureLogin 
configurations, including password policies and preferences. Lower-level settings that you manually 
configure always override higher-level settings. Therefore, configuration at the user object level 
overrides all higher level configuration settings. You can manually disable inheritance from objects 
higher in directory by selecting Yes next to Stop walking here in the Preferences of the desired 
object. For example you can set this value at the partition boundaries to keep users from needing to 
walking across WAN links to locate inherited values for SecureLogin.

The inherited settings include configuration properties, application definitions, password policies, 
and credentials. For example, if a user belongs to the following hierarchy of containers and groups: 

Container 1: SettingsOfContainer1

    Container 2: SettingsOfContainer2

     Group 1 applies to Container 2: SettingsOfGroup1

        User: settings, credentials
Then, the user will inherit SettingsOfContainer1, SettingsOfContainer2, SettingsOfGroup1, settings, 
and credentials. However, the preference values set at the user object level override any values 
inherited from other objects in the directory. The settings configured at the lower level in the 
hierarchy take precedence over the settings at the higher level. For example, settings in container 2 
would take precedence over settings in container 1.
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13.2 Distributing Configurations Within Directory Domains
There are two options for distributing the single sign-on-configured environment:

 Corporate Redirection: Specifies the object from which the selected object will inherit its 
SecureLogin configuration settings. 

 Copy SecureLogin Configuration: Replicates and stores the SecureLogin environment from one 
directory object to another. 

Table 13-1   SecureLogin Configuration Options

13.3 Setting Corporate Redirection
The Corporate Redirection policy distributes SecureLogin settings of a specified object, which can be 
a container or an organizational unit, to another directory. When this policy is enabled, the recipient 
directory ignores the SecureLogin settings of its parent directory and inherits the SecureLogin 
settings of the specified object. The inherited SecureLogin configurations can include enabled 
applications, password rules, or any other settings.

The Corporate Redirection functionality bypasses the Microsoft Active Directory, NetIQ eDirectory™ 
inheritance by specifying the source object from which the current object inherits its single sign-on 
configuration. Although inheritance is redirected to a specific object, such as a container or 
organizational unit, local user object settings continue to override the inherited settings.

Before you set corporate redirection, the Administrative Management utility must be active.

Corporate redirection cannot be applied to a group object because they are not part of the hierarchy 
but linked to it.

Consider the following example:

1 Create two directory containers (OU's) under O=novell:
 ou_apps
 ou_users

If Then

 Multiple containers or organizational units require the same SecureLogin 
environment, and you want to manage configuration from one directory 
object.

 Inheritance, from a higher level object in the directory is not required.
 The container or OUs are on the same directory tree.

Do not use Corporate redirection across a slower WAN link.

Click Corporate 
redirection.

 You want to distribute configurations within the same directory across a 
slower WAN link.

 You want to replicate a complete SecureLogin configuration environment 
from one object to another in the directory.

 You do not want to use XML files to distribute SecureLogin configuration 
data.

Click Copy 
SecureLogin 
configuration.
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2 Create a user (user1) in ou_users (user1.ou_user.novell).
3 Create SecureLogin applications and, or define settings on the ou_apps.novell container.
4 Set corporate redirection on ou_users.novell to point to ou_apps.novell. The following 

is seen:
 user1 has applications and settings defined at ou_apps.novell. 
 user1 also has its own applications and settings.

You can configure the Corporate redirection preference only to be redirected to a specific 
organizational unit or container. 

 When set to a user, the user does not inherit any SecureLogin preferences from their nominal 
hierarchy but from the other organizational unit or container.

 When applied to an organizational unit or container, any user in that object does not inherit 
SecureLogin preferences from its container settings. It inherits from the other organizational 
unit or container.

To get the correct inheritance, users must be granted the correct rights to inherit from other object. 
The inheritance process stops at the redirected container. There is no inheritance from the 
redirected object’s hierarchy. 

In the following example, the Finance organizational unit is redirected to inherit the SecureLogin 
configuration from the Development organizational unit.

1 Launch the Administrative Management utility (SLManager or MMC snap-ins).
2 Click Advanced Settings. 
3 Specify the full distinguished name of the object in Corporate redirection. 

NOTE: The full distinguished name is required to uniquely identify the container or 
organizational unit. 

In this example, the Development organizational unit (ou=development,dc=training7,dc=com)
4 Click Apply.
5 Click OK.

Click Applications to view the application definitions inherited from the object. Click Preferences 
to view the inherited preferences. In this example, the preferences inherited from the 
Development ou.
Ensure that you do not overwrite administrator settings when distributing SecureLogin 
configuration environments. For example, if you set the preference Allow users to view and 
change settings to No and then copy this to the container or organizational unit as part of a 
SecureLogin environment, including the Administrator user object, the administrator cannot 
view or change SecureLogin settings because they reside in that organizational unit. To prevent 
this from happening, all administrator user objects should be located in a separate 
organizational unit, and administrator preferences should be manually configured.
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13.4 Configuring Groups Within eDirectory
You must make additional attribute assignments to the group objects. This is primarily required 
when users use different administrative management utilities, such as NWAdmin or ConsoleOne.

1 Launch SLManager. 
2 Specify the distinguished name of the container object you want to modify.

NOTE: SecureLogin supports configuring group memberships only within a container object.

3 Select Advanced Settings > Configured Groups. The Group Configuration dialog box is displayed.
4 Click Add. 
5 Provide the distinguished name of the group object. 
6 Click OK to add the new group object. 

Use the Up and Down options to promote or demote the order in which the group policies are 
applied. 

NOTE: Within the Group Configuration, the higher group takes precedence.
Configured groups can only be set against containers like O and OU and not set against a user 
object. In such a case, contrary to the earlier statement, the higher container takes the lower 
precedence.

When looking at the defined SecureLogin applications from within the properties of a group 
member, you will not see the "innerweb" application listed. However, the configured 
application will be available in the client when SecureLogin is launched at the workstation.

13.5 Copying a Configuration Across Organizational Units
You can copy an object’s SecureLogin configuration to another object from the Distribution pane in 
the Administrative Management utility. This functionality replicates the SecureLogin configuration 
internally in the same directory tree.

NOTE: In the following example, the Development organizational unit SecureLogin environment is 
copied to the Finance organizational unit.

1 Launch the Administrative Management utility (SLManager or MMC). 
2 Click Distribution > Copy.
3 Under Select SecureLogin Configuration, select or clear the appropriate check boxes.

Configuration Function

Applications Copies, exports, or imports all configured application definitions, as displayed in 
the Applications pane.

Credentials Copies, exports, or imports all credentials as displayed in the Logins pane, 
excluding passwords.
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4 In the Destination Object, click the name of the object or type the full distinguished name.
5 Click Copy.

If a predefined application or an application definition currently exists in the destination object, 
a confirmation message appears. It confirms or rejects the overwriting of the imported data.

6 Click Yes or No as required.
The selected SecureLogin configuration is copied across to the destination user object, 
organizational unit or container. A confirmation message appears, advising what information 
has been loaded to the destination object.

7 Click OK.

13.6 Creating an Active Directory Group Policy
 Section 13.6.1, “Group Policy Object Support,” on page 101
 Section 13.6.2, “Group Policy Management Console Support,” on page 102
 Section 13.6.3, “Definition of a Group Policy Object,” on page 102
 Section 13.6.4, “Adding or Editing a Group Policy Object,” on page 103
 Section 13.6.5, “Installing the GPMC Plug-In,” on page 103
 Section 13.6.6, “Retrieving a Policy Applied to the User Object in GPMC,” on page 104
 Section 13.6.7, “Retrieving a Policy Applied to the User Object in SLManager,” on page 105

13.6.1 Group Policy Object Support

Prerequisites:
 SecureLogin is installed with support for group policies.
 The Active Directory Users and Computers snap-in or Group Policy Management Console is 

open.

Using Group Policy object support, you can manage SecureLogin users in Active Directory users at 
the container, OU, and user object levels.

Group Policy object support is useful for organizations with flat directory structures where a more 
granular approach is required when applying settings, policies, and application definitions for users. 
For example, applying a group policy for a global marketing group in a worldwide organization. 
Several group policies can be defined and applied to any user, group, or container at the directory 
level. These different policies are then applied to a specific user object or container or organizational 
unit through the inheritance process. 

Password Policies Copies, exports, or imports password policies as displayed in the Password 
Policies Properties table

Preferences Copies, exports, or imports all preferences manually set in the Preferences pane.

Active Passphrase 
Question

Provides users with a selection of passphrase questions. This option copies, 
exports, or imports only the passphrase question the user has responded to.

Configuration Function
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To limit network traffic during the Group Policy object synchronization, SecureLogin leverages an 
existing Microsoft Windows feature to specify policy settings that are updated when the group 
policy object changes.

Edit the WinLogon/GPextensions in the Windows Registry, and set the NoGPOListChanges key to 1.

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\GPExtensions\{2893059c-1175-11d9-8088-
00e018f97d4d

13.6.2 Group Policy Management Console Support
You can see the resultant set of single sign-on policy settings that apply to a particular user object 
when multiple SecureLogin group policies and organizational unit or user object setting are applied 
through the Microsoft’s Group Policy Management Console (GPMC), which now includes support for 
Resultant Set of Policy (RSOP).

NOTE: The GPMC must be installed on the administrative workstation where you want to see the 
resultant set of policies.

Resultant Set of Policy Settings
The Resultant Set of Policy (RSOP) is a feature of a group policy that makes the implementation, 
troubleshooting, and planning of group policies easier and allows you to plan how the group policy 
changes might affect a targeted user or computer or remotely verify the policies under effect on a 
specific computer. 

When multiple group policy objects are applied to a given user or computer, the policy can often 
contain conflicting policy settings. For most policy settings, the final value of the setting is set only by 
the highest precedent Group Policy object that contains that setting.

RSOP assists directory administrators to understand and identify the final set of policies that are 
applied as well as settings that did not apply as a result of policy inheritance.

In this version of SecureLogin, you can see the final SecureLogin settings that apply to a user when 
he or she starts SecureLogin. You have the ability to do the following:

 Retrieve the policy applied to the user object in the Microsoft Management Console.
 Retrieve the policy applied to the user object in SLManager.
 Define from which policy the setting is inherited.

13.6.3 Definition of a Group Policy Object

IMPORTANT: Group policy functionality is enabled only if it was selected during the installation of 
SecureLogin in Microsoft Active Directory mode. For more information, see the “Installing and 
Configuring in an Active Directory Environment”.

For more information about Group Policy Objects (GPOs), go to the Microsoft website.
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Policy settings are stored in Group Policy Objects (GPOs). Settings for each GPO can be edited using 
the GPO Editor from within Microsoft’s Group Policy Management Console (GPMC).

When an administrator defines a SecureLogin GPO, they can now use the GPMC to add this group 
policy or edit and configure the SecureLogin settings.

13.6.4 Adding or Editing a Group Policy Object
Policy settings are stored in Group Policy object settings for each Group Policy object and can be 
edited using the Group Policy object editor from Microsoft (GPMC).

The group policy functionality is enabled during the installation of SecureLogin in Microsoft Active 
Directory mode. For more information, see “Installing and Configuring in an Active Directory 
Environment”in the SecureLogin CE 24.3 (v9.2) Installation Guide.

When you define a SecureLogin Group Policy Object, administrative users can use the GPMC tool to 
add this group policy or edit and configure the SecureLogin settings.

13.6.5 Installing the GPMC Plug-In
With the Microsoft’s GPMC plug-in, you can manage core aspects of Group Policy object across 
enterprises.

For Microsoft Vista (or higher) customers, the GPMC snap-in is already integrated in to the operating 
system.

Existing Windows XP and Server customers can download the gpmc.msi installer package at the 
Microsoft website and install the Microsoft GPMC plug-in.

NOTE: After installation, the Group Policy tab that previously was on the Property pages of sites, 
domains, and organizational units in the Active Directory plug-in is updated to provide a direct link to 
GPMC. The functionality that previously existed on the Group Policy tab is no longer available 
because all functionalities for managing a Group Policy is available through the GPMC plug-in.

Managing Group Policy Objects through the GPMC
Use any of the following methods to open the GPMC plug-in directly: 

 Click Start > Programs > Administrative Tools > Active Directory Users and Computers. The Active 
Directory Users and Computers page is displayed.

 In the navigation tree, right-click the appropriate organizational unit, then click Properties. The 
selected organizational unit page is displayed.

 Click Group Policy, then click Open.
 Click Start > Programs > Administrative Tools > Group Policy Management.
 Click Start > Run. The Run page is displayed.

1 At Open, type mmc.
2 Click OK. The Management Console is displayed.
3 Click File.
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4 Click Add/Remove Snap-in. The Add/Remove page is displayed.
5 Click Add. The Add Standalone Snap-in page is displayed.
6 Select Group Policy Management and then, click Add.
7 Click Close. The Add Standalone Snap-in page is displayed.
8 Click OK. The Group Policy Management page is displayed. 

NOTE: When you launch the GPMC for the first time, it loads the forest and domain containing the 
user object logged in to the computer. You can then specify the forest and domain to be displayed. 

When you close the GPMC, it automatically saves the last view and returns that view the next a user 
opens the console. 

13.6.6 Retrieving a Policy Applied to the User Object in GPMC
The definition of the Group Policy Objects are defined by the administrator at the directory level, so 
changes can now be seen immediately at the OU, container or user object level, depending on the 
level where the group policies have been applied and the SecureLogin preferences applied.

These settings must follow the rules already defined of inheritance and precedence:

 The Stop walking here preference
 The Corporate Redirection setting
 The Group Policy object settings and their priorities
 The directory hierarchy settings

The precedence rules are respected and follow the rules already defined:

 The deepest object in the tree has the precedence over any other higher-level object
 The group policies have the lower precedence than all OUs and User objects.

As a consequence of all these processes, the administrator can now see the resultant set of the 
policies in the user object either through MMC interface or administrative management utilities.

The resultant set of policies are displayed in the bottom left hand corner of the SecureLogin 
Administration Management utility. They show from which Group Policy the current setting has 
been inherited.

NOTE: The retrieval of all SecureLogin configuration information is subject to both SecureLogin and 
native Directory access controls. In the unlikely circumstance that the user has rights to read a Group 
Policy object but the administrator does not, this system displays incorrect effective configuration 
information. This is because the administrator simply cannot access the same information as the 
user, and any mechanism for allowing this would introduce a security problem.

In this specific configuration, if SecureLogin has no way to retrieve the exact policy applied to the 
user object, then a message is displayed indicating that the information displayed does not 
correspond to the resultant set of policies applied to this user object. The message RSOP not 
available is displayed in the bottom left side of the Administration Management console.
104 Distributing Configurations



13.6.7 Retrieving a Policy Applied to the User Object in SLManager
Because the definition of the Group Policy objects are performed by you at the directory level, any 
changes are now seen immediately at the OU, container, or the user object level.
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14 14Managing Configurations

You can use SecureLogin to export or import unencrypted and encrypted XML files. The export 
functionality of SecureLogin creates an XML file that is external to the directory. You can import the 
SecureLogin information from this XML file to different directory types, servers, domains, 
containers, group policies, organizational objects, and user objects.

 Section 14.1, “Exporting the Single Sign On Data in Encrypted XML Files,” on page 107
 Section 14.2, “Importing Single Sign-On Data in Encrypted XML Files,” on page 108
 Section 14.3, “Creating a Signing Key for Secure Distribution,” on page 108
 Section 14.4, “Locally Installing a Digital Signing Key,” on page 110

14.1 Exporting the Single Sign On Data in Encrypted XML 
Files
Using SecureLogin Manager (SLManager), you can encrypt and password-protect or digitally sign the 
exported files to ensure the information is secure. Alternatively, you can also export an unencrypted 
file for unrestricted distribution. 

1 Launch SLManager.
2 In the object field, specify your object name, then click OK. 
3 Click Distribution. 
4 Click Save. 
5 Select the configurations that you want to export. 

6 In Select File Protection, select Password protected and encrypted. If you select Not encrypted, 
credentials will not be exported.

7 Specify and confirm the password.
8 Click OK. 
9 Select the applications to be exported and click OK.

Configuration Function

Application Exports all configured application definitions as displayed in Application.

Credentials Exports all credentials as displayed in the Logins pane, including passwords.

Password Policies Exports password policies as displayed in the Password Policies Properties table.

Preferences Exports preferences manually set in the Preferences Properties tables.

Passphrase Question Provides users with a selection of passphrase questions. This option copies, 
exports, and imports only those passphrase questions to which the user has 
responded.
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10 Specify a name for the file, select a location, and click Save. 
11 Click OK.

14.2 Importing Single Sign-On Data in Encrypted XML Files
1 Launch SLManager.
2 In the object field, specify your object name, then click OK.
3 Click Distribution. 
4 Click Load. 
5 Select the configurations you want to import. 

6 Click OK. 
7 Select the exported encrypted (ESX) file.
8 Click Open. 
9 Specify the password and click OK.

If a predefined application or an application definition already exists in the destination object, 
you get a confirmation message.
Click Yes if you want to overwrite the existing application definition with the imported one. 

10 If you click Yes, the configuration is copied across to the user object, organizational unit, or 
container. A confirmation message appears indicating that the information is copied to the 
destination object. 

11 Click OK.

14.3 Creating a Signing Key for Secure Distribution
After you configure and tested SecureLogin in an user environment, you can create a digital signing 
key that is embedded in the .exe file. You can distribute the file through a web download or email to 
the users. When users receive the file, they need to double-click the file to load to the local 
workstation. This updates the following configurations:

 Preferences
 Application definitions

Configuration Function

Application Imports all configured application definitions as displayed in Application.

Credentials Imports all credentials as displayed in the Logins pane, including passwords.

Password Policies Imports password policies as displayed in Password Policies Properties.

Preferences Imports preferences manually set in the Preferences Properties tables.

Passphrase Question Provides users with a selection of passphrase questions. This option copies, 
exports, and imports only those passphrase questions to which the user has 
responded.
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 Password rules
 Credentials

This is collectively known as the SecureLogin configured user environment. This is designed for users 
of standalone SecureLogin (such as mobile users) and those who do not frequently connect to the 
corporate network.

When a digital signing key is created, the key pair is randomly generated by SecureLogin to increase 
security.

To create a digital signing key, perform the following steps:

1 Launch SLManager.
2 In the object field, specify your object name, then click OK.
3 Click Distribution. 
4 Click Save. 
5 Select the configurations you want to export.
6 Under Select File Protection, select Digitally signed and encrypted.
7 (Optional) Select Administrative data will overwrite user’s data without notification.

If you select this option, users are prompted before overwriting any data with the configuration 
settings saved in the .msi file.

IMPORTANT: Selecting this option results in the user data being overwritten with the 
configuration setting in the .msi file for any items that are present in both user’s local 
configuration and administrative configuration (.exe file).
For example, if a user has an application definition configured locally, and a predefined 
application definition is supplied in the .exe file, the .exe file application definition overwrites 
the user’s application definition without notification.
However, for example, if a user has configured a Hotmail application definition locally, and a 
predefined application is not supplied in the .msi file, the user’s Hotmail application definition 
is not changed.

8 Click Manage Keys. 
9 Specify a name for the key in Generate Digital Signing Key.

10 Click Create > Close.
11 In Key List, select the newly created key.
12 Under Install, click Install Package. 
13 Browse to locate the distribution file (.msi file) in which you want to embed the key.
14 Click Open. A confirmation message that the key is embedded in the .msi file is displayed.
15 Click OK.

You can now distribute and install the .msi file on the user’s machine. This allows them to 
import signs that are signed and encrypted.
After the keys are created, they must not be deleted because they are randomly generated. 
They key used must correspond to the key that is been previously packaged and with the 
distributed installer.
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14.4 Locally Installing a Digital Signing Key
1 Log in to SLManager.
2 In the object field, specify your object name, then click OK.
3 Click Distribution. 
4 Click Manage Keys. 
5 Specify a name in Generate Digital Signing Key.
6 Click Create.
7 In the list, select the new key.
8 Under Install, click Install Locally. 
9 Click OK.
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15 15Using the slAP Tool

 Section 15.1, “About the slAP Tool,” on page 111
 Section 15.2, “The slAP Syntax,” on page 112

15.1 About the slAP Tool
The SecureLogin Attribute Provisioning (slAP) tool uses command line options to allow SecureLogin 
to leverage user data from an organization’s provisioning system. Using the slAP tool, you can import 
data, in XML format from third-party applications into the SecureLogin user’s datastore and export 
information (except passphrase answers).

This tool can import and export the following data:

 User variables
 Application definitions
 Organizational settings
 Password
 Password policies
 Logins
 Passphrase questions 

The slAP tool command operates as a provisioning tool between SecureLogin data in a directory and 
in an XML file. The XML schema used is the same as the Copy Settings GUI importer/exporter. In 
addition to copying settings, the slAP tool can extract user names. 

For example, an organization with 10,000 users in a SAP system, implementing SecureLogin can 
speed deployment significantly by automating the initial user login. To do this, use a file containing 
multiple users’ username and password combinations from SAP, and use the slAP tool to import the 
file into the SecureLogin datastore as a bulk process. The slAP tool removes the requirement for each 
user to enter credentials on the first log in to SecureLogin.

If the slAP tool is used to import data into SecureLogin from an encrypted or an unencrypted file, 
and any preferences are set that require the SecureLogin version 6 data store format, then the 
datastore version must be specified in the file. Preferences that require the version 6 format are:

 EncryptionType
 NRKeySource
 StoreDataOnSmartCard
 UseEnhancedProtectionByDefault

The datastore version is set as: 

<preference>
   <name>AppliedSSODataStoreVersion</name>
   <value>600000</value>
   <isdatastore/>
</preference>
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If the value of this preference is not set to 6, 6.0, or 600000 then an error message is returned from 
the slAP tool: Cannot import version 6 datastore preferences into a lower versioned datastore.

When the slAP tool is used for initial provisioning of SecureLogin user accounts, before any 
SecureLogin data has been stored for users, the XML file must include a passphrase question and 
response. This question/response can be the same for each user and can be changed by the user 
after deployment.

NOTE: SecureLogin does not need to be running to use the slAP tool.

15.2 The slAP Syntax
slaptool [-hlvasISpEcPefdF] [-k password] -r object_name_file | -o "object" [file | 
App ID | Credential ID]
The following table describes the command options:

Command Description

-h Displays a help message and exits (all other options are ignored).

-l Excludes user IDs. 

-v Excludes variables. 

-a Excludes applications.

-s Excludes settings. 

-S Include passwords. Only applies to export operations which include symbols and must be 
used in conjunction with -E for security.

-p Excludes password policies. 

-E password Specifies that the generated XML should be encrypted or decrypted using the supplied 
password. Password must be at least 8 characters long.

-f Use the current user, for export allow inclusion of password credentials. (Cannot be used 
with -r or -o).

-c Excludes credsets.
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-d Performs delete rather than import.

For example:

 To delete logins:

slaptool -d -o "cn=abc,dc=123" -l
 To delete applications:

slaptool -d -o "cn=abc,dc=123" -a
 To delete password policy:

slaptool -d -o "cn=abc,dc=123" -p
NOTE: You can also use -f, to perform delete operation for the current user.

For example:

 slaptool -d -f -l
-F Performs delete of all applications or login without user confirmation.

For example:

 To force delete all applications:

slaptool -d -f -a -F
-e Performs an export rather than an import. 

-r 
<object_name_
file>

Specifies a file containing line-delimited object names on which to perform the 
operation.

-o <object> Specifies a particular object on which to operate. 

[file] Specifies one or more .XML files from which to read data (or to write to for exporting). 
No file specification. It reads and writes data from and to the stdin and stdout. 

For example:

./slaptool.exe -o "cn=bernie, cn=netiq, dc=testdomain, dc=com" 
initial_setup.xml
This reads userIDs, applications, settings and password policies from the file 
initial_setup.xml and writes them out to the object: 

"cn=bernie, cn=netiq, dc=testdomain, dc=com"

Command Description
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NOTE: 
 If the -P switch was not used during the export operation, you must use -P or -k switch during 

the import operation.
 If -P switch was used during the export operation, then -P or -k switch is not required during 

the import operation.
 When using the slAP tool in the eDirectory mode and Novell Client is installed, use the following 

syntax:

slaptool <command option> -o <user DN in NDS format> -a

For example: 

slaptool -d -o "abc.mytestou.novell" -a

[App ID/
Credential ID]

Specifies one or more application ID or credential ID in case of delete.

If none is specified, all applications and credentials are deleted.

For example:

 To delete specific credential:

slaptool -d -f -l <Credential ID>
 To delete specific application:

slaptool -d -f -a <App ID>
 To delete all applications:

slaptool -d -f -a
-P Exclude Passphrase.

-k [password] Enables the creation of a passphrase answer for individual users in LDAP and Microsoft 
Active Directory environments. 

It is mandatory for users to save a passphrase answer on first log in to SecureLogin. The 
slAP tool requires password authorization to save user data. The -k switch provides the 
user password, enabling automated creation of the passphrase answer. This answer can 
be manually changed by users after provisioning. 

For example, the following command is used to import user data and a passphrase 
question and answer combination:

slaptool.exe -k password -o context filename.xml
This reads userIDs, applications, settings, and password policies from the file 
initial_setup.xml file and writes them out to the object: 
"cn=writer,cn=netiq, dc=testdomain, dc=com" 

-I  Includes settings inherited from containers or groups.

Command Description
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Syntax of slAP Tool for Migrating to Advanced Edition
Using the slap tool you can migrate the data at the user-level or at the group-level.

 At the user-level: You can migrate the data using UPN of the user.
 Export: slaptool.exe -e -a -s -P -E <password> -S -f <path of the 
backup XML file>
For example, slaptool.exe -e -a -s -P -E xyz -S -f d:\nslbackup.xml

 Import: slaptool.exe -E <password> -o "UPN" <path of the exported XML 
file>
For example, slaptool.exe -E xyz -o "migrate@nsl-test.xyz" 
d:\nslbackup.xml

 At the group-level: You can migrate the data using GUID of the group. While migrating, you 
need to specify the object ID of the group instead of the group name.
 Export: slaptool.exe -e -a -s -P -E <password> -S -f <path of the 
backup XML file>
For example, slaptool.exe -e -a -s -P -E xyz -S -f d:\nslbackup.xml

 Import: slaptool.exe -E <password> -o "GUID" <path of the exported XML 
file>
For example, slaptool.exe -E xyz -o "52926721-ce14-4b0a-b7ef-
b1261282d24e" d:\nslbackup.xml

slAP Tool Example
The following Perl application definition, created for the example organization discussed previously, 
assumes that user names and passwords are stored in a text file named listofnames.txt. There 
is one space between each username and password pair per line.

A XML file, such as the “XML File Example” on page 116 is required to run this application definition, 
containing the data for import. Where the data is customized on a per user name basis, the string to 
be substituted is replaced with *usernamegoeshere*.

For example:
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******************************************************
open FILE,"listofnames.txt";
foreach (<FILE>) {
chomp;                  # Clean string
@lines = split(/\n/);   # Split up string
for each $l (@lines) {
    @fields = split(/\s/);
    $name = $fields[0];
    $pass = $fields[1];
    open DATAFILE,"source.xml";
    open OUTFILE,">data.xml";
    foreach (<DATAFILE>) { # Write up a file specific to this user
        s/\*usernamegoeshere\*/$name/;
        s/\*passwordgoeshere\*/$pass/;
        # Any other variable substitution can be done here too...
        print OUTFILE "$_";
   }
    close DATAFILE;
    close OUTFILE;
   system "slaptool.exe -k \"$pass\" -o
\"CN=$name.O=myorg.T=OURCOMPANY\" data.xml";
        }
}
close FILE;
unlink 'data.xml';
****************************************************
Using an XML file called source.xml, run the application definition with the data that is to be 
imported. For example, you can manually export data from a single user setup with the value for the 
username replaced with the string "*usernamegoeshere*".

NOTE: The example application definition does not include error handling.

XML File Example
<?xml version="1.0"?>
<SecureLogin>
   <passphrasequestions>
      <question>Please enter a passphrase for SLAP testing.</question>
   </passphrasequestions>
   <passphrase>
      <activequestion>Please enter a passphrase for SLAP 
testing.</activequestion>
      <answer>passphrase</answer>
   </passphrase>
   <logins>
      <login>
         <name>fnord</name>
         <symbol>
            <name>username</name>
            <value>bob</value>
         </symbol>
         <symbol>
            <name>Password</name>
            <value>test</value>
         </symbol>
      </login>
<login>
         <name>notepad.exe</name>
         <symbol>
            <name>username</name>
            <value>asdf</value>
         </symbol>
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         <symbol>
            <name>Password</name>
            <value>test</value>
         </symbol>
      </login>
      <login>
         <name>testlogin</name>
         <symbol>
            <name>username</name>
            <value>Novell</value>
         </symbol>
         <symbol>
            <name>Password</name>
            <value>test</value>
         </symbol>
      </login>
    </logins>
</SecureLogin>
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16 16Migrating the Datastore Using the 
slMigrationHelper Tool

The slMigrationHelper tool migrates the data from an existing datastore to a new datastore. 
This tool is an enhanced version of the slAP tool and helps in the seamless migration with minimal 
disruption of service. 

The data migrated during the migration process includes:

 User variables
 Application definitions
 Organizational settings
 Password policies
 Logins
 Passphrase questions and answers

The following are the benefits of using this tool:

 No need to install SecureLogin in a new mode: You only need to export the data from an existing 
installation and then import the data to configure SecureLogin with the new datastore.

 Single restart: You need to restart your workstation only once to complete the migration. 
 Seamless migration: The entire process of exporting the data, reconfiguring SecureLogin to the 

new datastore, and importing the data is seamless and requires minimal manual intervention.
 No uninstallation required during migration: You can continue the migration process without 

uninstalling the existing SecureLogin installation. This results in minimal disruption of service.

In this Chapter

 Datastores Supported for Migration
 Migrating the Datastore

16.1 Datastores Supported for Migration
The migration is supported for the following datastores:

 Microsoft Active Directory
 eDirectory 887
 OpenLDAP
 Active Directory Application Mode (ADAM) or Active Directory Lightweight Directory Services 

(AD LDS)
 SecureLogin Advanced Edition (Azure Active Directory)
 NDS
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16.2 Migrating the Datastore
The migration process involves the following two phases:

 Migrating the administrator-managed settings: If you want to decommission your existing 
datastore and move to another datastore, you need to migrate all settings, preferences, 
application definitions, password policies, logins with passwords, and other stored data.

First, you need to identify the shared configurations, such as containers and group policy 
settings, and how it will be fit in the structure of the new datastore. You can export this 
administrator-managed data using the tools similar to the existing process of distribution, and 
then import these to the new environment.

See Distributing Configurations, Using the slAP Tool, and Managing Configurations (SLManager).
 Migrating the per-user settings: The per user data, which is encrypted by the user is not 

transferable by an administrator without the user’s keys to unlock it. Also as part of migration, 
the client application needs some reconfiguration where the data is stored via installer 
modification. The slMigrationHelper tool performs these per user actions, running the process 
of exporting the data, reconfiguring the SecureLogin client to the new datastore, and importing 
the data. Users’ inherited settings from containers or group/group policy are not migrated by 
default.

Perform the following steps to migrate the per-user settings by using the slMigrationHelper tool:

1 Determine the following details:
 Whether you want to upgrade from an earlier version and migrate or only migrate from 

one datastore to another in the same version of SecureLogin.
 The type of the new datastore and any associated additional installer options, such as 

server address.
2 Go to the SecureLogin\Tools\Administration\Provision Tools folder.
3 Run the slMigrationHelper tool with the following options as required:

 The option to import the data automatically after login (requires HKLM access)
 The option to specify where to export the users' encrypted data
 The option to customize the password of the exported data
 The option to exclude the passphrase in the migration

For more information about these options, see Table 16-1 on page 121. 
4 Based on the installer prompt, re-login or restart SecureLogin to load it in the new datastore 

mode. 
5 If you did not choose to import the data automatically, run the tool again with the option to 

import all the data.
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Table 16-1   slMigrationHelper Options

Option Description

Migrate to the same version or upgrade to a later version

-m Use this option to modify an existing SecureLogin installation.

For example: If you are on eDirectory, run the following command to specify that the 
existing installation needs to be modified to run with a new datastore:

slmigrationhelper.exe -m [Datastore options]
You can also specify additional options during the modify process. For example, 
slmigrationhelper.exe -m ADDLOCAL=SeamlessLDAPGina

-u <path of 
the 
installer>

Use this option to upgrade SecureLogin and change the datastore. To upgrade and change 
the datastore, use this option in combination with option -t to specify the new datastore.

For example, slmigrationhelper.exe – u <path of the 9.0 installer> - 
t [datastore]
You can choose to upgrade to a newer version without changing the datastore.

For example, slmigrationhelper.exe – u <path of the 9.0 installer>
You can specify additional options during the upgrade or modify process.

For example, slmigrationhelper.exe -u <path of the 9.0 installer> 
ADDLOCAL=SeamlessLDAPGina

Installer options

-t 
<datastore>

Use this option to specify the datastore you want to migrate to. This option is used in 
combination with option -m.

The valid datastores are:

 Microsoft Active Directory (AD)
 Active Directory Application Mode (ADAM) or Active Directory Lightweight Directory 

Services (AD LDS)
 LDAP

IMPORTANT: Multiple options are available for seamless login in the LDAP mode:
— Windows Login (Credential Provider): The SeamlessLDAPGina feature
— Network provider credential manager (Post-login, before desktop): The 

SeamlessLDAPCred feature
— On SecureLogin application launch: The LDAPApp feature

 LDAPSecretStore
 NDS
 SecureLogin Advanced Edition (Azure Active Directory)

IMPORTANT: When you migrate to SecureLogin Advanced Edition (SLAE):
— The seamlessMAD feature is installed automatically for the seamless login 
— SLAESERVERADDRESS is required
— By default the value of SLAEPORT is TLS 443
— You can migrate to SLAE only from Active Directory or ADAM. Migration from SLAE 

to any other mode is not supported.

For examples, see “Example Commands for the -t Option” on page 123.
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 Example Commands for the -t Option
 Migrating from the SecretStore Mode to Other Modes
 Upgrading SecureLogin and Migrating the Datastore

-q Use this option to run the installer in the quiet mode. By default, all installation program 
screens are displayed during the migration process.

For example: slmigrationhelper.exe -q
Export options

-f <path of 
the XML 
file>

Use this option to specify path to the file that will contain all the exported data. All the data 
is stored in the XML format.

For example: slmigrationhelper.exe – f <path of the file>
-E Use this option to encrypt the exported data. If you do not specify a password, the default 

password changeit is used for encryption.

For example: slmigrationhelper.exe – E <password>
Import the exported user data manually or automatically

-i <path to 
the XML 
file>

Use this option to import the previously exported data.

For example: slmigrationhelper.exe – i 

-r Use this option to invoke importing of user data from the XML file. 

Using option updates 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\RunOnce.

For example: slmigrationhelper.exe -r
Export/import option

-P Use this option to exclude import/export of passphrase information. If you have excluded 
passphrase import and export, during installation the user has to configure the passphrase 
information. 

For example: slmigrationhelper.exe -m -f <path to the XML file> -P
-I Use this option to include settings inherited from containers or groups.

For example, you can include or exclude the settings inherited from containers or groups as 
follows:

 To include:

slmigrationhelper.exe -m -t SLAE -I
 To exclude:

 slmigrationhelper.exe -m -t SLAE
Help option

-h Use this option to display help for the slmigrationhelper tool.

Option Description
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Example Commands for the -t Option
You can use the APPENDLOCAL property to add additional features to be installed. 

For example, you can use the APPENDLOCAL command to add DAS and Syslog as additional features 
in the LDAP mode using the following command:

slmigrationhelper.exe -u C:\NetIQSecureLogin.exe -t LDAP 
ADDLOCAL=SeamlessLDAPGina LDAPSERVERADDRESS=127.0.0.1 
APPENDLOCAL=DAS,Syslog

NOTE: You can specify multiple comma-separated features as required in APPENDLOCAL. For more 
APPENDLOCAL commands, see the command options in the mode-specific sections in the 
SecureLogin CE 24.3 (v9.2) Installation Guide. 

Example commands for migrating to another modes:
 To Migrate to the SLAE Mode: You must provide the server address. Alternate port is optional 

and its default value is SSL 443.
slmigrationhelper.exe -m -t SLAE SLAESERVERADDRESS=10.198.1.2 /q 

 To Migrate to the LDAP or LDAPSecretStore Mode: You must provide the server address. 
Consider the method of seamless login GINA/Cred Manager.
slmigrationhelper.exe -u <fullpath>\NetIQSecureLogin.exe -t LDAP 
LDAPSERVERADDRESS=127.0.0.1 APPENDLOCAL=SeamlessLDAPCred

IMPORTANT: To include the additional NICI LDAP dependency, you might need to perform 
upgrade instead of migration. 

IMPORTANT: Installing in any LDAP or LDAPv3 mode requires NICI to be installed.
If you are modifying the datastore from an existing one to LDAP and NICI is not installed on your 
workstation, use the -u option to specify the path to SecureLogin installer.

Scenario Command

To switch to the LDAP mode and install 
in the GINA/Credential Provider mode

slmigrationhelper.exe -u 
C:\NetIQSecureLogin.exe -t LDAP 
ADDLOCAL=SeamlessLDAPGina

To switch to the LDAP mode and install 
in the Credential Manager mode

slmigrationhelper.exe -u 
C:\NetIQSecureLogin.exe -t LDAP -q 
ADDLOCAL=SeamlessLDAPCred

To switch to the LDAP mode and 
specify an LDAP server address

slmigrationhelper.exe -m -t LDAP 
LDAPSERVERADDRESS=127.0.0.1

To specify additional features to be 
installed using the APPENDLOCAL 
property

slmigrationhelper.exe -m -t LDAP 
LDAPSERVERADDRESS=127.0.0.1 APPENDLOCAL=DAS

To Switch to the LDAPSecretStore and 
install in the Credential Manager mode

slmigrationhelper.exe -m -t LDAPSecretStore 
ADDLOCAL=SeamlessLDAPCred /q 
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For example: slmigrationhelper.exe -u C:\NetIQSecureLogin.exe -t LDAP -q 
This switches the datastore to LDAP and installs NICI in the quiet mode.

 To Migrate to the Microsoft Active Directory Mode:
slmigrationhelper.exe -m -t MAD /q 

 To Migrate to the ADAM (AD LDS) Mode:
slmigrationhelper.exe -m -t ADAM /q 

 To Migrate to the NDS Mode:
slmigrationhelper.exe -m -t NDS /q 

Migrating from the SecretStore Mode to Other Modes
In the subsequent release of SecureLogin, support for Secret Store will be discontinued. It is 
recommended to migrate from the SecretStore environment to one of the following modes:

 LDAP
 NDS

SecureLogin supports the following migration flows:

 Migrating from LDAPSecretStore to LDAP
 Migrating from LDAPSecretStore to NDS
 Migrating from NDS SecretStore to NDS

Migrating from LDAPSecretStore to LDAP

Migrating from LDAPSecretStore to NDS
To migrate to the NDS mode, use the following command:

slmigrationhelper.exe -m -t NDS /q

Migrating from NDS SecretStore to NDS
To migrate to the NDS mode, use the following command:

slmigrationhelper.exe -m -t NDS /q

Scenario Use the command

To switch to the LDAP mode and install in 
the GINA/Credential Provider mode

slmigrationhelper.exe -m -t LDAP 
ADDLOCAL=SeamlessLDAPGina /q

To switch to the LDAP mode and install in 
the Credential Manager mode

slmigrationhelper.exe -m -t LDAP 
ADDLOCAL=SeamlessLDAPCred /q

To switch to the LDAP mode and specify an 
LDAP server address

slmigrationhelper.exe -m -t LDAP 
LDAPSERVERADDRESS=127.0.0.1 /q

To specify additional features to be 
installed using the APPENDLOCAL property

slmigrationhelper.exe -m -t LDAP 
LDAPSERVERADDRESS=127.0.0.1 APPENDLOCAL=DAS
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Upgrading SecureLogin and Migrating the Datastore
If you want to upgrade SecureLogin and want to use another mode in the upgraded version, you 
must first upgrade SecureLogin to the latest version and then migrate it to the required mode. 
Performing the direct migration disables the features that you have enabled in the previous version.

Using ADDLOCAL overwrites the existing feature set. During upgrade, you can use ADDLOCAL, but it 
must be used with all features that are required. 

You can use the APPENDLOCAL property to add additional features to be installed. However, this 
option does not work during the upgrade. It only migrates the features that are installed.

For example, you can use the APPENDLOCAL command to add DAS and Syslog as additional features 
in the LDAP mode using the following command:

slmigrationhelper.exe -u C:\NetIQSecureLogin.exe -t LDAP 
ADDLOCAL=SeamlessLDAPGina LDAPSERVERADDRESS=127.0.0.1 
APPENDLOCAL=DAS,Syslog

NOTE: You can specify multiple comma-separated features as required in APPENDLOCAL. For more 
APPENDLOCAL commands, see the command options in the mode-specific sections in the 
SecureLogin CE 24.3 (v9.2) Installation Guide.
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17 17Managing the Workstation Cache

 Section 17.1, “About the Workstation Cache,” on page 127
 Section 17.2, “Creating a Backup File,” on page 128
 Section 17.3, “Deleting the Workstation Cache,” on page 128
 Section 17.4, “Restoring the Local Cache Backup File,” on page 129

17.1 About the Workstation Cache
The SecureLogin cache is an encrypted local copy of SecureLogin data. It allows users who are not 
connected to the network (or working offline using a laptop) to continue to use SecureLogin even if 
the directory becomes unavailable. 

User data includes credentials, preferences, policies, and SecureLogin application definitions, except 
when you use a smart card for storing credentials. By default, a cache file is created on the 
workstation as part of SecureLogin installation. The cache file stores user data locally and is 
synchronized regularly with the user’s data in the directory. You can set the synchronization period in 
the Administrative Management utility. You can also disable the offline cache, forcing all SecureLogin 
data to be stored in the directory.

Depending on the type of installation, the cache is stored:

 In the users profile directory. For example:

%APPDATA%\SecureLogin\Cache
On Microsoft Windows Vista and higher: %APPDATA% represents 

C:\Users\<Username>\Appdata\Roaming\
On XP systems: %APPDATA represents

C:\Documents and Settings\<Username>\Application Data\
 In the %ProgramFiles%. For example:
C:\Program Files\NetIQ\SecureLogin\Cache

Directory and workstation caches are synchronized regularly, by default every five minutes, and 
whenever the user logs off or on to the workstation. When changes are made, either by the user on 
the workstation or the administrator in the directory, single sign-on user data is compared and 
updated during synchronization. Any settings configured by the user through the Credentials 
Management tool on the local workstation take precedence over those made in the directory. 

If you require full administrative control of a user’s SecureLogin environment, you can disable the 
user's access to administration tools through the settings in the Preferences Properties table. This 
prohibits users from overriding your changes while configuring changes on the workstation.

NOTE: The SecureLogin cache refresh interval is by default five minutes. You can change the default 
in the Preferences Properties table.
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Because SecureLogin data is stored in the directory, existing directory backups also back up 
SecureLogin data. In addition, the local cache synchronizes with the directory for further redundancy 
of data. Backing up or restoring by using the SecureLogin menu options is typically performed by 
users who have been disconnected from the network for long periods of time, such as weeks or 
months.

Using workstation backup and restore, users can securely back up their SecureLogin cache in stand-
alone or directory deployments. All user data, including passwords and passphrases, is saved in a 
password-protected, encrypted XML file. 

17.2 Creating a Backup File
1 In the notification area, right-click the SecureLogin icon and select Advanced > Backup User 

Information. The Save Settings dialog box is displayed.
2 Select a folder to store the backup file. The file can be stored in any location.
3 In the File name field, specify a name for the backup file.
4 Click Save. The Password dialog box is displayed.
5 In the Password field, specify a password.

SecureLogin verifies if the password entered is at least 8 characters long. If the password does 
not meet this requirement then the user is prompted to re-enter the password with the 
required length.

6 Click OK.
7 Click OK.

17.3 Deleting the Workstation Cache
IMPORTANT: Before restoring the backup file, you must delete the cache file on the workstation. In 
directory environments, you must also delete the user object data in the directory. 

1 Right-click the Windows Start button, then click Explore.
Ensure that you have selected Show hidden files and folders in the Windows Folder 
Options dialog box.

2 Depending on the type of installation, browse to C:\Program Files\SecureLogin\Cache 
or
%APPDATA%\SecureLogin\Cache
On Microsoft Windows Vista, browse to 
C:\Users\<Username>\Appdata\Roaming\SecureLogin\Cache

3 Delete the cache directory.
4 Close Windows Explorer.
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17.4 Restoring the Local Cache Backup File
1 In the notification area (system tray), right-click the SecureLogin icon, then select Advanced > 

Restore User Information. 
2 Select the backup file.
3 Click Open. The Password dialog box is displayed.
4 In the Password field, specify the password.

If the specified password is correct, SecureLogin processes the file to restore the user's data. If 
one or more application are already defined, a series of messages asking the user whether to 
overwrite the existing workstation file, appears.

5 Select Yes to overwrite the file and continue restoring the local cache backup file.
6 After the completion of the restoration process, a confirmation message appears confirming 

that the cache is successfully loaded to the local workstation cache.

NOTE: If password policies already exist, ignore the wrong error message 0 password policy that 
is shown when restoring user data.
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18 18AutoPass License Server

AutoPass License Server (APLS), is a Micro Focus web-based solution for managing your Micro Focus 
Software product licenses. It helps you organize and manage your product licenses, server users, and 
client users.

The AutoPass License Server manages the licenses acquired from the license portal. These licenses 
are then installed on the AutoPass License Server. When a client computer needs a license, the client 
sends a request to the Autopass License Server and a license is checked out to this computer.

APLS uses the concurrent (floating) license model. A concurrent license is shared dynamically 
between multiple client users. The concurrent licenses are shared or pooled between a groups of 
users. Using concurrent licenses enables you to purchase the number of licenses equal to the largest 
number of users liable to be active at any time, instead of the total number of users of a product.

The AutoPass License Server manages the licenses acquired from the license portal. These licenses 
are then installed on the AutoPass License Server. When a client computer needs a license, the client 
sends a request to the Autopass License Server and a license is checked out to this user.

On a concurrent license, after the client user's work session (or when the license expires), the license 
is returned to the AutoPass License Server for renewal or for use by other users.

Using the AutoPass License Server:

 Control and manage how the licenses are used
 Create and manage users who are responsible for administering the AutoPass License Server 

and the licenses installed on the server
 Manage client user access to the AutoPass License Server
 Centrally manage license /product /custom usage product-wise
 Generate reports for usage to manage pay per use billing
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19 19Auditing and Logging

 Section 19.1, “About Auditing Tools,” on page 133
 Section 19.2, “About SNMP Auditing,” on page 133
 Section 19.3, “About Windows Event Log Alerts,” on page 133
 Section 19.4, “Creating a Windows Event Log Alert,” on page 133
 Section 19.5, “Logging Events,” on page 134

19.1 About Auditing Tools
SecureLogin provides monitoring functionality with Simple Network Management Protocol (SNMP) 
trapping and Windows event logging. You can choose a preferred auditing application and to 
integrate event monitoring into your current SNMP functionality. Event alerts are activated through 
SecureLogin application definitions. An understanding of application definition is useful to enable 
event monitoring.

19.2 About SNMP Auditing
To understand how to use SecureLogin with SNMP, see SecureLogin Guidelines for SNMP Trapping. 

19.3 About Windows Event Log Alerts
Windows event log alerts are activated by following the same procedure as SNMP alerts. The 
Logevent.exe application is activated through the Run command in an application definition.

Windows event logging from SecureLogin requires that the Windows Event Log system is active on 
the computer receiving the alerts, along with the executable Logevent.exe on each audited client 
workstation, to generate the alerts.

NOTE: Logevent.exe is included in the Windows 2000 Resource Kit. Microsoft licensing 
regulations apply.

19.4 Creating a Windows Event Log Alert
The following procedure uses the Windows Notepad application as an example.

1 In the notification area (system tray), double-click to open the SecureLogin Client Utility.
2 Click Applications.
3 In the right pane, double-click the application description (in this example, Untitled-Notepad). 
4 Click the Definition tab. 
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5 The command syntax to execute LogEvent.exe is:
logevent -m \\computername-s severity-c categorynumber-r source-e 
eventID-timeout"event text"

6 After EndDialog, specify the LogEvent command for the required alert. 
For example:
Run "C:\Program Files\Resource Kit\LogEvent.exe –m SecureLogin –s –e 
99"Notepad has started"
This command requests an alert to be sent to the console with a security level of W – warning 
and event ID number 99.

7 Click OK.
8 Start Notepad. The alert is sent to the Windows Event Log system.

19.5 Logging Events
 Section 19.5.1, “Enabling Logging Events from Browsers,” on page 134
 Section 19.5.2, “Enabling Logging Events from Embedded Web Browser,” on page 135

19.5.1 Enabling Logging Events from Browsers
You can enable logging through one of the following ways:

 Native Logging from SecureLogin 
 Browser Console 

Native Logging from SecureLogin
To enable logging for browsers, create the following registry:

Browser Console 
Perform the following steps to enable logging through browser console:

1 Navigate to the respective browser’s console.
2 Specify log.setdefaultlevel(0);

Browser Registry Path Registry Type Registry Name Registry Value

Google Chrome HKEY_LOCAL_MACHINE\SOFTWAR
E\Protocom\SecureLogin

DWORD Chromesso Set the value of 
Chromesso to 0

Microsoft Edge HKEY_LOCAL_MACHINE\SOFTWAR
E\Protocom\SecureLogin

DWORD Edgesso Set the value of 
Edgesso to 0

Mozilla Firefox HKEY_LOCAL_MACHINE\SOFTWAR
E\Protocom\SecureLogin

DWORD SLoMoz Set the value of 
SLoMoz to 0

Internet Explorer HKEY_LOCAL_MACHINE\SOFTWAR
E\Protocom\SecureLogin

DWORD Iesso Set the value of 
Iesso to 0
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19.5.2 Enabling Logging Events from Embedded Web Browser 
To enable logging for the embedded web browsers, create a registry:

1 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Protocom\SecureLogin.
2 Create a DWORD registry called iessobho.
3 Set the value of iessobho to 2.
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20 20Analytics Dashboard

NetIQ Access Manager Analytics Dashboard provides visual analytics of the access-related data 
based on usage, performance, and events.

SecureLogin integrates with Access Manager to use this dashboard. This dashboard helps in 
visualizing the access patterns, tuning the policies, and getting insights about the usage of 
SecureLogin in your environment. You can also monitor the real-time data access patterns to decide 
further actions.

Analytics Dashboard displays all required events in the form of graphs. The graphs are displayed in 
the following modes:

 Real-time Data: You can add filters or refresh the data after a specific time duration. You can 
view data from the time Analytics Dashboard is configured till the present time, but the data 
that is older than 7 days is not displayed. Refer Section 20.7, “Set Time Range,” on page 142 to 
increase the time range.

 Historic Data: When you require the historic data, click Dashboard > SecureLogin Historical 
Dashboard. It has default time range of 6 months, which can be increased to a maximum of 365 
days. Refer Section 20.7, “Set Time Range,” on page 142 to increase the time range.

Analytics Dashboard displays the following graphs:

 Section 20.5.1, “Count of Unique Users - Analytics [SecureLogin],” on page 140
 Section 20.5.2, “Data Table of Users - Analytics [SecureLogin],” on page 141
 Section 20.5.3, “Count of Workstations - Analytics [SecureLogin],” on page 141
 Section 20.5.4, “Data Table of Workstations - Analytics [SecureLogin],” on page 141
 Section 20.5.5, “Count of Applications SSO - Analytics [SecureLogin],” on page 141
 Section 20.5.6, “Data Table of Applications SSO - Analytics [SecureLogin],” on page 141
 Section 20.5.7, “Most Used SSO Applications - Analytics [SecureLogin],” on page 141
 Section 20.5.8, “Frequent SSO User of SecureLogin - Analytics [SecureLogin],” on page 141
 Section 20.5.9, “SecureLogin Application Usage Date Wise - Analytics [SecureLogin],” on 

page 141
 Section 20.5.10, “SecureLogin Disabled Users - Analytics [SecureLogin],” on page 141
 Section 20.5.11, “Count of Application Password Change - Analytics [SecureLogin],” on page 141
 Section 20.5.12, “Data Table of Application Password Changed - Analytics [SecureLogin],” on 

page 142
 Section 20.5.13, “Application Credentials Change - Analytics [SecureLogin],” on page 142
 Section 20.5.14, “Data Table of Application Credential Change - Analytics [SecureLogin],” on 

page 142
 Section 20.5.15, “Data Table of Users with Workstation Count - Analytics [SecureLogin],” on 

page 142
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In this Chapter

 Section 20.1, “Advantages of Using Analytics Dashboard,” on page 138
 Section 20.2, “Who Can Access Analytics Dashboard,” on page 138
 Section 20.3, “Getting Started with Analytics Dashboard,” on page 138
 Section 20.4, “Events for Each Graph,” on page 139
 Section 20.5, “Types of Graphs,” on page 140
 Section 20.6, “Managing Graph Limit,” on page 142
 Section 20.7, “Set Time Range,” on page 142

20.1 Advantages of Using Analytics Dashboard
 Displays visual analytics based on access patterns, logins, risk-based authentication, and usage 

of SecureLogin. This helps the administrators to tune the system according to their needs.
 Provides the trends of using devices, browsers, or applications in an organization.
 Provides the number of unique users who are logged in to SecureLogin. 
 Displays the graphs in a full screen (kiosk) mode, which helps in viewing Analytics Dashboard in 

a data center. Also, it does not time out.
 Display a snapshot of the historic data graphs based on the query for any specific period.
 Analytics Dashboard can be used with older versions of SecureLogin. Users with NetIQ 

SecureLogin 9.0.0 Patch 1 and above get following improvements to the dashboard as 
compared to older releases:
 Count of application SSO includes Windows application events.
 NetIQ SecureLogin events created are logged with accurate timezone and year.

20.2 Who Can Access Analytics Dashboard
SecureLogin administrators can view and manage Analytics Dashboard.

20.3 Getting Started with Analytics Dashboard
Analytics Dashboard comprises of the following sections:

 Recently viewed: Contains the graphs that you have viewed recently.
 Analytics Dashboard: Contains the following options:

 Options:
 Use margins between panels: Specifies a margin of space between each pane.
 Show panel titles: Specifies the appearance of titles in the header of each panel.

 Share: To share the dashboard using Snapshot or Saved objects. 

NOTE: It is recommended to take snapshots to avoid data loss. For more information, see 
Snapshot and Restore in the NetIQ Access Manager 5.0 Administration Guide.
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 Add: Create and add panels of your data to the dashboard, or add existing panels from the 
library.

 Create New: Use the following options: 
 To start with an empty dashboard, click Create dashboard.
 To open an existing dashboard, click the dashboard Title you want to open.

 Save: To save the dashboard.
 Cancel: To cancel the changes made to the dashboard.

 Discover: Enables you to interactively explore the data. 
 Dashboard: Provides visual analytics of access-related data based on the usage, performance, 

and events of SecureLogin. 
 Visualize: Helps you visualize the captured data in the dashboard using the customizing view of 

the graphs.
 Management: Contains the following options:

 Dev Tools: Provides tools to help you interact with the data.
 Stack Management: Helps you manage every resource such as; indices, clusters, licenses, 

UI settings, index patterns, spaces present in the entire dashboard.

20.4 Events for Each Graph
The events are enabled by default. The following table provides the list of graphs with the required 
events:

Table 20-1   

Graph Event Event ID

Count of Unique Users SecureLogin Start Event 256

Data Table of Users SecureLogin Start Event 256

Count of Workstations SecureLogin Start Event 256

Data Table of Workstations SecureLogin Start Event 256

Count of Applications SSO Password provided by script 514

Data Table of Applications SSO Password provided by script 514

Most Used SSO Applications Password provided by script 514

Frequent SSO User of SecureLogin Password provided by script 514

SecureLogin Application Usage 
Date Wise

Password provided by script 514

SecureLogin Disabled Users SecureLogin disabled or inactive 259

Count of Application Password 
Change

Application password changed 
through SecureLogin

515, 516
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20.5 Types of Graphs
The graphs represent the information about the business requirement of an organization. Analytics 
Dashboard displays the following graphs in real-time and historic data modes by default:

 Section 20.5.1, “Count of Unique Users - Analytics [SecureLogin],” on page 140
 Section 20.5.2, “Data Table of Users - Analytics [SecureLogin],” on page 141
 Section 20.5.3, “Count of Workstations - Analytics [SecureLogin],” on page 141
 Section 20.5.4, “Data Table of Workstations - Analytics [SecureLogin],” on page 141
 Section 20.5.5, “Count of Applications SSO - Analytics [SecureLogin],” on page 141
 Section 20.5.6, “Data Table of Applications SSO - Analytics [SecureLogin],” on page 141
 Section 20.5.7, “Most Used SSO Applications - Analytics [SecureLogin],” on page 141
 Section 20.5.8, “Frequent SSO User of SecureLogin - Analytics [SecureLogin],” on page 141
 Section 20.5.9, “SecureLogin Application Usage Date Wise - Analytics [SecureLogin],” on 

page 141
 Section 20.5.10, “SecureLogin Disabled Users - Analytics [SecureLogin],” on page 141
 Section 20.5.11, “Count of Application Password Change - Analytics [SecureLogin],” on page 141
 Section 20.5.12, “Data Table of Application Password Changed - Analytics [SecureLogin],” on 

page 142
 Section 20.5.13, “Application Credentials Change - Analytics [SecureLogin],” on page 142
 Section 20.5.14, “Data Table of Application Credential Change - Analytics [SecureLogin],” on 

page 142
 Section 20.5.15, “Data Table of Users with Workstation Count - Analytics [SecureLogin],” on 

page 142

20.5.1 Count of Unique Users - Analytics [SecureLogin]
This graph displays the count of unique users logged in to SecureLogin.

Data Table of Application Password 
Changed

Application password changed 
through SecureLogin

515, 516

Application Credentials Change Application credentials added, 
modified, or deleted through 
SecureLogin

277, 278, 279

Data Table of Application 
Credential Change

Application credentials added, 
modified, or deleted through 
SecureLogin

277, 278, 279

Data Table of Users with 
Workstations Count

SecureLogin Start Event 256

Graph Event Event ID
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20.5.2 Data Table of Users - Analytics [SecureLogin]
This graph displays the list of unique users logged in to SecureLogin with access count.

20.5.3 Count of Workstations - Analytics [SecureLogin]
The graph displays the number of workstations where SecureLogin is being accessed.

20.5.4 Data Table of Workstations - Analytics [SecureLogin]
The graph displays the list of workstations where SecureLogin is being accessed.

20.5.5 Count of Applications SSO - Analytics [SecureLogin]
The graph displays the count of applications single signed-on by SecureLogin.

20.5.6 Data Table of Applications SSO - Analytics [SecureLogin]
The graph displays the list of applications and the number of times each application is single signed-
on by SecureLogin.

20.5.7 Most Used SSO Applications - Analytics [SecureLogin]
The graph displays the top 10 applications single signed-on by SecureLogin.

20.5.8 Frequent SSO User of SecureLogin - Analytics [SecureLogin]
The graph displays the top 10 frequent users who use SecureLogin SSO for applications.

20.5.9 SecureLogin Application Usage Date Wise - Analytics 
[SecureLogin]
The graph displays the top 5 applications single signed-on by SecureLogin in 7 days.

20.5.10 SecureLogin Disabled Users - Analytics [SecureLogin]
The graph displays information about the users who have disabled SecureLogin in 7 days.

20.5.11 Count of Application Password Change - Analytics [SecureLogin]
The graph displays the number of applications passwords changed by SecureLogin.
Analytics Dashboard 141



20.5.12 Data Table of Application Password Changed - Analytics 
[SecureLogin]
The graph displays the list of applications whose password is changed by SecureLogin with change 
count.

20.5.13 Application Credentials Change - Analytics [SecureLogin]
The graph displays the top 10 applications credentials changed [Add/Modify/Delete] in 7 days.

20.5.14 Data Table of Application Credential Change - Analytics 
[SecureLogin]
The graph displays the list of applications credential changed [Add/Modify/Delete] with change 
count.

20.5.15 Data Table of Users with Workstation Count - Analytics 
[SecureLogin]
The graph displays information about the SecureLogin users who have logged in from multiple 
workstations.

20.6 Managing Graph Limit
The limits on the graphs can be increased as per the requirement of the user. Perform the following 
steps to increase the limit:

1 Select Visualize.
2 Search for the required metric in the search bar.
3 Under Buckets, click Split Rows.
4 Scroll to locate Size and update the limit as required.
5 Click Update.
6 Click Save.
7 Click Save.

NOTE: Ensure that Save as new dashboard toggle is set to close if you do not want to save the 
updated visualization as a new visualization.

20.7 Set Time Range
Perform the following steps to permanently set time range for dashboard:

1. Select the preferred time range in the dashboard.
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2. Edit dashboard.
3. Click Save.
4. Set the Store time with dashboard toggle to on and click Save.

NOTE: Ensure that Save as new dashboard toggle is set to close if you do not want to save the 
updated visualization as new visualization.
Analytics Dashboard 143



144 Analytics Dashboard



21 21Audit Configuration for Sentinel

SecureLogin integrates with NetIQ Sentinel for auditing. The events are logged to Windows Event 
Log from which the auditing server such as NetIQ Sentinel can fetch the event logs. In the previous 
releases the connection to the auditing server was outbound. That is, the Platform Agents sent the 
event logs to the Novell Audit. 

In SecureLogin, the connection to the auditing server is inbound. The events are logged to Windows 
Events Log from where the auditing server fetches the event logs. 

 Section 21.1, “Windows Event Log: An Overview,” on page 145
 Section 21.2, “WMS Connector,” on page 145
 Section 21.3, “Configuring Auditing,” on page 145
 Section 21.4, “Logging Events from LDAP,” on page 148

21.1 Windows Event Log: An Overview
Windows event logging is a system service used by the Windows operating system to record the 
occurrence of system events. Events range from resource tracking of failing device drivers to 
security-related actions such as attempts to access files, directories, printers, or other system objects 
that are under audit control. The Windows security event log monitors events generated by system 
security and auditing processes.

By default, Windows Security Event Auditing is turned off. The Windows Event Viewer is the primary 
tool for viewing the event logs found on Windows systems.

21.2 WMS Connector
The Windows Monitoring Service (WMS) connector facilitates integration between Sentinel 
Collectors with Microsoft Windows event sources. For SecureLogin, we use the SecureLogin 
Collector. The collector is available at Sentinel Connector and Collector Web site.

For information, see Understanding Event Source Management in Sentinel User Guide.

21.3 Configuring Auditing
The configuration of auditing, with the SecureLogin Collector, differs for workstations in Active 
Directory environments and non-Active Directory environments. The configuration involves enabling 
audit for the target system and configuration of the appropriate accounts to access the Windows 
Event Logs remotely by Sentinel. For more information, see the WMS Connector (Sentinel Connector 
and Collector).

 Section 21.3.1, “Monitoring a System in a Domain Environment,” on page 146
 Section 21.3.2, “Monitoring a System in a Non-Domain Environment,” on page 147
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21.3.1 Monitoring a System in a Domain Environment
In a domain environment, a domain account must be created that has the policy rights to access the 
Windows Security Event logs on the remote Event Sources. This domain user account must be 
recognized by the Event Sources either as a user within the domain, or a user within one of the 
groups referenced on the server. 

 “Configuring Events Logged by Windows Event Log” on page 146
 “Configuring Users to Collect Windows Event Log Remotely” on page 146
 “Setting up the Windows Management Instrumentation Service” on page 147
 “Configuring Domain Account User COM/DCOM” on page 147

Configuring Events Logged by Windows Event Log
Use the following procedure to enable basic Windows event logging for use with Windows 
Collectors. To collect data from a different application that writes to the Windows Event Log, refer to 
the documentation for the associated Collector. See the Sentinel Connector and Collector website.

To configure the Sensor to report Events to Security Log:

1 Log on to Windows with an account that has Administrative rights.
2 Click Start > Settings > Control Panel.
3 In Control Panel window, double-click Administrative Tools.
4 Double-click Local Security Policy; expand Local Policies, then double-click Audit Policy. 
5 Double-click a specific audit policy to edit the security settings.
6 In Local Security Setting window, select Success/Failure.
7 Click OK.

Configuring Users to Collect Windows Event Log Remotely
1 From the Event Source, click Start > Settings > Control Panel.
2 In the Control Panel window, select Administrative Tools > Local Security Policy > Local Policies > 

User Rights Assignment > Manage auditing and security log.
3 Click Add.
4 In Select Users/Groups, click Look in field and select the domain with the account to be used for 

collecting the security event log information.
5 Double-click the account to be used, then click OK.
6 In the Local Security Policy Settings window, click OK.

The new policy setting takes effect after you restart the system.

NOTE: If domain-level policy settings are defined, they override local policy settings.
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Setting up the Windows Management Instrumentation Service
1 Log in to the remote computer and click Start > Settings > Control Panel.
2 In the Control Panel window, double-click Administrative Tools > Computer Management.
3 In the Computer Management window, on the Tree tab expand Services and Applications; right-

click WMI Control, then select Properties.
4 In WMI Control Properties window, select the Security tab.
5 Select the Root folder, then click Security to open the Security for Root dialog.

If the User or Group that needs the remote WMI access does not appear in the list, click Add.
6 From the Select Users, Computers, or Groups window, select the user or group that needs 

remote WMI access, then click Add.
7 After you finish selecting users or groups, click OK.
8 Select the newly added user or group and ensure that they have at least the following 

permissions depending on what type of Event log you want to access:
 Execute Methods
 Provider Write
 Enable Account
 Remote Enable

9 With the user or group still highlighted, click Advanced.
10 Select the group, then click View/Edit, to open the Permission Entry for Root dialog.
11 From the Apply onto list, select This namespace and sub namespaces.
12 Click OK on each dialog until you return to the Computer Management window.
13 Restart the WMI service. See Starting and Stopping the WMI Service.

Configuring Domain Account User COM/DCOM
The procedure to configure domain account user COM/DCOM differs based on the platform on the 
SecureLogin workstation. See the WMS Connector document (Sentinel Connector and Collector).

21.3.2 Monitoring a System in a Non-Domain Environment
In a non-domain environment, local accounts must be created on both the Collector Manager 
system and on the Event Source. These accounts must have the same username and password.

 “Configuring Events Logged by Windows Event Log” on page 147
 “Configuring Users to Collect Windows Event Log Remotely” on page 148
 “Setting up the Windows Management Instrumentation Service” on page 148
 “Configuring Domain Account User COM/DCOM” on page 148

Configuring Events Logged by Windows Event Log
See “Configuring Events Logged by Windows Event Log” on page 146.
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Configuring Users to Collect Windows Event Log Remotely
In a non-Active Directory environment, you must create a user account on each event source, that is, 
each workstation running SecureLogin. This same username and password must be configured on 
the Collector Manager machine. On Collector Manager machine, this user must be part of 
Administrator group. See “Configuring Users to Collect Windows Event Log Remotely” on page 146.

Setting up the Windows Management Instrumentation Service
See “Setting up the Windows Management Instrumentation Service” on page 147.

Configuring Domain Account User COM/DCOM
See “Configuring Domain Account User COM/DCOM” on page 147.

21.4 Logging Events from LDAP 
You must configure the registry to enable logging from LDAP.

1 Create a registry value at HKEY_LOCAL_MACHINE\Software\Novell\Login\Ldap 
The following events are logged:

Event ID 1 Informational: NSL user login
Event ID 2 Informational: LDAP user password change
Event ID 3 Warning: Workstation unlocked by different User

2 Open nslevtsvc.ini in a text editor and add the following section about the new information 
source:

[wmi]
event_source=LDAPAuth
The following events are logged:

Event ID 1 Informational: NSL user login
Event ID 2 Informational: LDAP user password change
Event ID 3 Warning: Workstation unlocked by different User
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22 22Administering Desktop Automation 
Services

The module ARS.exe is the primary component of Desktop Automation Services. Configuration of 
the service is performed through the use of an XML file. The XML document can be obtained either 
locally on the workstation or through directory services. The XML document is called the action file 
and the file is named actions.xml.
See an example file in Section 22.3, “Example of an Action File,” on page 172.

Each action is a set of configurable user-level operations such as mapping a drive, testing for an 
authenticated connection to a directory, and even running/ shutting down an application. The 
flexibility of the code to test for conditions and have the action triggers such as hot keys, provide 
tremendous flexibility to change the behavior of the workstation to fit your needs.

The ARSControl.exe runs as a Windows service. The ARSControl.exe then parses the 
actions.xml file and stores the configuration in memory. All actions performed by ARS.exe and 
ARSControl.exe are recorded in a DASlog.txt log file at different configurable levels of details.

After you configure the ARS.exe application, its actions are available individually or in combination 
with the scripting interface that is available on Windows. For example, VBScript, JavaScript, login 
scripts, SecureLogin scripts, and batch files.

 Section 22.1, “Actions and Descriptions,” on page 149
 Section 22.2, “Using the DAS Editor to Configure Actions,” on page 170
 Section 22.3, “Example of an Action File,” on page 172

22.1 Actions and Descriptions
Each instance of Desktop Automation Services is configured by an XML document that defines 
events and desired actions.

The following table describes the elements that might be used to compose a Desktop Automation 
Services XML input document. Unless otherwise specified, all XML attributes listed for a given 
element are required for that element.
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Table 22-1   Desktop Automation Services XML Description

XML Tags Description

application-
runner-script

This is the parent element for an Desktop Automation Services input document. 

application-runner-script has no attributes.

application-runner-script can contain any number of action elements.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <run-application application= "notepad.exe" interval="500" 
serial="true" parameters="" />
     </action> 
     <action-triggers> 
         <on-inactivity-timer interval1="100" messagebox="Your " 
interval2="8" action-name="sample-action"/> 
     </action-triggers>
</application-runner-script>

action-triggers This element is a parent (container) for action-trigger elements such as on-
nds-login, or on-hot-key. 

action-triggers enables Desktop Automation Services executables to respond 
to workstation events by triggering specified actions as defined in the input 
document.

action-triggers has no attributes.

action-triggers can contain any of the following child elements:

 on-inactivity-timer
 on-nds-login
 on-ldap-login
 on-hot-key
 on-screen-saver
 on-cardmon
 on-Tap-cardmon
 on-ad-login

For example:

<action-triggers>
      <on-nds-login action-name="LoginInAction" tree="NCCD_TREE_1"/>
</action-triggers>
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action This is the parent element for all the commands that constitute an action. 

action has two attributes:

name: The name can be any arbitrary string value. The character case in the name 
used by a caller to invoke an action must match the case used where the action is 
defined. The action-name must be contained in double quotes.

multi-delay: This command element specifies the interval in executing the same 
action, twice. 

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
     <action name="ctrl+l" multi-delay="4000">
     </action>
</application-runner-script>
action can contain any number of the following child elements:

 Hide-Desktop and Unhide-Desktop  
 run-application
 test-app-running
 kill-app
 kill-all-apps
 map-drive
 map-home-drive
 map-location-drive
 test-logged-in
 test-ldap-logged-in
 test-ad-logged-in
 ad-logout
 nds-logout
 ldap-logout
 screen-saver-on

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
     <map-drive drive-letter="o:" remote-name="\\192.168.1.255\sys"/>
   </action>
</application-runner-script>

XML Tags Description
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on-inactivity-
timer

on-inactivity-timer has four attributes:

 interval1: is the time of executing an action
 interval2: is the time after which warning dialog will be displayed.
 messagebox: contains the message to be displayed in the warning.

This command element provides information to Desktop Automation Services on the 
action to be performed if the workstation is inactive for more than the specified 
period of time.

At the end of the countdown period, a specified action such as Close all 
programs or Lock the Workstation can be invoked. If a mouse or keyboard 
action is detected, the countdown timer stops and resets until the next inactivity is 
detected. 

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">

<application-runner-script>

   <action name="sample-action">

       <run-application application="notepad.exe" interval="500" 
serial="true" parameters="" />

   </action>  

   <action-triggers>

       <on-inactivity-timer interval1="100" message box="Your"  
interval2="8" action-name="sample-action"/> 

   </action-triggers>

</application-runner-script>

 interval1 is the time of executing an action.
 interval2 is the time after which warning dialog will be displayed.
 messagebox contains the message to be displayed in the warning.
 action-name is the name of the action to be executed.

Specify the inactivity timer in seconds. For example, 10 seconds. 

NOTE: You must specify only numbers for interval values in the syntax. If you use 
special characters in the action.xml file, it does not behave as expected. 

The on-inactivity-timer is implemented to work with positive numbers. If a 
negative number or special character is specified, it will behave erroneously.

The on-inactivity-timer functions only if the network login is present.

XML Tags Description
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on-nds-login This element defines an action trigger that is activated when a user logs in to 
eDirectory through the Novell Client GINA/Credential Provider. If a user logs in to the 
tree, an action trigger invokes Desktop Automation Services. It tests the primary 
connection to see if the current tree matches the configuration. If it matches, 
Desktop Automation Services executes the configured action identified by the action 
name attribute value.

on-nds-login element must be contained within an action-triggers parent 
element.

on-nds-login has two attributes:

 action-name: The name of an action defined in the input document that is 
executed when a user logs in to the tree named by the tree attribute. The 
action-name must be contained in double quotes.

 tree: Connections are tested periodically to see if they are linked to the tree 
named by this network name. The tree name must be contained in double 
quotes.

For example:

 <action-triggers>

      <on-nds-login action-name="LoginInAction" 
tree="NCCD_TREE_1"/>

 </action-triggers>
on-ldap-login This element defines an action trigger that is activated when a user logs in to 

eDirectory through SecureLogin's LDAP client. 

Desktop Automation Services tests the primary connection to check whether the 
current server matches the server attribute specified in the configuration. If the 
current server matches the configuration, Desktop Automation Services executes the 
configured action identified by the action-name attribute value.

on-ldap-login must be contained by an action-triggers parent element.

on-ldap-login has two attributes:

 server: The connections are tested periodically to test if the user is connected 
to a server matching this element name.

 action-name: The name of an action defined in the input document that is 
executed when a user logs in to the tree named by the tree attribute. 

For example:

<action-triggers>

      <on-ldap-login action-name="LoginInAction" 
server="192.168.1.255"/>

</action-triggers>
NOTE: Ensure that the server address matches the LDAP Server address provided 
during installation.

XML Tags Description
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on-hot-key This element defines an action trigger to respond to the user typing the specified hot 
key sequence.This causes Desktop Automation Services to execute the matching 
action as defined in the input document. The on-hot-key elements must be 
contained within an action-trigger parent element.

on-hot-key has three attributes:

 virtual-key: The hex value of the key based on the virtual key map. This element 
specifies that it is the second component of the hot key sequence. 

 modifiers: The modifiers indicate the keys that are pressed in together with the 
virtual key to cause the hot-key event. The hex value might be a combination of 
one or more of the following, separated by a plus sign (+):
 alt indicates the Alt key
 ctrl indicates the Ctrl key
 shift indicates the Shift key
 win indicates the Windows key

This element specifies that it is the first component of the hot key sequence.
 action-name: The name of an action defined in the input document that is 

executed when the hot-key sequence is detected.

For example:

<action-triggers>
    <on-hot-key virtual-key="h" modifiers="ctrl+shift" action-
name="HKeyAction"/>
</action-triggers>
A virtual-key value of 'h' and a modifiers value of ‘ctrl+shift’ produces a 
Control-Shift-H HotKey sequence.

XML Tags Description
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on-screen-saver This element causes an action to be called when the workstation enters the 
screensaver mode. on-screen-saver elements must be contained by an 
action-trigger parent element.

on-screen-saver has the following attributes:

 action-name: The name of the action defined in the input document that is 
executed when the workstation has entered the screensaver mode and the 
specified interval has elapsed.

 interval: The amount of time in milliseconds that the ARSControl waits before 
running the specified action after a screensaver event is triggered.
NOTE: To activate this trigger, you must have a Windows system screen saver 
selected. Set the screen saver wait time to the desired time interval before the 
workstation activates the screen saver. If you are using DAS to activate the 
screen saver through the on-inactivity-timer  action trigger, set the wait 
time to a longer timer interval than what you set for the on-inactivity-
timer action trigger. For example, you can set the on-inactivity-timer 
interval to 60 minutes. The screen saver is triggered from DAS on the shared 
workstation.

For example:

<action-triggers>
   <on-screen-saver action-name="logoff" interval="60000"/>
</action-triggers>
This results in the logoff action being executed 60 seconds after the Windows screen 
saver is activated.

on-cardmon The on-cardmon element specifies the action to be performed when a smart card 
is inserted, removed or when it is used for the login to the directory. If a user is 
logged in through a smart card and logs out because of a security reason, a specific 
action like a system lock must be performed to ensure that the workstation security 
is not at risk. 

on-cardmon must be contained within an action-trigger parent element.

on-cardmon has the following attributes:

 action-name: The name of the action defined in the input document that is 
executed when the card is removed from the reader.

 card-insert: The name of the action defined in the input document that is 
executed when the card is inserted to the reader.

 LoginAction: The name of the action defined in the input document that is 
executed when the user successfully logs into the Directory. 

If the login action fails card-insert action is repeated again.

For example:

<action-triggers>
   <on-cardmon action-name="Removal" card-insert="Insertion" 
LoginAction = "unHideMe" />
</action-triggers>

XML Tags Description
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on-Tap-cardmon The on-Tap-cardmon element specifies the action to be performed when a 
contactless smart card is tapped on and tapped out, or when it is used for the login 
to the directory. If a user is logged in through a smart card and logs out because of a 
security reason, a specific action like a system lock must be performed to ensure that 
the workstation security is not at risk.

The on-Tap-cardmon element must be contained within an action-trigger 
parent element.

on-Tap-cardmon has the following attributes:

 action-name: The name of the action defined in the input document that is 
executed when the card is tapped out from the reader.

 card-tapon: The name of the action defined in the input document that is 
executed when the card is tapped on to the reader.

 LoginAction: The name of the action defined in the input document that is 
executed when the user successfully logs into the Directory. 
If the login action fails card-tapon action is repeated again.

 TapCardSwitchUser: This attribute is used to restrict the card tap to switch 
users in the kiosk mode. If this attribute value is set to true, then single card 
tap is required to switch the user in kiosk mode. If this attribute value is set to 
false, then double card tap is required to switch the user in kiosk mode.

For example:

<action-triggers>
   <on-Tap-cardmon action-name="Tappedout" card-tapon="Tappedon" 
LoginAction = "unHideMe" TapCardSwitchUser="true"/>
</action-triggers>

on-ad-login This element defines an action trigger to poll for a user logging in to a workstation,in 
the Active Directory domain.

This support is for SecureLogin installed in the Active Directory mode. If a user logs in 
to Active Directory, an action trigger invokes Desktop Automation Services which in 
turn executes the configured action identified by the action-name. on-ad-
login element must be contained within the parent element, action-triggers.

For example:

<action-triggers>
   <on-ad-Login action-name="LogInAction"/>

</action-triggers>

Hide-Desktop and 
Unhide-Desktop

The Hide-Desktop and Unhide-Desktop actions will hide or show the items on 
the user’s desktop. These commands can be used with the on-login element to 
disable the users desktop prior to login and then to enable the desktop when the 
user login has been completed.

NOTE: These actions are primarily for a kiosk approach without role-based access or 
for workstation policies managed through ZENworks® syntax. If you specify special 
characters in the action.xml file, it does not behave as expected. 

XML Tags Description
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run-application This command element provides information that enables Desktop Automation 
Services to run an application and respond when the application is closed. There are 
four required attributes and one optional attribute.Following are the required 
attributes:

 application: The name of the application to launch, such as notepad.exe. For 
applications that the operating system cannot find through the configured path 
environment variable, specify the complete application path and file extension.

 parameters: Lists the required parameters to be passed to the application. This 
attribute should have text values enclosed within double quotes (“”). 

 serial: This attribute defines the application to run in synchronous or 
asynchronous mode. The attribute value can be either true or false. When 
this attribute is set to true (in synchronous mode), then the execution of the 
parent action does not continue until the application is closed or the interval 
timeout has expired.

 interval: The timeout interval is used only used when the serial attribute is set 
to true (synchronous mode). If the application has not returned by the 
specified timeout, Desktop Automation Services stops waiting for a return and 
executes the next action.

 The following is an optional attribute:

on-exit-action: When the application started by this element is closed, the specified 
action is called.

run-application cannot have any child elements.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
      <run-application application="C:\Program Files\Mozilla 
Firefox\firefox.exe" parameters="" on-exit-
action="launchSomethingElseAction"serial="true" interval="500"/>
   </action>
</application-runner-script>

XML Tags Description
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test-app-
running

The test-app-running command element provides information that enables 
Desktop Automation Services to test whether an application is running or not. .

test-app-running can have only one attribute:

application: The name of the application as it is found in the process list.

Because test-app-running is a test command, it can contain either one or both 
of the following child elements:

 if-true: An element containing the command operations to perform if the test 
returns a true value.

 if-false: An element containing the command operations to perform if the test 
returns a false value.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
        <test-app-running application="notepad.exe">
          <if-true>
             <kill-app application="xmlspy.exe"/>
             <kill-all-apps exclude-apps="notepad.exe:xmlspy.exe"/>
            <map-drive drive-letter="F:" remote-
name="\\172.16.5.250\sys"/>
          </if-true>
          <if-false>
            <map-drive drive-letter="G:" remote-
name="\\192.168.1.255\sys"/>
          </if-false>
        </test-app-running>
     </action>
</application-runner-script>

kill-app The kill-app command element provides information that enables Desktop 
Automation Services to close an application. 

kill-app has one required attribute and one optional attribute. 

The following is the required attribute:

 application: The name of the application to close, as found in the process list.

The following is the optional attribute:

 interval: The amount of time in milliseconds that Desktop Automation Services 
waits after sending a close command to the application before killing the 
process. The default interval value is 1000.

kill-app cannot contain any child element.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <kill-app application="xmlspy.exe"/>
     </action>
</application-runner-script>

XML Tags Description
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kill-all-apps This command element provides information that enables Desktop Automation 
Services to kill all the running applications except those specified in exclude-apps.

kill-all-apps has one required attribute and one optional attribute. 

The following is the required attribute:

exclude-apps: The names of the applications that must not be killed. The application 
names are separated by a colon (:) character. The name of an application listed in this 
attribute must match the name of the application listed in the Processes tab of the 
Task Manager.

The following is the optional attribute:

interval: The amount of time in milliseconds that Desktop Automation Services waits 
after sending a close command to an application before killing the process. Because 
each process is closed in a sequential order, a large interval significantly increases the 
amount of time the command takes to execute. 
The default value is 0.

kill-all-apps cannot have any child elements.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <kill-all-apps exclude-apps="notepad.exe:xmlspy.exe"/>
     </action>
</application-runner-script> 

map-drive This command element enables Desktop Automation Services to perform a drive 
mapping.

map-drive has two required attributes:

 drive-letter: Specifies the drive letter to assign to the new mapped drive.
 remote-name: Specifies the path in UNC format for a remote volume to be 

mapped.

map-drive cannot contain child elements.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <map-drive drive-letter="G:" remote-
name="\\192.168.1.255\sys"/>
     </action>
</application-runner-script>
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map-home-drive This command element enables Desktop Automation Services to map a drive to a 
home directory as defined by the homedrive attribute in the user’s directory object.

map-home-drive has two required attributes:

 drive-letter: Specifies the drive letter to assign to the new mapped drive. This 
value should be a letter representing the drive pointer, followed by a colon (:) 
character enclosed within double quotes.

 tree: Specifies the tree containing the object with the home directory 
information.

map-home-drive cannot contain any child elements.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <map-home-drive drive-letter="I:" tree="TestTree"/>
     </action>
</application-runner-script>

map-location-
drive 

This command element enables Desktop Automation Services to map a drive based 
on a properties file. The properties file is an acscii based text file that contains 
the necessary mapping information for one or more drives.

map-location-drive has four required attributes:

 drive-letter: Specifies the drive letter to assign to the new mapped drive. This 
value should be a letter representing the drive pointer followed by a colon (:) 
character enclosed within double quotes.

 tree: Specifies the tree containing the object with the location information.
 attribute: Specifies the key to be used to obtain a value from the properties file.
 file-name: Specifies the file system path to a properties file containing 

information for the map-location-drive operation. This file contains 
property information in the form of key or value pairs. The property key is 
located on the left of the equals symbol (=) and the value is on the right side.
For example:
here=\\137.65.60.39\Share2
there=\\137.65.60.39\Share3

map-location-drive cannot contain any child elements.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <map-location-drive drive-letter="T:" tree="TestTree2" 
file-name="c:\yourFile.c" attribute="yourAttribute"/>
     </action>
</application-runner-script>
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test-logged-in This command element provides information that enables Desktop Automation 
Services to test whether the user is logged in to a particular eDirectory server or not.

test-logged-in has one required attribute:

tree: The name of the tree for which the logged in state has to be tested.

Because the test-logged-in is a test command, it can contain either one or both 
of the following child elements:

 if-true: An element containing the command operations to perform if the test 
returns a true value.

 if-false: An element containing the command operations to perform if the test 
returns a false value.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
    <action name="sample-action">
       <test-logged-in tree="TestTree">
          <if-true>
            <run-application application="explorer.exe" parameters="" 
serial="false" interval="1000"/>
             <map-home-drive drive-letter="I:" tree="TestTree"/>
         </if-true>
         <if-false>
            <map-location-drive drive-letter="J:" tree="TestTree" file-
name="c:\myFile.c" attribute="myAttribute"/>
         </if-false>
      </test-logged-in>
    </action>
</application-runner-script>
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test-ldap-
logged-in

This command element provides information that enables Desktop Automation 
Services to test whether the user is logged in to a particular LDAP server or not. This 
command must only be used when using the LDAP GINA/Credential Provider for 
authentication.

test-ldap-logged-in has one required attribute:

server: The name of the server for which the logged-in state must be tested.

Because test-ldap-logged-in is a test command, it can contain either or both 
of the following child elements:

 if-true: An element containing the command operations to perform if the test 
returns a true value.

 if-false: An element containing the command operations to perform if the test 
returns a false value.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
      <test-ldap-logged-in server="192.168.1.255">
         <if-true>
            <run-application application="explorer.exe" parameters="" 
serial="false" interval="1000"/>
        </if-true>
         <if-false>
            <run-application application="iexplore.exe" parameters="" 
serial="false" interval="1000"/>
         </if-false>
      </test-logged-in>
  </action>
</application-runner-script>

test-ad-logged-
in

The test-ad-logged-in command element provides information that enables 
Desktop Automation Services to test whether a user is logged in to Active Directory.

test-ad-logged-in contains no attributes. It contains either one or both of the 
following child elements:

 if-true: This element contains the command operations to perform if the test 
returns a true value.

 if-false: This element contains the command operations to perform if the test 
returns a false value

For Example:

<action name="test">
   <test-AD-logged-in>
     <if-true>
       <message-box caption="User are logged in"  />
     </if-true>
     <if-false>
       <message-box caption="User are not logged in"  />
     </if-false>
   </test-AD-logged-in>
</action>
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ad-logout This test command element provides information that enables Desktop Automation 
Services to log out of the SecureLogin in the Active Directory mode.

ad-logout does not have any attributes or child attributes.

For Example:

<application-runner-script>
   <action name="sample-action">
     <AD-logout/>
   </action>
</application-runner-script>

nds-logout This test command element provides information that enables Desktop Automation 
Services to log out of the primary NDS® connection. 

nds-logout has no attributes.

nds-logout has no child attributes.

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
          <nds-logout/>
     </action>
</application-runner-script>

ldap-logout This test command element provides information that enables Desktop Automation 
Services to log out of SecureLogin.

ldap-logout can have one optional attribute:

 gina: Can have either true or false values. If the value is true, the login dialog 
box for SecureLogin is displayed after logging out of SecureLogin. If the value is 
false, no action is taken.
The default value is true.

ldap-logout cannot have any child elements. 

For example:

<action name="logoff">
     <pause interval="100"/>
     <kill-all-apps exclude-
apps="slbroker.exe:slwinsso.exe:slproto.exe:explorer.exe:"/>
     <ldap-logout gina="true"/>
</action>
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screen-saver-on This action tag invokes the Windows screen saver, which triggers the on-screen-saver 
action. When this action is triggered, the Windows screen saver is started and the 
DAS on-screen-saver is invoked with timer.

This action locks the workstation and triggers the screen saver, which covers up any 
icons and browsers. screen-saver-on elements must be contained by an 
action-triggers parent element.

Use Case: A user is away from the workstation. A smartcard device triggers an event 
to start the Windows screen saver program. After the defined time interval of 
inactivity, the user is logged out. If an activity occurs, the screen saver closes; the 
user is not logged out. The user returns to the workstation, which is in an 
undisturbed state. The screen-saver-on action ensures that the icons and browsers 
are covered.

screen-saver-on has one optional attribute:

 lock: If lock is set to true, the workstation is locked after the screen saver is 
activated. The user must enter the password to unlock the workstation and the 
screen saver.

If lock is set to false, the workstation lock is not activated. Any mouse 
movement or keystroke deactivates the screen saver. 

For Example:

   <action name="Act1">
      <screen-saver-on/>
   </action>
   <action name="Act2">
      <screen-saver-on lock="true"/>
   </action>
   <action name="Act3">
      <screen-saver-on lock="false"/>
   </action>
   <action-triggers>
      <on-hot-key virtual-key="l" modifiers="ctrl" action-
name="Act1"/>
      <on-hot-key virtual-key="m" modifiers="ctrl" action-
name="Act2"/>
      <on-hot-key virtual-key="n" modifiers="ctrl" action-
name="Act3"/>
   </action-triggers>
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test-nds-attr-
val

This test command element provides information that enables Desktop Automation 
Services to test whether or not the currently logged in users NDS account contains a 
particular directory attribute with a particular value. 

test-nds-attr-val has four required attributes:

 tree: The name or IP address of the tree containing the user account to be 
searched for the attribute value. 

 attr-name: The name of the attribute to be tested in the NDS account.
 attr-syntax: The syntax of the attribute to be tested in the NDS account.

The acceptable attr-syntaxes are:
 string
 integer
 boolean

 attr-val: The value to be searched in the target attribute in the NDS account. 
The values for the Boolean syntax attribute must be either true or false.

NOTE: If the attribute syntax is string, then the comparison between the value 
retrieved from the eDirectory and the value of the attr-val is case sensitive.

Because the test-nds-attr-val is a test command, it can contain either  or both 
of the following child elements:

 if-true: An element containing the command operations to perform if the test 
returns a true value.

 if-false: An element containing the command operations to perform if the test 
returns a false value.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action1">
      <test-nds-attr-val tree="TestTree" attr-name="cn" attr-
syntax="string" attr-val="larry">
         <if-true>
            <kill-app application="george.exe"/>
            <run-application application="fred.exe" 
parameters="" serial="true" interval="250"/>
         </if-true>
         <if-false>
            <map-drive drive-letter="S:" remote-
name="\\172.16.5.253\sys"/>
         </if-false>
      </test-nds-attr-val
   </action>
   <action name="sample-action2">
      <test-nds-attr-val tree="TestTree" attr-name="Password 
Minimum Length" attr-syntax="integer" attr-val="5">
         <if-true>
            <!â€"any commands may be inserted here-->
         </if-true>
         <if-false>
            <!â€"any commands may be inserted here-->
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   </action>
   <action name="sample-action3">
      <test-nds-attr-val tree="TestTree" attr-name="Password 
Required" attr-syntax="boolean" attr-val="true">



test-ip-subnet This test command is useful for enabling an action to determine if the workstation 
resides on a particular network or not. This can be critical if the action is deciding 
whether to launch a particular application that is available or effective in a given 
network.

When invoked, the test-ip-subnet command executes the child commands if 
the current subnet of the workstation and the command’s addr attribute value are 
the same.

test-ip-subnet has two required attributes:

 addr: An IP subnet to compare with the local IP addresses of the machine.
 subnet: The subnet mask (in the form of 255.255.255.0) is applied to the addr 

attribute and the local IP addresses, which are then compared. If the network 
portion matches, the test returns a true value. 

Because the test-ip-subnet is a test command, it can contain either one or both 
of the following child elements:

 if-true: An element containing the command operations to perform if the test 
returns a true value.

 if-false: An element containing the command operations to perform if the test 
returns a false value.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
      <test-ip-subnet addr="192.168.1.0" subnet="255.255.255.0">
         <if-true>
            <run-application application="write" parameters="" 
serial="true" interval="500"/>
         </if-true>
         <if-false>
            <run-application application="notepad" parameters="" 
serial="true" interval="500"/>
         </if-false>
      </test-ip-subnet>
   </action>
</application-runner-script>
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test-env-
variable

This test command element enables Desktop Automation Services to test whether an 
environment variable matches a specific value or not.

test-env-variable has two required attributes:

 var-name: The case-sensitive environment variable name. If the variable does 
not exist, the test returns a false value.

 var-value: The value used for case-insensitive comparison with the actual 
variable value.

Because test-env-variable is a test command, it can contain either one or both 
of the following child elements:

 if-true: An element containing the command operations to perform if the test 
returns a true value.

 if-false: An element containing the command operations to perform if the test 
returns a false value.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
      <test-env-variable var-name="Testvar" var-
value="testvalue">
         <if-true>
            <run-application application="write" parameters="" 
serial="true" interval="500"/>
         </if-true>
         <if-false>
            <run-application application="notepad" parameters="" 
serial="true" interval="500"/>
         </if-false>
      </test-env-variable>
   </action>
</application-runner-script>
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message-box This command element provides information that enables Desktop Automation 
Services to display a message box.

message-box has two required attributes:

 caption: The text to be displayed in the dialog box.
 window-name: The title for the dialog box window.

message-box does not have any child elements.

For Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
       <message-box caption="HotKey Control+H was pressed." 
window-name="HotKey Event"/>
   </action>
</application-runner-script>

execute-user-
action

The value of this attribute can be set by using an eDirectory management tool. Find 
the attribute ARSUserConfiguration and edit the value. The value must be 
formatted in the XML syntax as used by the Desktop Automation Services. 

NOTE: The XML information stored in the user object can contain only actions. 
Triggers are not supported.

execute-user-action has one required attribute:

action-name: The name of the configured action read from the user object.

An example value for the ARSUserConfiguration attribute:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
    <action name="userAction">
       <!--.
          .  Any actions may be inserted here.
          . -->
    </action>
</application-runner-script>

execute-user-action Example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
    <action name="sample-action">
         <execute-user-action action-name="userAction"/>
    </action>
</application-runner-script>
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if-true This is one of the two allowed types of child elements for a test type of command. 
The other element is if-false. 

if-true contains the result of all the test commands that return a true value. So, 
if-true can be a parent element for all the commands that constitute an action.

if-true does not have any attribute values.

if-true can contain any number of the following child elements:

 run-application
 test-app-running 
 kill-app
 kill-all-apps
 map-drive
 map-home-drive
 map-location-drive
 test-logged-in
 test-ldap-logged-in
 test-nds-attr-val
 test-ip-subnet
 test-env-variable
 message-box
 nds-logout
 ldap-logout
 execute-user-action

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
     <action name="sample-action">
        <test-env-variable var-name="Testvar" var-value="testvalue">
           <if-true>
              <run-application application="write" parameters="" 
serial="true" interval="500"/>
           </if-true>
           <if-false>
              <run-application application="notepad" parameters="" 
serial="true" interval="500"/>
           </if-false>
        </test-env-variable>
     </action>
</application-runner-script>
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22.2 Using the DAS Editor to Configure Actions
Each instance of DAS is driven by an XML document describing the actions that are available. 

The DAS Editor helps you in composing an action. The wizard tool is available in \SecureLogin\Tools\ 
DAS Editor folder on the SecureLogin CD image. 

if-false This is one of the two allowed types of child elements for a test type of command. 
The other element is if-true. 

if-false contains the result of all the test commands that return a false value. So, 
if-false can be a parent element for all the commands that constitute an action.

if-false does not have attribute value. 

if-false can contain any number of the following child elements:

 run-application
 test-app-running 
 kill-app 
 kill-all-apps
 map-drive
 map-home-drive 
 map-location-drive 
 test-logged-in
 test-ldap-logged-in
 test-nds-attr-val
 test-ip-subnet
 test-env-variable
 message-box
 nds-logout
 ldap-logout
 execute-user-action

For example:

<?xml version="1.0"?><!DOCTYPE application-runner-script SYSTEM 
"ARS_1.0.dtd">
<application-runner-script>
   <action name="sample-action">
      <test-env-variable var-name="Testvar" var-value="testvalue">
         <if-true>
            <run-application application="write" parameters="" 
serial="true" interval="500"/>
         </if-true>
         <if-false>
            <run-application application="notepad" parameters="" 
serial="true" interval="500"/>
         </if-false>
      </test-env-variable>
   </action>
</application-runner-script>
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The DAS Wizard provides an ability to create and modify a configuration file. The wizard helps you 
create the configuration with the correct XML format.

 If you are using the DAS Wizard to create the configuration file, select actions and triggers 
applicable for DAS.

 The DTD file must be stored in the same location as the XML file. The DTD file validates XML.

Creating a New Configuration File
1 Run the DASWizard.exe available in the \SecureLogin\Tools\DAS Editor folder of the 

SecureLogin executables. The wizard is launched.
2 Right-click on the action header and select Insert Action. 
3 Specify a name for the action and press Enter. For example, WSAction.
4 Define a child element for the action that was created.

Right-click the action you added, click Insert Element, and select the child element. For example, 
map-drive.
Note that the Editor will only list the DAS actions that are valid for child elements.

NOTE: The Editor lists only the DAS actions that are valid for child elements.

5 Specify the attributes for the child element you defined in Step 4. Note that not all of the child 
elements have attributes. For example, nds-logout or show-desktop does not have any 
required attributes. 
For example, if you selected map-drive in Step 4, specify the drive letter and the UNC path to be 
mapped.

6 To add a trigger to the action you have created, right-click on the header trigger, followed by 
selecting Insert trigger. The Editor will display a list of valid triggers that can be selected. Select 
the desired trigger.

7 Specify the attributes for the trigger you selected.
8 The configuration specified is saved to a new text file in the required XML format.

The DTD file must be copied to the same location as the xml file that you want to edit. If you 
create a new configuration file by following the previous steps and require to open the file for 
further editing, then you need to copy the DTD file to the same location. Creating a new 
configuration file uses the DTD file from the DAS Editor folder for validation of the XML syntax. If 
the DTD file is not located the following error message is displayed:

Error Loading XML
Error 0x800c0006 on line x, position x
Reason: The system cannot locate the object specified. 
Error processing resource 'ARS_1.0.dtd'.
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22.3 Example of an Action File
The following XML file contains examples of most of the XML elements that can be used to compose 
action sequences in Desktop Automation Services. 

<application-runner-script>
   <action name="startup">
      <test-app-running application="sltray.exe">
         <if-true>         
         </if-true>
         <if-false>
        <hide-desktop/>
            <run-application application="sltray.exe" parameters="" on-exit-
action="restartNSL" serial="true" interval="500"/>
         </if-false>
      </test-app-running>    
   </action>
   <action name="restartNSL"> 
      <test-app-running application="sltray.exe">
         <pause interval="500"/>    
         <if-true>
         </if-true> 
        <if-false>
            <run-application application="sltray.exe" parameters="" on-exit-
action="restartNSL" serial="true" interval="500"/>
         </if-false>
      </test-app-running>
   </action>
   <action name="loggedin">
      <pause interval="1000"/>
    <unhide-desktop/>
    <!-- Starting the chrome browser with the url mention in the parameters -->
    <run-application application="chrome.exe" parameters="https://www.msdn.com" on-
exit-action="" serial="true" interval="500"/>
   </action>
   
   <action name="logoff">
   <!-- <message-box caption="logoff" window-name="Session logoff"/> -->
     <pause interval="2000" />
         <ad-logout/>
            <pause interval="1000" />  <!-- delay for NSL to successfully shutdown 
-->
            <kill-app application="chrome.exe"/>
      <hide-desktop/>
            <run-application application="sltray.exe" parameters="" on-exit-
action="restartNSL" serial="true" interval="500"/>
       
   </action>
<action-triggers>
        <!-- action executed when user logs in to AD through SecureLogin -->
        <on-ad-login action-name="loggedin"/>
    <on-hot-key modifiers="ctrl" virtual-key="l" action-name="logoff"/>
        <on-hot-key modifiers="ctrl" virtual-key="s" action-name="loggedin"/>
    <!-- This is for contactless smart card is tapped on and tapped out -->
    <on-Tap-cardmon action-name="logoff" card-tapon="" LoginAction="loggedin" 
TapCardSwitchUser="true"/>
    </action-triggers>
</application-runner-script>

NOTE: Additional action file examples can be found in SecureLogin\Tools\DAS 
Editor\Script Samples\XML on the SecureLogin CD image.
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23 23Support for Tap to Switch User

Traditional single sign-on solutions provide credential management solutions to web and Windows 
applications. Organizations now require more services that provide flexibility to users as well as ease 
of deployment and integration with other applications.

Let us assume Digital Health is a hospital that has a centralized nurse station where all the nurses 
and doctors are required to login and logout for patient administration. Now, Digital Health requires 
following capabilities from a single sign-on solution tool:

 Support for the Kiosk mode to avoid multiple systems
 Multi-user interface to save login/logoff time when users switch
 An alternative to the conventional username/password method to save time in emergency 

situations

To overcome these challenges the Tap to Switch User feature of SecureLogin provides following 
capabilities: 

 Supports the Kiosk mode
 Integration with Desktop Automation Services (DAS) and Advanced Authentication allows user 

to switch using smart cards
 Support for contact-less smart cards

The following sections contain information about how to configure SecureLogin for the Tap to Switch 
User feature.

 Section 23.1, “Prerequisites,” on page 173
 Section 23.2, “Configuring the Tap To Switch User Feature,” on page 173

23.1 Prerequisites
This following list includes the minimum requirements to enable the Tap to Switch User feature:

1. SecureLogin 8.1.1 or above.
2. Contact-less smart cards enrolled for the Active Directory users.

23.2 Configuring the Tap To Switch User Feature
Perform the followings steps to configure the Tap to Switch User feature:

1 Select the following features while installing SecureLogin:
 In the Select the datastore for SecureLogin menu, select the Microsoft Active Directory 

option
 In the Custom Setup menu, select Advanced Authentication and Desktop Automation 

Services.
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For more information about how to install SecureLogin, see SecureLogin CE 24.3 (v9.2) 
Installation Guide.

2 Perform the following steps to configure the Kiosk Mode in SecureLogin:
2a Click Start > Run to open the Run dialog box.
2b Specify regedit and click OK to open Registry Editor.
2c Navigate to the HKEY_LOCAL_MACHINE > SOFTWARE > Protocom > SecureLogin key.
2d Right click and click New > DWORD.
2e Rename the DWORD to NSLADAuth.
2f Edit the NSLADAuth value to 1.

3 Perform the following steps to configure DAS in SecureLogin:
3a Open the DAS configuration file from the following path:

C:\Program Files\NetIQ\SecureLogin\Desktop Automation 
Services\actions.xml

3b Edit the TapCardSwitchUser attribute in the configuration file to enable tap to switch 
user operation.

IMPORTANT: The TapCardSwitchUser attribute is used to restrict the card tap to switch 
users in the KIOSK mode. If this attribute value is set to true, then single card tap is 
required to switch the user. If this attribute value is set to false, then double card tap is 
required to switch the user.

The following example shows a sample DAS configuration file with the TapCardSwitchUser 
attribute value set to true.

<?xml version="1.0"?>

<!DOCTYPE application-runner-script SYSTEM "ARS_1.0.dtd">

<!-- KP Base Windows Action for Active Directory Mode Version: 1.02 
-->

<!-- Inactivity Counter is supposed to be working -->

<application-runner-script>

<action name="startup">

<test-app-running application="sltray.exe">

<if-true>

<AD-logout gina="false" />

<!-- delay for NSL to successfully shutdown -->

<pause interval="750" />

<hide-desktop/>

<pause interval="750" />
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<!-- <kill-all-apps exclude-
apps="slproto.exe:slwinsso.exe:slbroker.exe:explorer.exe:notepad.ex
e" /> -->

<pause interval="750" />

<run-application application="sltray.exe" parameters="" on-exit-
action="" serial="true" interval="500"/>

</if-true>

<if-false>

<hide-desktop />

<pause interval="750" />

<run-application application="sltray.exe" parameters="" on-exit-
action="" serial="true" interval="500"/>

</if-false>

</test-app-running>

</action>

<action name="showdesktop">

<unhide-desktop/>

</action>

<action name="SCLogoff">

<AD-logout gina="false" />

<!-- delay for NSL to successfully shutdown -->

<pause interval="750" />

<hide-desktop/>

<pause interval="750" />

<!-- <kill-all-apps exclude-
apps="slproto.exe:slwinsso.exe:slbroker.exe:explorer.exe:notepad.ex
e" /> -->

<pause interval="750" />

<run-application application="sltray.exe" parameters="" on-exit-
action="" serial="true" interval="500"/>

</action>
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<action name="insert">

<test-app-running application="sltray.exe">

<if-true></if-true>

<if-false>

<run-application application="sltray.exe" parameters="" on-exit-
action="" serial="true" interval="500"/>

</if-false>

</test-app-running>

</action>

<action-triggers>

<on-Tap-cardmon action-name="SCLogoff" card-tapon="insert" 
LoginAction= "showdesktop" TapCardSwitchUser="true"/>

</action-triggers>

</application-runner-script>
For more information about how to configure DAS configuration, see Chapter 22, 
“Administering Desktop Automation Services,” on page 149.

4 Perform the following steps to configure DAS to start during Windows start up:
4a Click Start > Run to open the Run dialog box.
4b Specify regedit and click OK to open Registry Editor.
4c Navigate to the HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows > 

CurrentVersion > Run key.
4d Right click and click New > String Value.
4e Edit String Value and specify the DAS executable path in the Value data field. For example, 

specify DAS : C:\Program Files\NetIQ\SecureLogin\Desktop Automation 
Services\ARS.exe startup in the Value data field.

NOTE: The startup parameter in the DAS executable path is the additional parameter 
used in DAS to invoke a default action defined in the actions.xml DAS configuration file 
during Windows startup.

4f Restart the Windows.
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24 24LDAP SSL Server Certificate Verification

 Section 24.1, “About LDAP SSL Server Certificate Verification,” on page 177
 Section 24.2, “Validating an LDAP SSL Server Certificate,” on page 177
 Section 24.3, “Enabling LDAP SSL Certificate Verification,” on page 178

24.1 About LDAP SSL Server Certificate Verification
The LDAP SSL server certificate verification is a security feature that was introduced in the 
SecureLogin 6.0 SP1 release. This feature allows the client to verify the trustworthiness of the server, 
using a process similar to the certificate verification process carried out by browsers like Microsoft 
Internet Explorer and Mozilla Firefox. 

Certificate verification of the server is important to prevent potential security risks. It is essential 
that the client verify the server certificate during the LDAP SSL connection to the server. If the client 
cannot verify the server certificate, it is possible that an intruder on the same subnet can decrypt 
the communication between the client and access user credentials. 

By default, eDirectory is configured for self-signed certificates. Although self-signed certificate 
works, it does not pass all the validation checks carried out during the verification process. So, users 
are prompted to validate the certificate at the first time they attempt to access the server. To 
prevent this, you can obtain a signed certificate from a known certificate authority such as VeriSign 
and replace the existing certificate.

24.2 Validating an LDAP SSL Server Certificate
During the establishment of an LDAP SSL connection, client receives the root certificate from the 
server so that the client can verify the trustworthiness of the server. The client uses the following 
process to validate the certificate: 

 It compares the current certificate with any of the previously stored certificate. If the 
certificates match, the client does not perform further checks, and adds the certificate to the 
local store. If the certificates do not match, the client continues the validation process.     

 It checks whether the certificate is trusted. This ensures that a known authority is issuing the 
certificate. 

 It checks whether the date on the certificate is valid with reference to the current date. 
 It checks whether the host name on the certificate matches the date on the server. 

If the certificate passes these preceding tests, the client adds the certificate to local store so it can be 
used for future verification. 
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If the certificate does not pass the verification process, the application prompts you to either 
continue the connection or terminate the connection. 

 To continue the connection, click Yes. The certificate is added to the local store so it can be used 
for future verification, and the authentication process continues.

 To terminate the connection, click No. 
 To get details about the certificate, click View Certificate to display the Certificate Information 

dialog box shown in the proceeding figure. If you decide that the certificate is valid, you can 
click Install Certificate to permanently install the certificate.

NOTE:  The Windows workstation local store is different from the SecureLogin LDAPAuth clients 
certificate store.

24.3 Enabling LDAP SSL Certificate Verification
By default, the certificate verification feature is disabled. You can enable this feature by adding the 
following registry value:

1 On a Windows workstation, click Start > Run to display the Run dialog box. 
2 Type regedit then click OK to open the Registry Editor. 
3 Browse to the HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Login\LDAP registry hive. 
4 Create a new DWORD Value named VerifySSLCert and set it to 1.
5 Exit the Registry Editor.
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25 25Security Considerations

Consider the following to help ensure security for SecureLogin:   

 Use the AES (Advanced encryption standard) or Triple DES (Data Encryption Standard) for the 
encryption of SecureLogin data.

 Back up SecureLogin data and directory data by using encryption and password protection. 
 Use AAVerify to provide additional advanced authentication to single sign-on applications 

with NMAS methods or other AA methods such as NetIQ Advanced Authentication Framework.
 Implement smart cards, storing application credentials on cards and the encryption of the data 

store using PKI credentials. 
 Protect the SecureLogin desktop shortcut with a password so that others cannot view 

SecureLogin data.
 Prevent certain SecureLogin settings and options from being visible or modifiable by others.
 Use a universal password for increased security by providing additional layers of policies.
 Require SecureLDAP when using LDAP to authenticate to SecureLogin.
 Use Novell SecretStore to provide additional security to SecureLogin data stored on eDirectory.
 Use AA methods such as OTP and NMAS to provide advanced authentication, such as 

fingerprint, and token-based authentication.
 Store SecureLogin credentials in a PIN-protected smart card, which provides a secure, portable, 

and efficient single sign-on solution.
 Keep the local cache files in a user profile directory so that only the corresponding Windows 

user can access them.
 Enable a passphrase to provide additional security to SecureLogin user data.
 Ensure strict password policies for SecureLogin users and for all single sign-on logins. 

Randomization of passwords and hiding them from end users is also essential.
 Use auditing features such as NetIQ Sentinel, SNMP alerts and Windows event logs to capture 

SecureLogin activity wherever applicable.
 When you are using LDAP with NMAS, the SecureLogin universal password must be enabled. 
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26 26SecureLogin Security Role Configuration 
for Active Directory

For a user to administer SecureLogin in an Active Directory environment, the user must have both 
sufficient permissions to the SecureLogin attributes and the SecureLogin settings to allow access.

In this Chapter

 Directory Attributes
 Directory Permissions Assignment
 Assigning Permissions for SecureLogin Administrators
 Assigning Permissions for SecureLogin Help Desk
 Assigning SecureLogin Client Settings for Administrators and Help Desk Groups

26.1 Directory Attributes
The protocom attributes hold user or container data that is used by SecureLogin to provide Single 
Sign-On functionality. These attributes are named as follows: 

protocom-SSO-Auth-Data 
protocom-SSO-Entries 
protocom-SSO-Entries-Checksum 
protocom-SSO-Profile 
protocom-SSO-Security-Prefs 
protocom-SSO-Security-Prefs-Checksum 
The function for each of these attributes is as follows: 

protocom-SSO-Auth-Data:  
 This attribute is only for a User object. It is an octet-string type. 
 It contains all user-specific authentication data, such as the passphrase. 

protocom-SSO-Entries:  
This attribute is for User, Container, and Organizational Unit objects. It is an octet-string type. 
This attribute contains the following: 
 All the user's login user IDs and passwords 
 Specific preferences and application definitions at the User object 
 Corporate application definitions and preferences at the Container and Organizational Unit 

objects 

protocom-SSO-Entries-Checksum:  
 This attribute optimizes the loading of data from the Directory. Whenever data changes in 

the protocom-SSO-Entries attributes, the Checksum attribute is updated. When 
SecureLogin loads, it reads the checksum and compares it to the checksum in memory. If 
the checksums are different, SecureLogin reloads the Entries attribute from the directory. 
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NOTE: This attribute is used only when the database mode is set to 6.0 or higher.

protocom-SSO-Profile: 
 This attribute is used to instruct SecureLogin to read the settings and preferences from 

another container. 

protocom-SSO-Security-Prefs: 
 This attribute stores data required for SecureLogin to operate before loading the users 

datastore. This data can include Administrator-set Passphrase questions, Passphrase help 
information, settings, and similar things. 

protocom-SSO-Security-Prefs-Checksum: 
 This attribute functions with the protocom-SSO-Security-Prefs attribute much like the 

protocom-SSO-Entries-Checksum functions with the protocom-SSO-Entries attribute. 

NOTE: This attribute is used only when the database mode is set to 6.0 or higher.

26.2 Directory Permissions Assignment 
Based upon the above attribute descriptions and functions, specific roles might be granted the 
following permissions: 

 Complete SecureLogin Management: 
 protocom-SSO-Auth-Data = Read and Write 
 protocom-SSO-Entries = Read and Write 
 protocom-SSO-Entries-Checksum = Read and Write 
 protocom-SSO-Security-Prefs = Read and Write 
  protocom-SSO-Security-Prefs-Checksum = Read and Write 

 Script, Credentials, and Clear Object Data administration: 
 protocom-SSO-Auth-Data = Read and Write 
 protocom-SSO-Entries = Read and Write 
 protocom-SSO-Entries-Checksum = Read and Write 

Depending on the needs of your organization, these permissions can be assigned to specific users or 
groups at an organizational unit level. The following discussion demonstrates the creation of a 
SecureLogin Administration group and the delegation of permissions to an organizational unit that is 
one level below the top level organizational units in the Directory hierarchy. 

26.3 Assigning Permissions for SecureLogin Administrators
1 Login to the Active Directory domain as an administrative level user. 
2 On a workstation or server, open Active Directory User and Computers (dsa.msc), and browse to 

the OU where you would like to create the group that will manage SecureLogin for the selected 
container and its children. 

3 Click the create group button. 
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4 Give the group a descriptive name, such as Service1-SecureLogin-Admins.
5 Add the appropriate users to the group.
6 Delegate the permissions to the SecureLogin attributes at the container where the users are. 

7 Add the group you want to delegate control, then click Next. 

8 Select create a custom task to delegate, then click Next.
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9 Select This folder, existing objects in this folder, and creation of new objects in this folder, then 
click Next. 

10 Since these are administrator level users, they will be granted permissions to manage all aspects 
of the container and its subordinate objects. Select the General, Property-specific check boxes. 
Select the Read, Write, Read All Properties, and Write All Properties permissions. 
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Verify that you have all Protocom permissions with Read and Write. Click Next to continue. 
11 You are now finished with the delegate control wizard for the Service1-SecureLogin-Admins 

group. Click Finish. 

26.4 Assigning Permissions for SecureLogin Help Desk
1 Login to the Active Directory domain as a administrative level user. 
2 On a workstation or server open Active Directory User and Computers, and browse to the OU 

where you would like to create the group that will hold the Help Desk users who will work with 
SecureLogin for the selected container and its children. 

3 Click the create group button .
4 Give the group a descriptive name, such as Service1-SecureLogin-Help Desk. 

5 Add the appropriate users to the group. 
6 Delegate the permissions to the SecureLogin attributes at the container where the users are. 
7 Add the group you want to delegate control to, then click Next. 
8 Select create a custom task to delegate, then click Next. 
9 Select the Only the following objects in the folder, then scroll down to user objects and select it. 

Click Next. 
10 Since these are SecureLogin Help desk level users they will only be granted permissions to 

manage the SecureLogin attributes. Select the General and Property-Specific checkboxes. Then 
scroll down and select both the read and write permissions for all protocom- attributes. 

11 You are now finished with the delegate control wizard for the Service1-SecureLogin-Admins 
group. Click Finish. 
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26.5 Assigning SecureLogin Client Settings for 
Administrators and Help Desk Groups 
Now that you have assigned the correct Directory permissions to allow members of the 
administrators and help desk groups to read and write the protocom attributes, you need to assign 
the SecureLogin client settings (SecureLogin preferences) to allow them to see what they have 
permissions to access. This is required to override the more restrictive settings the user will inherit 
from their parent container. 

To accomplish this, you can either directly modify the users individual settings. A viable approach if 
you have a few users who will be granted the elevated permissions. This said, many customers still 
choose the direct assignment approach, as it can reduce the steps when troubleshooting where 
someone is getting a specific client setting from. Alternatively, you might utilize SecureLogin group 
policies. In both cases, see step 8 for the recommended settings. 

It assumed that you know how to assign individual user’s settings, and the information in this section 
focuses on the use of group policies (assuming the feature was enabled during the product 
installation). As stated previously, both methods have their merits and should be evaluated before 
deciding on an approach. 

26.5.1 Creating the Group Policy
1 Log in to the Active Directory domain as a administrative level user. 
2 On a workstation or server open Active Directory User and Computers, and browse to the OU 

that contains the groups that you created earlier. Right click it, select Properties. 
3 In the properties dialog that opens up, select the Group Policy Tab.

NOTE: In this example, the Group Policy Management snap-in has been installed. It can be 
downloaded from Microsoft (http://www.microsoft.com/downloads/
details.aspx?FamilyID=0a6d4c24-8cbd-4b35-9272-dd3cbfc81887&displaylang=en)

4 Click Open. 
5 Select the Group Policy Objects container, right-click it, and click New. 
6 Enter a name for the GPO. 
7 Right-click the new GPO and select Edit. 
8 Go to User Configuration > Software Settings. In the right pane, double-click SecureLogin. 
9 In the SecureLogin management interface, select the Preferences tab. Set each setting in 

accordance with what you want the users to do. 

NOTE: The users referred in this example are administrators and help desk staff. They have full 
access to the SecureLogin client. Your configuration might differ slightly.

The preferences highlighted are the ones that are critical to ensure users are able to mange 
SecureLogin. Ensure that they are set as follows:
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10 Click OK. This might take a minute to save. 
11 Close the GPO editor. 
12 In the GPM, select the new GPO you created, remove the Authenticated Users group, and add 

the admin and help desk groups you created in the previous two sections. 
13 Link this policy to the OU where the users are located. Right-click and select Link to an existing 

GPO. 
14 Select the GPO you created, click OK. 
15 Close the GPM. Click OK on the group policy tab. 
16 Close Active Directory Users and Computers. 

26.5.2 Testing the Configuration
If you chose to use individual assignment or GPO assignment, proceed with the following tests to 
confirm your updated configuration: 

1 On a workstation with SecureLogin and the Active Directory Admin Pack, log in as a user who is 
a member of one of the groups you have configured as SecureLogin administrators or help desk.

2 If your GPO refresh has not occurred, you can manually force the update by going to a 
command line and issuing the gpupdate /force command (Windows XP). You should see results 
similar to the following: 
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3 Launch Active Directory Users and Computers. Navigate to the container where you delegated 
control. As a member of the Admins group you should be able to manage the OU’s, and 
subordinate objects, applications and preferences. 
As a member of the Help Desk group you should be able to only make changes to the users in 
the OU. It might appear that as a help desk user you can save changes to the OU, but that is not 
the case. And if you close the Single Sign-On properties and then open it back up, you will see 
the changes were not saved.
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27 27Limiting Concurrent Connections

SecureLogin when installed in the LDAP mode (for eDirectory or non-eDirectory), can restrict the 
number of concurrent user connections to eDirectory, or Active Directory. According to the limit set 
for a user at the directory level, SecureLogin decides whether to allow user authentication or deny it. 
The connection log of all the user accounts is maintained and managed by SecureLogin.The validity 
of any entry will be decided based on the timestamp and the pre-defined time-to-live parameter.

Setting up the environment for limiting concurrent connections consists of the following actions:

 Section 27.1, “Registry Entry,” on page 189
 Section 27.2, “Schema Extension,” on page 189
 Section 27.3, “Setting the Attribute Values,” on page 191

27.1 Registry Entry
1. Modify the EnforceConcurrentConnections value under 

HKLM\Software\Novell\Login\LDAP. This should be a DWORD type and the value 
should be set to 1. To disable this feature, set the value to 0. 

2. Under HKLM\SOFTWARE\Novell\Protocom\SecureLogin, add the value of 
LDAPContextlessSearchBindcreds. Copy this value from the output file that contains the 
encrypted credential in the string format. For information about encrypting the credentials of 
the LDAP user, see Contextless Login in the SecureLogin CE 24.3 (v9.2) Installation Guide.

27.2 Schema Extension
Extend the schema to add the attributes for the limit of concurrent connections and the timestamp 
for a connection. 

For eDirectory: The schema has to be extended and the attribute rights have to be set using the 
included .sch and .ldif files, which are found at SecureLogin\Tools\Schema\LDAP. The 
Concurrent_schema_extn.sch file is used to add the attributes to the schema, and the 
concurrent-rights.ldif file is used to extend the rights. These files can be extended as 
mentioned in the proceeding options.

The Concurrent_schema_extn.sch file can be used to extend the eDirectory schema with one 
of the following options:

 ndssch (eDirectory schema extension utility): This is a Windows/ Linux executable. Type the 
following in the command shell:

ndssch <AdminDN> Concurrent_schema_extn.sch
For more information, see ndssch Utility. 

 ICE Tool (version 20503.02 or later): Execute the following command:
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ice -S SCH -f Concurrent_schema_extn.sch -D LDAP -d <AdminDN> -w 
<password> -L <ServerCertificate>
For more information about ICE (NetIQ Import Conversion Export Utility), see NetIQ Import 
Conversion Export Utility in the eDirectory Administration guide.

The concurrent-rights.ldif file can be extended by using one of the following options:

 ICE Tool (version 20503.02 or later): Execute the following command in eDirectory:
 ice -S LDIF -f concurrent-rights.ldif -D LDAP -d <AdminDN> -w 
<password> -L <ServerCertificate>
For more information about ICE (NetIQ Import Conversion Export Utility), see NetIQ Import 
Conversion Export Utility in the eDirectory Administration guide.

 LDAP Modify tool: Execute the following command in eDirectory:
 ldapmodify -x -h <host ip address> -p 389 -D cn=admin,o=context -w 
password -f concurrent-rights.ldif

NOTE: LDIF and SCH files are not integrated with the ldapschema.exe file, but are bundled as 
separate files in SecureLogin\Tools\Schema\LDAP.

For Active Directory: The ConcurentSchema.exe file is used to extend the schema to add the 
required attributes to the schema. The default location for this file is 
SecureLogin\Tools\Schema\AD. To extend the schema, perform the following:

1 Run the Concurrentschema.exe file.
2 Select Extend Active Directory Schema.
3 Assign rights to the directory.

To set the attribute values, see Section 27.3, “Setting the Attribute Values,” on page 191.
4 Click OK.

After the schema is extended, three new attributes are added to the list of attributes:

 Protocom-SSO-Connections: This attribute stores the connection information, that is the IP 
address along with the timestamp. This attribute gets added when a user connects for the first 
instance.

 Protocom-SSO-ConnectionLimit: This attribute stores the configuration parameter, indicating 
the number of concurrent connections that are allowed for the user.

 Protocom-SSO-ConnectionTTL: This attribute stores the configuration parameter that indicates 
how long the connection information will be stored.
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27.3 Setting the Attribute Values
To set the attribute values by using MMC (Microsoft Management console), assign the Protocom-
SSO-ConnectionLimit attribute and the Protocom-SSO-ConnectionTTL attribute to the user 
and then set the attribute values.

To set the attribute values, perform the following:

1 In Active Directory Users and Computers, click View > Advanced Features
2 In the Users list, right-click the user and click Properties > Attribute Editor.

You can set the attribute values, then click OK.

Example:
The attributes are set to the following values:

 Protocom-SSO-ConcurrentConnectionLimit: 2
 Protocom-SSO-ConcurrentConnectionTTL: 1440 (in minutes)

When UserA logs in from workstation 1 with IP 1.1.1.1, a new entry is added to the Protocom-SSO-
Connections attribute in the IP@timestamp format, that is,  1.1.1.1@20110621000000 (2011 June 
21 00 AM). 

Similarly, when UserA logs in from workstation 2 with IP 2.2.2.2, another entry is added to the 
Protocom-SSO-Connections attribute in the IP@timestamp format, that is, 
2.2.2.2@20110621040000 (2011 June 21 04 AM). 

If UserA then tries to log in from workstation 3, SecureLogin will deny the authentication because 
the connection limit is exceeded.
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28 28Support for Advanced Authentication

SecureLogin uses the Advanced Authentication infrastructure to integrate SecureLogin features with 
Advanced Authentication. The integration with Advanced Authentication helps SecureLogin to single 
sign-on to the required application by using different authentication mechanism. For more 
information about Advanced Authentication, see the Server Administration Guide.

In a deployment with Advanced Authentication, SecureLogin supports the following features:

 Authentication: Advanced Authentication provides the Credential Provider in the system where 
it is installed. When the user logs in using this Credential Provider, SecureLogin will also launch 
seamlessly in an Active Directory environment.

 Re-authentication: SecureLogin leverages this functionality by making Advanced 
Authentication available during re-authentication. This module can be configured from the 
wizard or a script. An appropriate authenticator can be selected for re-authentication when 
configuring this module. This feature is supported in Active Directory, AD LDS and eDirectory 
environments.

 Kiosk Mode: SecureLogin uses Advanced Authentication as an external authenticator in Active 
Directory and eDirectory deployments in kiosk mode.

 DAS Support:  DAS on Active Directory and eDirectory supports the Advanced Authentication 
and SecureLogin integrated environment. This feature can effectively be used for desktop 
sharing using DAS.

In this Chapter

 Advanced Authentication Registry Settings
 Configuration of Advanced Authentication for SecureLogin

28.1 Advanced Authentication Registry Settings
 To enable kiosk mode, create the following registry: 

 To disable advanced authentication, create the following registry: 

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin

DWORD NSLADAUTH For kiosk authentication, 
set NSLADAUTH to 1.

Setting NSLADAUTH to 0 
is the default behavior.
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 To enable Advanced Authentication debug logging, create the following registry: 

 To disable SSL check, create the following registry: 

 To change the background image, create the following registry: 

 To change the system tray icon, create the following registry: 

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin

DWORD NoAuthasas For disabling the 
advanced authentication 
feature, set NoAuthasas 
to 1; but for enabling it, 
set to 0.

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin\Loggi
ng

DWORD All For enabling the 
advanced authentication 
debug logging, set All to 
0.

Only log levels 1 and 2 are 
supported.

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin\Advan
cedAuthentication

DWORD DisableSSLCheck For disabling the SSL 
check, set 
DisableSSLCheck to 1; but 
for enabling it, set to 0 
(default). 

IMPORTANT: If you set 
the registry value to 0, 
you must upload the SSL 
certificate to the 
Advanced Authentication 
server.

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin\Advan
cedAuthentication

SZ BackgroundImagePat
h

Specify the path that 
contains the background 
image.
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 To change the windows title, create the following registry: 

28.2 Configuration of Advanced Authentication for 
SecureLogin
When installing Advanced Authentication, the default event name is Windows logon in the Advanced 
Authentication server.

You can also enter any custom name (same as configured in the Advanced Authentication server) as 
the event name, as the custom event can be used for re-authentication and KIOSK mode.

If you enable the Kiosk mode, you need to enter the username and logon method. The logon 
method will have the list of chains from the custom event or the Windows Logon event. For the re-
authentication wizard, the list of chains either from the custom or Windows Logon event will be 
displayed for selection. You must choose a logon method to initiate the Advanced Authentication 
flow.

NOTE: During SecureLogin installation, the installer registers an endpoint to the Advanced 
Authentication server, which is used for validation of the credentials for all supported mechanisms.

SecureLogin uses TLS v1.2 to communicate with the Advanced Authentication server. If your 
deployment does not allow using TLS v1.2, you can use the lower version after performing the 
following steps:

IMPORTANT: It is not recommended to use TLS 1.1 because it is less secure than TLS 1.2 and it may 
open your deployment to the security threats.

1 Navigate to the SecureLogin installation folder. For example, C:\Program 
Files\NetIQ\SecureLogin.

2 Open the config.cfg configuration file.
3 Specify the following in the configuration file.
tlsVersion: TLSv1.1

4 Save the configuration file.

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin\Advan
cedAuthentication

SZ IconPath Specify the path that 
contains the system tray 
icon.

Registry Path Registry Type Registry Name Registry Value

HKEY_LOCAL_MACHINE
\SOFTWARE\Protocom
\SecureLogin\Advan
cedAuthentication

SZ WindowTitle Specify the window title.
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29 29VBA Emulators for SecureLogin

VBA emulators support the Visual Basic scripting language. You can write a macro for the emulator. 
The macro prompts SecureLogin to enter credentials. Configuring VBA emulators to work with 
Terminal Launcher is a specialized field and is specific to each emulator.

You can configure VBA emulators as generic emulators. However, the generic configuration offers 
limited functionality.

In this Chapter

 Configuring VBA Emulators
 Configuring Reflections
 Creating a Macro
 Configuring the Emulator Type of Terminal Launcher

29.1 Configuring VBA Emulators
Perform the following steps to configure a VBA emulator:

1 Click Start > Programs > NetIQ SecureLogin > Terminal Launcher 32 or Terminal Launcher 64.
Terminal Launcher displays the applications for which you have created VB scripts.

2 Click Edit Available Emulators > New.
3 Specify a name for the emulator, select VBA as the emulator type, and click OK.
4 Specify the following details:

5 Click OK.
6 Click Done.
7 Continue with Configuring Reflections.

Field Description

Emulator Path Specify the path to the emulator. For example, select R8win.exe, which 
supports IBM PC (Reflection for IBM).

Emulator Session File Specify a name for the valid session file to be created in the .rd3x format.

For example, let us connect to an IBM 3270 Terminal by using Trace Player 
that simulates the session. 
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29.2 Configuring Reflections
The following procedure illustrates the steps to configure a reflection for IBM 3270 terminal as an 
example:

1 Launch the Reflection workspace.
2 In Create New Document, select 3270 terminal as the session template. 
3 Click Create.
4 Specify host name where the terminal is listening to and device name.
5 Specify Terminal /Device type. In this example, specify IBM -3278-&M.
6 Keep the default values of other settings.
7 Click OK. 

An untitled session file is created in the .rd3x format.
To determine which type of the terminal you are using, perform the following steps:

1. Open the session in Reflection.
2. Verify the file extension in the session tab to determine which terminal you are using. 

8 In the Reflection workspace, click Macro > Reflection Objects > Modules > Module1 (as this is the 
first module under the same session).

9 Select Declarations.
The VB Editor window opens.

10 Create a sample VB script.
11 Click Tools > References.
12 Click Browse and select slVBA Type Library. 
13 Continue with Creating a Macro.

29.3 Creating a Macro
Create a macro that gets the text from the screen and displays it in a message box. For information 
about how to create a macro, see Create a Macro with the VBA Editor.

Continue with Configuring the Emulator Type of Terminal Launcher.

Samples
 Printing the Screen Text
 Saving the Entire Screen as Text
 Opening a Session Dynamically
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Printing the Screen Text
The following is a sample VB script of a macro to capture the screen text:

Sub CopyTextMacro()
    'Create a variable to hold the text
    Dim screenText As String
      
    'Get text from the screen starting at screen row 1, column 1, and 30 characters 
long
     screenText = ThisIbmScreen.GetText(1, 1, 30)
      
    'Display the text in a message box
    MsgBox (screenText )
End Sub
The following is a valid response from the Reflection application and the same response is shown in 
the console of IBM Simulator 3230 by using Trace Player:

Saving the Entire Screen as Text
The following sample gets all text displayed on a screen and saves that to a text file:

Private Function IbmScreen_BeforeSendControlKey(ByVal sender As Variant, key As 
Long) As Boolean
    Dim screenRows As Integer
    Dim screenColumns As Integer
    Dim fnum As Integer
    Dim screenShot As String
    screenRows = ThisIbmScreen.rows
    screenColumns = ThisIbmScreen.columns
   
    'Get all the text on the screen
    screenShot = ThisIbmScreen.GetTextEx(1, 1, screenRows, screenColumns, 
GetTextArea_Block,  _
    GetTextWrap_Off, GetTextAttr_Any, GetTextFlags_CRLF)
   
    'Add a line to separate each screen
    screenShot = screenShot & 
"................................................................................"
   
    'Open a file and append the screenshot to the file
    path = ThisIbmTerminal.SessionFilePath & ".log"
    fnum = FreeFile()    
    Open path For Append As fnum
    Print #fnum, screenShot
    Close #fnum
   
    IbmScreen_BeforeSendControlKey = True
End Function
For information about how to run this script in Visual Basic Editor, see Save Screens as Text.
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Opening a Session Dynamically
You can open or close sessions dynamically. For information about how to open a terminal session 
from another session that is running in the Reflection workspace, see Dynamically Open a Session.

Save the session and create a working SecureLogin script for the Terminal Emulator type that prints 
MessageBox to evaluate the interactions of Terminal Launcher. If launched from Terminal Launcher 
32, launch the same.

29.4 Configuring the Emulator Type of Terminal Launcher
To interact the screens and inject username and passwords, the VBA Emulator type of the Terminal 
Launcher must be WinHLLAPI. 

Perform the following steps to set WinHLLAPI as the emulator type:

1 Click Start > Programs > NetIQ SecureLogin > Terminal Launcher 32 or Terminal Launcher 64.
2 Right-click Terminal Launcher 32 or Terminal Launcher 64 and select Run as administrator.
3 Select the application for which you want to change the emulator type.
4 Click Edit Available Emulators.
5 Click New and specify the following details:

6 Click OK.
7 Specify the following details:

8 Click OK > Done.

Field Description

Emulator name Specify a name for the emulator.

Emulator type Select WinHLLAPI.

Field Description

Emulator Path Specify the emulator executable’s location. 

For example, C:\Users\administrator\Desktop\<session-
name>.rd3x 

Home Directory Specify the emulator’s home directory.

For example, C:\Program Files (x86)\Micro 
Focus\Reflection

HLLAPI DLL Specify the file name and path.

For example, C:\Program Files (x86)\Micro 
Focus\Reflection\Whlapi32.dl

HLLAPI Function Specify WinHLLAPI.

Session Files Select the current session file.
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30 30Troubleshooting

 Unable to See Password Using ?syspassword If the User Is Authenticated Using Smart Card PIN
 SecureLogin Fails To Provide Single Sign-on to Virtual Applications
 SecureLogin Fails To Start For Domain Users On Windows Domains Or Domain Controller 

Servers
 Recovering a Forgotten Password
 Smartcard Does Not Work with SecureLogin in Windows 11

30.1 Unable to See Password Using ?syspassword If the User 
Is Authenticated Using Smart Card PIN
Workaround 1: In Universal Password > Configuration Options, select Allow admin to retrieve 
passwords.

Workaround 2:  In Universal Password > Configuration Options, select Allow the following to retrieve 
passwords. Specify the FDN of the user allowed to retrieve the password. 

30.2 SecureLogin Fails To Provide Single Sign-on to Virtual 
Applications
Issue: SecureLogin does not provide SSO to virtual applications because the virtualization tools do 
not allow SecureLogin running on the host to access the virtualized application. 

For example, when you use ZENworks Application Virtualization to virtualize Internet Explorer, 
SecureLogin does not provide SSO to Internet Explorer. The following reasons can cause this issue:

1. ZENworks Application Virtualization does not allow Internet Explorer to access the existing 
Internet Explorer registries for the extensions that are configured with SecureLogin.

2. ZENworks Application Virtualization does not allow reading of the COM entries for SecureLogin
3. ZENworks Application Virtualization does not allow reading of the file system where 

SecureLogin is installed.

Workaround: While virtualizing an application, the virtualization tool must include the registries or 
the file system sections of the application that SecureLogin will access to provide single sign-on. 

For example, if you virtualize Internet Explorer, you must virtualize BHO registry keys also. It will 
allow SecureLogin to provide single sign-on to Internet Explorer.
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30.3 SecureLogin Fails To Start For Domain Users On 
Windows Domains Or Domain Controller Servers
Issue: When domain users that are not assigned with administrator rights starts SecureLogin, 
SecureLogin displays the A password change has been detected. For security 
reasons, it is necessary to logout of windows and log back in. error message 
and stops working. This issue occurs on Windows Domains or Domain Controller servers. This issue 
does not occur on Windows clients.

Workaround: Perform the following steps to fix this issue on a Domain Controller server: 

1 Open the Group Policy Management console and navigate to Domain Controllers.
2 Right-click the appropriate Domain Controller Policy and click Edit.
3 In the Group Policy Management Editor window, click Computer Configuration.
4 Go to Policies > Windows Settings > Security Settings > Local Policies > User Rights Assignment.
5 Click Allow log on locally.
6 Click Add User or Group to add the appropriate users or group.
7 Click OK.

30.4 Recovering a Forgotten Password
The Client Login Extension provides password recovery support for applications that are accessed 
through SecureLogin. The password recovery support is available for graphical authentication 
interfaces such as GINA/Credential Provider for LDAP clients, Novell Client, and Microsoft clients. 
Clients in the Windows operating systems support Credential Provider model of graphical 
authentication interface. Clients in other operating systems support GINA/Credential Provider 
model of graphical authentication interface.

NOTE: To enable the Client Login Extension support for Novell Client in a SecureLogin setup, install 
Novell Client before installing Client Login Extension.

The password recovery support through Client Login Extension is also available for locked 
workstations and for workstations in which user operations are controlled by Desktop Automation 
Services.

To know more about using Client Login Extension tool for recovering forgotten passwords, see the 
Client Login Extension Guide.

30.5 Smartcard Does Not Work with SecureLogin in 
Windows 11
Issue: In Windows 11, there can be instances where Smartcard does not work with SecureLogin. 

Workaround: To workaround this issue, perform the following:

1 Disable VBS with group policy. 
For more information, see Disable VBS with group policy.
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2 Disable LSA protection.
For more information, see Disable LSA protection.

NOTE: This workaround is verified only for ActivClient 7.4.1.
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31 31Feature Use Cases

 Section 31.1, “AutoPass License Server Use Case,” on page 205

31.1 AutoPass License Server Use Case
Mark, an administrator with Reltic Data Inc. recently placed an order for 10000 paper-based licenses 
of NetIQ SecureLogin to enhance the single sign-on for employees. Currently, the organization is 
restructuring and it has led to employee provisioning and de-provisioning. This scenario has led to a 
challenge for Mark and his associates to track the licenses for any of the following tasks:

 Active SecureLogin user count: Number of SecureLogin users in the organization
 Centralized license management: Manage SecureLogin license in the web portal
 Actual SecureLogin usage reporting: Increase or decrease licenses based on usage
 Email notification: License expiry email notification

Mark and his associates are relying on different methods to keep a track of all the licenses, and it is a 
challenging task to keep tabs on the licenses and record updated data.

31.1.1 Solution
NetIQ SecureLogin is providing integration with AutoPass License Server (APLS), a Micro Focus web-
based solution for managing your Micro Focus Software product licenses. It helps you organize and 
manage your product licenses, server users, and client users. Following are the benefits of this 
integration:

 Centralized Management of SecureLogin license
 Usage Tracking and Report: Track the current SecureLogin licenses in use, as well as the usage 

history for APLS administrator to get a quick trend report on the product usage.
 License Reservation and Blocking: Reserve SecureLogin license capacity for groups or clients
 Centrally manage license, product, and custom usage
 Generate usage reports to manage pay-per-use billing

How does this solution benefit Mark?
Mark gets the following benefits with the current solution:

 Track and monitor the number of users using SecureLogin
 Get an actual number of SecureLogin instances in the organization
 Be compliant with the license usage based on the reporting option
 Receive license expiry email notification
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In addition to these benefits, he can take the following decisions:

 If his organization has purchased licenses higher than the regular usage required, he can work 
with the Micro Focus team to reduce the capacity and save cost

 If the maximum license count is reached, a request for more licenses can be placed. It is an 
opportunity to fix up the gap.

More than 120 products of Micro Focus are using AutoPass license technology. 26 products have 
integrated with AutoPass License Server for managing the license centrally. More teams are planning 
to integrate.
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A AError Messages

SecureLogin error messages display a number code that generally includes a text description of the 
error. SecureLogin error numbers currently range between -101 and -914. Following is a list of these 
error message, their cause, and the appropriate action to take.

Some of the codes displayed in SecureLogin error messages are not native SecureLogin codes. Refer 
to the relevant application’s Help for assistance with the following:

NetIQ eDirectory: Numbers between -1 and -813

Microsoft Active Directory; Error codes such as, 0x80070002

For more information about Active Directory error codes, go to the Microsoft website.

-102: BROKER_NO_SUCH_ENTRY
Possible Cause: You tried to load an application definition or variable that does not exist. 

For example, you set up Terminal Launcher to run from a shortcut or to run a 
particular application definition, but the application definition does not exist. 

Action: Check that the name of the application definition is actually defined in 
SecureLogin. Verify that the name is the same as the name specified in the 
application definition.

-103: BROKER_INVALID_CLASS_CREATED
Possible Cause: Data has become corrupted, or you are running an earlier version. 

SecureLogin is trying to create a new version of the application definition data 
format that was stored in ANDS.

Action: Upgrade the older SecureLogin client to the new client. Install the latest 
SecureLogin software.

-104: BROKER_CREATE_CLASS_FAILED
Possible Cause: The SecureLogin client has run out of memory.

Action: Free up some memory. Try again later.

-105: BROKER_REMOVE_ENTRY_FAILED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.
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-106: BROKER_UPDATE_GET_ENTRY_FAILED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-107: BROKER_ENTRY_NOT_FOUND
Possible Cause: An attempt to load an application definition or variable that does not exist.

Action: Check that the name of the application definition is actually defined in 
SecureLogin. Verify that the name is the same as the name specified in the 
application definition editor.

-109: BROKER_SCRIPT_BUFFER_ALLOC_FAILED
Possible Cause: The SecureLogin client has run out of memory.

Action: Free up some memory. Try again later.

-110: BROKER_NO_MORE_PLATFORMS
Possible Cause: Data is corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-111: BROKER_NO_MORE_VARIABLES
Possible Cause: Data is corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-112: BROKER_NO_SUCH_VARIABLE
Possible Cause: You are trying to use an undefined variable. 

Because SecureLogin is not prompting you for the variable, data has become 
corrupted, or some other situation is preventing the software from working as 
expected.

Action: Contact NetIQ Support.

-114: BROKER_PRIMARY_NOT_AVAILABLE
Possible Cause: You are not logged on to the directory. You are using the offline cache. 

Therefore, you cannot perform some directory functions. For example, you 
cannot change your passphrase.

Action: Log in to the directory.
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-116: BROKER_HEADER_DATA_CORRUPT
Possible Cause: Data is corrupted. You might have a customized build for your site, but have 

installed a standard version of SecureLogin, or have gone from a standard 
version to a customized build for your site.

Action: Delete the local cache file and try again. If unsuccessful, contact NetIQ Support.

-120: BROKER_INVALID_PREF_DATA_TYPE
Possible Cause: Data is corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-121: BROKER_PREFERENCE_DATA_CORRUPT
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-122: BROKER_TARGET_ENTRY_LIST_NOT_LOADED
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-123: BROKER_CACHE_PASSWORD_INCORRECT
Possible Cause: You have tried to log on from offline mode, but the password you entered does 

not match the expected password from the local cache. 

Typically, the offline password is the passphrase answer.

Action: Enter the correct passphrase answer or directory password.

-129: BROKER_ENTRY_LIST_NOT_NULL
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Delete the local cache file and try again. If unsuccessful, contact NetIQ Support.

-130: BROKER_ENTRY_LIST_NULL
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Delete the local cache file and try again. If unsuccessful, contact NetIQ Support.

-131: BROKER_YSM_LIST_NOT_NULL
Possible Cause: Memory is not handled as expected.

Action: Contact NetIQ Support.
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-132: BROKER_SYM_LIST_NULL
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-138: BROKER_SYMBOL_DATA_CORRUPT
Possible Cause: Data has become corrupted in the local cache file or in the directory.

Action: Delete the local cache file and try again. If unsuccessful, contact NetIQ Support.

-140: BROKER_SCRIPT_DATA_CORRUPT
Possible Cause: Data has become corrupted in application definitions.

Action: Delete the local cache file and try again.

-141: BROKER_PREF_INVALID
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-142: BROKER_SET_PREF_INVALID
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-145: BROKER_SECURITY_ALERT
Possible Cause: Unable to locate security keys (AuthData), but security data appears to exist. It is 

possible that someone has attempted to gain access to your security data.

Action: Contact your system administrator.

-166: BROKER_INVALID_DES_KEY
Possible Cause: Hex strings are invalid. The DES_KEY variable requires hexadecimal (0-9, A-F) 

numbers.

Action: Make sure that the DES_KEY variable contains only hexadecimal numbers.

-167: BROKER_INVALID_DES_OFFSET
Possible Cause: Hex strings are invalid. The DES_OFFSET variable requires hexadecimal (0-9, A-F) 

numbers.

Action: Make sure the DES_OFFSET variable contains only hexadecimal numbers.
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-168: BROKER_DESKEY_NOT_FOUND
Possible Cause: You tried to generate a one-time password for a platform. However, you have 

not defined the DES_KEY variable.

Action: Create the DES_KEY variable.

-169: BROKER_DESOFFSET_NOT_FOUND
Possible Cause: You tried to generate a one-time password for a platform. However, you have 

not defined the DES_OFFSET variable.

Action: Create the DES_OFFSET variable.

-171: BROKER_CACHE_FILE_OPEN_FAIL
Possible Cause: SecureLogin tried to read or write to the offline cache. However, SecureLogin is 

unable to open the cache file.

Action: Assign rights so that the specified user object has rights to the cache directory.

-173: BROKER_NO_MORE_CACHE_FILE_DATA
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-174: BROKER_CACHE_SAVE_FAILED
Possible Cause: SecureLogin is unable to save data to the offline cache.

Action: Assign rights so that the specified user object has rights to the cache directory.

-175: BROKER_CACHE_SECRETS_INCORRECT
Possible Cause: The offline cache password is incorrect for either of the following reasons:

 The key used to decrypt the cache file is not the key that the cache file was 
encrypted with. 

 If you log on as a user to a workstation and create a cache file, and then you 
go to another workstation, reset your passphrase and log on, then when 
you return to the original workstation this error message appears.

Action: Delete the cache file.

-176: BROKER_PUBLIC_KEY_READ_FAILED
Possible Cause: SecureLogin is unable to read the public key from Active Directory System.

Action: Troubleshoot Microsoft Active Directory System and Microsoft ADAM.

-177: BROKER_PUBLIC_KEY_HAS_CHANGED
Possible Cause: Data has become corrupted, or the software is not working as intended.
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Action: Contact NetIQ Support.

-179: BROKER_RTVALUE_DOES_NOT_EXIST
Possible Cause: You tried to read a runtime variable that is not defined.

Action: Check the application definition. Make sure that the variable is set before it is 
read or used as a command.

-180: BROKER_DS_VARIABLE_NOT_READ
Possible Cause: You used one of the % variables to read a directory attribute, but SecureLogin 

cannot read the variable.

Action: Make sure that you have spelled the attribute name correctly. Troubleshoot 
Microsoft Active Directory System or Microsoft ADAM.

-181: BROKER_WRONG_PASS_PHRASE
Possible Cause: The passphrase or password is incorrect. The reason could be:

 You entered the wrong passphrase.
 You tried to change your passphrase, but entered it incorrectly.
 You password protected the SecureLogin notification area (system tray) 

icon and entered the incorrect password.

Action: Enter the passphrase or password correctly.

-190: BROKER_NO_AUTH_DATA_FOUND
Possible Cause: Although the SecureLogin Entry attribute has data, the SecureLogin Auth 

attribute was blank. 

Someone deleted the SecureLogin Auth attribute.

Action: Delete the Prot:SSO Entry attribute. 

SecureLogin creates these attributes the next time you run SecureLogin.

-192: BROKER_UNABLE_TO_INSTANTIATE
Possible Cause: A module, for example, WinSSO, is unable to connect to the Combroker.

Action: If you are using Windows 95, make sure that you have the latest DCOM update, 
or reinstall Internet Explorer. 

For other platforms, reinstall SecureLogin.

-195: BROKER_FILE_TRAITS_OP_NOT_IMPLEMENTED
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.
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-196: BROKER_DUMMY_OP_NOT_IMPLEMENTED
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-199: BROKER_ERROR_COMMAND_NOT_HANDLED
Possible Cause: An application definition parser encountered an unrecognizable command.

Action: Make sure that:

 The command is spelled correctly.
 The If/EndIf blocks match.

-200: BROKER_END_OF_SCRIPT
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-201: BROKER_UNEXPECTED_END_OF_SCRIPT
Possible Cause: If/EndIf or Repeat/EndRepeat blocks do not match. SecureLogin reached 

the end of the application definition without finding an expected EndIf or 
EndRepeat command.

Action: Check the application definition. Make sure that the If/EndIg and Repeat/
EndRepeat blocks match.

-206: BROKER_BREAK_BLOCK
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-207: BROKER_END_SCRIPT_NOW
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-210: BROKER_CORPORATE_MOD_ABORTED
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-211: BROKER_ENTRY_ALREADY_ON_LIST
Possible Cause: You tried to add an application definition or variable, but an application 

definition or variable with that name already exists.
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Action: Do one of the following

 Use a different name for the application definition or variable.
 Rename the existing application definition or variable in the application 

definition editor. 

-213: BROKER_NDS_OP_NOT_IMPLEMENTED
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-214: BROKER_UNABLE_TO_GET_CURRENT_OU
Possible Cause: Data has become corrupted or the software is not working as intended.

Action: Contact NetIQ Support.

-217: BROKER_ARG_NUM
Possible Cause: In application definition language, each command expects a certain number of 

arguments. You have used either too few or too many arguments for a given 
command.

Action: Make sure you are passing the correct number of arguments to the command. 

-219: BROKER_NOT_A_NUMBER
Possible Cause: The application definition language was expecting a decimal number, but 

characters other the 0-9 appeared.

Action: Remove incorrect characters.

-220: BROKER_HLLAPI_FUNCTION_NOT_FOUND
Possible Cause: In the Terminal Launcher configuration, you specified a HLLAPI.DLL and the 

name of the function in the DLL. The name of the function cannot be found in 
the DLL.

Action: Check you have specified the correct terminal emulator type. Make sure that 
you entered the HLLAPI function correctly.

-221: BROKER_HLLAPI_OBJECT_UNINITIALISED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-222: BROKER_HLLAPI_DLL_LOAD_FAILED
Possible Cause: Terminal Launcher was unable to load the HLLAPI.DLL that you specified. The 

HLLAPI.DLL for that emulator is looking for other DLL files that do not exist or 
are not installed for that emulator.
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Action: Make sure that the path and file that you are entered for the DLL are correct. 

Check the vendor’s documentation for information about that emulator.

-223: BROKER_HLLAPI_OBJECT_ALREADY_INITIALISED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-224: BROKER_ERROR_DURING_WINHLLAPICLEANUP
Possible Cause: Terminal Launcher has called the WinHLLAPI cleanup function for a WinHLLAPI 

emulator.

Action: Check the vendor’s documentation for information about that emulator.

-225: BROKER_CANNOT_FIND_WINHLLAPISTARTUP_FUNCTION_IN_DLL
Possible Cause: In the Terminal Launcher configuration, you incorrectly specified that the 

emulator is a WinHLLAPI emulator.

Action: Make sure that you have specified the correct emulator type. 

-226: BROKER_ERROR_DURING_WINHLLAPISTARTUP
Possible Causes: The reason can be the following:

 The terminal emulator does not support the right version of HLLAPI 
(requires at least V.1.1).

 The attempt to reset a connection to a HLLAPI terminal emulator failed.

Action: Check the vendor’s documentation for information about that emulator.

-227: BROKER_CANNOT_FINDWINHLLAPICLEANUP_FUNCTION_IN_DLL
Possible Cause: In the Terminal Launcher configuration, you incorrectly specified that the 

emulator is a WinHLLAPI emulator.

Action: Make sure you have specified the correct emulator type. 

See the NetIQ Web site for information about configuring specific terminal 
emulators.

-228: BROKER_BUTTON_NOT_FOUND
Possible Cause: For a Windows single sign-on application, no button exists for the control ID you 

specified. For example, if you specified Click #3, no button exists for control ID 
#3.

Action: Specify the correct emulator type. 
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-230: BROKER_SETPLAT_FAILED
Possible Cause: The regular expression that you supplied in the SetPlat command is invalid.

Action: Check the syntax of the regular expression that you provided.

-231: BROKER_AUTH_CANCEL
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-232: BROKER_UNABLE_TO_START_PROGRAM
Possible Cause: The Run command was unable to find and start the requested program.

Action: Make sure that the executable program exists and that the path is correct.

-234: BROKER_FREE_PLATFORM_SCRIPT_NULL_PTR
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-235: BROKER_VBA_LOGIN_INTERFACE_NOT_IMPLEMENTED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-236: BROKER_CHANGEPASSWORD_INVALID_VARIABLE_SYNTAX
Possible Cause: One of the parameters that you pass to the ChangePassword command must be 

a variable. The parameter that you provided is not a variable.

Action: Specify a variable.

-237: BROKER_MAD_COMMAND_SET_INVALID_VARIABLE_SYNTAX
Possible Cause: The first parameter that you pass to the Set command must be a variable. The 

parameter that you provided is not a variable.

Action: Specify a variable.

-239: BROKER_POLICY_SCRIPT_ARG_NUM
Possible Cause: One of the commands in a password policy script has too few or too many 

arguments.

Action: Include the correct number of arguments.
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-240: BROKER_VALID_CHARS_OUTNUMBERED
Possible Cause: A password is unable to satisfy a password policy. This is because the maximum 

number of allowable characters is less than the minimum number of allowable 
characters.

Action: Set the maximum number of a particular class of characters to a greater number 
than the minimum number of specified allowable characters.

-241: BROKER_PASSWORD_LOGIC_ERROR
Possible Cause: You have incorrectly set up a password policy. No password can satisfy all the 

settings.

Action: Work through each restriction in the password policy, and make sure that one 
restriction does not contradict another restriction in the policy.

-242: BROKER_EXECEPTION_CHARACHER_FOUND
Possible Cause: You entered a password that contains a character that is not allowed.

Action: Use allowable characters in your password.

-243: BROKER_PASSWORD_TOO_SHORT
Possible Cause: You entered a password that does not have enough characters.

Action: Provide enough characters in your password.

-244: BROKER_PASSWORD_TOO_LONG
Possible Cause: You entered a password that has too many characters.

Action: Enter the correct number of characters.

-245: BROKER_INSUFFICIENT_UPPERCASE_CHARS
Possible Cause: You entered a password that has too few uppercase characters.

Action: Use the specified number of uppercase characters in your password.

-246: BROKER_TOO_MANY_UPPERCASE_CHARS
Possible Cause: You entered a password that has too many uppercase characters.

Action: Use the specified number of uppercase characters in your password.

-247: BROKER_INSUFFICIENT_LOWERCASE_CHARS
Possible Cause: You entered a password that has too few lowercase characters.

Action: Use the specified number of lowercase characters in your password.
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-248: BROKER_TOO_MANY_LOWERCASE_CHARS
Possible Cause: You entered a password that has too many lowercase characters.

Action: Use the specified number of lowercase characters in your password.

-249: BROKER_INSUFFICIENT_PUNCTUATION_CHARS
Possible Cause: You entered a password that has too few punctuation characters.

Action: Use the specified number of punctuation characters in your password.

-250: BROKER_TOO_MANY_PUNCTUATION_CHARS
Possible Cause: You entered a password that has too many punctuation characters.

Action: Use the specified number of punctuation characters in your password.

-251: BROKER_INSUFFICIENT_NUMERALS
Possible Cause: You entered a password that has too few numerals.

Action: Use the specified number of numerals in your password.

-252: BROKER_TOO_MANY_NUMERALS
Possible Cause: You entered a password that has too many numerals.

Action: Use the specified number of numerals in your password.

-253: BROKER_NT_FILE_TRAITS_OP_NOT_IMPLEMENTED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-256: BROKER_UNABLE_TO_GET_NT_CHACE_DIR
Possible Cause: You are using Windows NT 4 Domains mode, but you have not defined or 

mapped a Home drive.

Action: Log in as the user to determine whether the Home drive and Home path 
variables are set. If the variables are not set, use the Windows NT domain 
administrative tools to set them. 

NOTE: Version 3.6 and above do not support Windows NT.

-257: BROKER_UNABLE_TO_CREATE_NT_CACHE_DIR
Possible Cause: The user object did not have rights to create a directory on the user’s local drive.

Action: Grant the user object rights to the directory.
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-259: BROKER_MUST_BEGIN_WITH_UPPERCASE
Possible Cause: You entered a password that did not begin with an uppercase character.

Action: Enter an uppercase character at the beginning of the password.

-260: BROKER_NO_DATA_STORES_LOADED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-261: BROKER_ENTRY_SRC_OBJECT_MISMATCH
Possible Cause: You are using a platform other than NDS or eDirectory and have moved an 

object. The directory object that you are reading entries from is not the 
directory object that the entries were saved to.

Action: Manually copy and paste the scripts between the objects.

-262: BROKER_CACHE_FILE_INCORRECT_VERSION
Possible Cause: The cache file that you are trying to load was created by a later version of 

SecureLogin.

Action: Use the version of SecureLogin that created the cache file.

Install the latest version of SecureLogin.

-263: BROKER_DDE_LOGIN_INTERFACE_NOT_IMPLEMENTED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-264: BROKER_DDE_CONNECT_FAILED
Possible Cause: Terminal Launcher could not connect to a specified DDE emulator.

Action: Make sure that the emulator launched correctly and the emulator’s DDE 
support is turned on.

-265: BROKER_DDE_DISCONNECT_FAILED
Possible Cause: Failed attempt to disconnect from a DDE-supporting terminal emulator.

Action: See the vendor’s documentation.

-266: BROKER_NT_FILE__SAVE_FAILED
Possible Cause: The user object was unable to save to the equivalent of a cache file in the Home 

directory using Windows NT 4 Domains.

Action: Grant the user object rights so that the user can write files to the Home 
directory. 
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NOTE: Version 3.6 and above do not support Windows NT.

-269: BROKER_NOT_A_PASSWORD_POLICY_COMMMAND
Possible Cause: An invalid command was used in a password policy.

Action: Make sure that the command is spelled correctly.

-271: BROKER_PASSWORD_UNACCEPTABLE
Possible Cause: The password did not meet the requirements as specified in password policies.

Action: Enter the password correctly.

-273: BROKER_MSTELNET_OPERATION_NOT_SUPPORTED
Possible Cause: The generic emulator cannot support a particular operation, for example, 

SetCursor.

Action: Do not use the command for generic emulators.

-279: BROKER_EMULATOR_LAUNCH_FAILED
Possible Cause: In Terminal Launcher, you can configure the path to the executable that will run. 

However, the specified executable is unable to run.

Action: Make sure the path to the emulator is correct.

-280: BROKER_UNABLE_TO_CREATE_EMULATOR
Possible Cause: You have specified an invalid terminal type in TLAUNCH.INI (or the Terminal 

Launcher configuration).

Action: Specify the correct terminal type.

-281: BROKER_INVALID_CHARACTER_FOUND_IN_PASTE_ID_LIST
Possible Cause: A comma does not separate decimal numbers for copy IDs.

Action: For generic emulators, you must specify a set of copy control IDs. Use a comma 
to separate decimal numbers.

-282: BROKER_INVALID_CHARACTER_FOUND_IN_COPY_ID_LIST
Possible Cause: A comma does not separate decimal numbers for copy IDs.

Action: For generic emulators, you must specify a set of copy control IDs. Use a comma 
to separate decimal numbers.

-283: BROKER_UNABLE_TO_READ_TLAUCH_INI
Possible Cause: SecureLogin is unable to read the TLAUNCH.INI file because the file has been 

deleted.
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Action: Do one of the following:

 Create a blank TLAUNCH.INI file.
 Return to the default TLAUNCH.INI file by reinstalling SecureLogin.

-284: BROKER_NO_TERMINAL_TYPE_DEFINED
Possible Cause: The TLAUNCH.INI file contains an error. The terminal type for the emulator is 

not defined.

Action: Use Terminal Launcher to specify a terminal type for the emulator.

-285: BROKER_EMULATOR_INFO_NOT_FOUND
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-286: BROKER_RELOAD_NOT_ENABLED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-287: BROKER_TERMINAL-CONNECT-TRY-AGAIN
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-289: BROKER_WRONG_OBJECT_TYPE
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-290: BROKER_FILE_LOAD_FAILED
Possible Cause: You do not have enough rights to convert an earlier TLAUNCH.INI file to a later 

format.

Action: Do one of the following:

 Read an earlier TLAUNCH.INI file.
 Create a new TLAUNCH.INI file.

NOTE: Ask the administrator to assign you necessary rights.

-292: BROKER_DLL_NOT_INITIALISED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.
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-294: BROKER_SETPLAT_VARIABLE_MUST_BE_RUN_TIME
Possible Cause: The first argument to a SetPlat argument can be a variable. The variable used 

is not a runtime variable.

Action: Make the first argument a runtime variable.

-295: BROKER_ERROR_CONDITIONAL_COMMAND_NOT_HANDLED
Possible Cause: SecureLogin does not handle text in the second part of an If command.

Action: Make sure that the command is the one listed and documented correctly. 

-297: BROKER_PARSER_ELSE_STATEMENT_FOUND
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-298: BROKER_RAW_MODE_MUST_BE_SECOND_ARG
Possible Cause: For the Click command, you have placed the –X and –Y arguments before –Raw.

Action: If you use –Raw, place it as the first argument.

-299: BROKER_DISALLOWED_REPEATS_EXIT
Possible Cause: You have tried to use repeated characters in a Password Policy that does not 

allow them.

Action: Avoid repeated characters.

-300: BROKER_DISALLOWED_SEQUENTIALS_EXIST
Possible Cause: You have tried to use sequential characters in a password, but a Password policy 

does not allow them.

Action: Avoid sequential characters.

-301: BROKER_DISALLOWED_KEYBOARD_ADJACENTS_EXIST
Possible Cause: You entered a password that has an unacceptable sequence of characters.

Action: Enter an approved sequence of characters.

-303: BROKER_CHARACTER-NOT-IN-REQUIRED-POSITION
Possible Cause: You entered a password that does not have a character in a required position.

Action: Enter the password correctly.
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-308: BROKER_BAD_POSITION_ARGUMENT
Possible Cause: While calling a SetCursor command, you tried to move the cursor to an invalid 

position. For example, out of the terminal session’s boundary.

Action: Specify a valid position.

-309: BROKER_ERROR_CONVERTING_POSITION
Possible Cause: The conversion from –X and –Y coordinates for the SetCursor command has 

failed.

Action: Specify the –X and –Y coordinates for one offset from the top left-hand corner of 
the screen.

-310: BROKER_NOT_A_WRITABLE_VARIABLE
Possible Cause: You tried to save a new value to a type of variable that cannot be written to.

Action: Use a runtime or normal variable.

-311: BROKER_RUN_SCRIPT_AGAIN
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-312: BROKER_NO_OU_PERIOD_FOUND
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-314: BROKER_COPY_BACKUP_FAILED
Possible Cause: When SecureLogin begins to update the cache file, SecureLogin first copies the 

current cache file to a file with the same name, but uses the extension .GOOD. 

SecureLogin was unable to copy the file. The .GOOD file is already open because 
another process is using it.

Possible Cause: You do not have rights to create files in the directory.

Action: Ask the administrator to assign you rights to the directory.

-315: BROKER_GOTO_LABEL_ALREADY_DEFINED
Possible Cause: You have used a GoTo command, but the label that you directed it to has 

already been used.

Action: Remove the second label command.
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-316: BROKER_GOTO_LABEL_NOT_DEFINED
Possible Cause: You have used a GoTo command, but the label that you directed it to has not 

been defined.

Action: Define the label.

-317: BROKER_INCORRECT_DATABASE_VERSION
Possible Cause: The version of SecureLogin that you are using does not handle the version of 

SecureLogin that is stored in the directory.

Action: Upgrade to the latest version of SecureLogin.

-318: BROKER_DIRECTORY_CRC_DOES_NOT_MATCH
Possible Cause: Whenever SecureLogin stores an entry in Microsoft Active Directory, 

SecureLogin employs a redundancy check. If the redundancy check does not 
match when SecureLogin reloads the entry, then the data in Microsoft Active 
Directory has been corrupted.

Action: Troubleshoot Microsoft Active Directory or Microsoft ADAM.

-319: BROKER_DISALLOWED_DUPLICATE_EXIST
Possible Cause: You entered a password that has unacceptable duplicate characters.

Action: Enter the password correctly.

-320: BROKER_GOTO_LIST_ASSERTION
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-321: BROKER_SUBROUTINE_NOT_DEFINED
Possible Cause: A Call command is calling a subroutine that has not yet been defined.

Action: Define the subroutine.

-322: BROKER_UNABLE_TO_FIND_PASSWORD_FIELD
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-323: BROKER_PASSWORD_FIELD_STYLE_NOT_SET
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.
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-324: BROKER_WEB_ACTION_NOT_SUPPORTED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-325: BROKER_ENTRY_MUST_HAVE_NON_NULL_KEY
Possible Cause: You tried to add an application definition or variable that is a blank string.

Action: Provide a name for the application definition or variable.

-326: BROKER_VARIABLE_REQUIRED
Possible Cause: Some commands, for example, ReadText, require a variable to copy the data 

that they are returning to. The argument must be a variable.

Action: Change the argument to a variable.

-327: BROKER_OBJECT_NOT_FOUND
Possible Cause: Microsoft Active Directory/ADAM library was unable to allocate memory.

Action: Troubleshoot Microsoft Active Directory or Microsoft ADAM.

-328: BROKER_ADS_MEMORY_FAILURE
Possible Cause: The Microsoft Active Directory/ADAM library was unable to allocate memory.

Action: Close one or more applications and try again.

-329: BROKER_ADS_ERROR_GETTING_ATTRIBUTE
Possible Cause: Although data exists in Microsoft Active Directory/ADAM, SecureLogin is unable 

to read the data.

Action: Troubleshoot Microsoft Active Directory or Microsoft ADAM.

-330: BROKER_ADS_INSUFFICIENT_RIGHTS_TO_DELETE
Possible Cause: When you removed an application definition, SecureLogin tried to delete part of 

an attribute from Microsoft Active Directory/ADAM. However, you are unable to 
delete the attribute because you do not have sufficient rights.

Action: The administrator must assign sufficient directory rights for each user object so 
that the user can modify SecureLogin attributes.

-331: BROKER_ADS_ERROR_DELETING_VALUE
Possible Cause: Microsoft Active Directory/ADAM was unable to delete a value.

Action: Troubleshoot Microsoft Active Directory or Microsoft ADAM.
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-332: BROKER_NO_PASSWORD_FIELD_VARIABLE_IN_SCRIPT
Possible Cause: A Web application definition must have at least one Type command that has 

“password” as the second argument. 

The following lines illustrate a typical application definition:

 Type $Username
 Type $Password Password

However, the application definition has no Type command followed by the 
Password attribute.

Action: Add a Type command followed by the Password attribute.

-333: BROKER_REGEX_GET_REPLACE_STRING_FAILED
Possible Cause: On the RegSplit command, the string that you are running through the regular 

expression did not match.

Action: Change the regular expression.

-335: BROKER_REGEX_COMPILE_FAILED
Possible Cause: The syntax of the regular expression was incorrect.

Action: Revise the syntax of the regular expression.

-336: BROKER_DIRECTORY_AUTH_DATA_CORRUPT
Possible Cause: The SecureLogin:SSOAuth data attribute has become corrupt.

Action: Contact NetIQ Support.

-337: BROKER_DES_KEY_NOT_SET
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-338: BROKER_DES_INVALID_BLOCK_LEN
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-339: BROKER_INVALID_ENCRYPTION_TYPE
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.
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-340: BROKER_UNKNOWN_DATABASE_VERSION
Possible Cause: You are using an earlier version of SecureLogin.

Action: Upgrade to the latest version of SecureLogin.

-341: BROKER_USER_KEY_NOT_SET
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-343: BROKER_PRIMARY_KEY-DECRYPT_FAILED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-344: BROKER_SECONDARY_KEY_DECRYPT_FAILED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-345: BROKER_MERGE_WRONG_ENTRY_TYPE
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-348: BROKER_PASSWORD_RESET_DETECTED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-349: BROKER_UNABLE_TO_FIND_SESSION_FILE
Possible Cause: Terminal Launcher could not find a session file for an emulator.

Action: Configure Terminal Launcher with the correct path to the file for the emulator 
session.

-352: BROKER_AUTH_DATA_INCORRECT
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-353: BROKER_RECURSIVE_SCRIPT_INCLUDE_DETECTED
Possible Cause: While using the Include command, you included an application definition twice.

Action: Only include an application definition once.
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-354: BROKER_NETWORK_PASSWORD_INCORRECT
Possible Cause: You have turned on the option to prompt the user for the network password 

before the user can access options on the taskbar, and the user entered an 
incorrect password.

Action: Enter the correct password.

-355: BROKER_USER_ABORTED_LOAD_PROCESS
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-356: BROKER_INVALID_CHARACTER_FOUND_IN_STARTUP_ID_LIST
Possible Cause: For generic emulators, you specify the startup control ID. 

A comma must separate a list of numbers. You have used a character other than 
a comma.

Action: Remove unacceptable characters.

-357: BROKER_ERRO_REG_CACHE_NO_DETAILS
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-358: BROKER_ERROR_REG_CHACE_SAVE_FAILED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-359: BROKER_ERROR_REG_CACHE_SPLIT
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-360: BROKER_PASSWORD_VARIABLE_NOT_ALLOWED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-361: BROKER_NMAS_DLL_NOT_AVAILABLE
Possible Cause: SecureLogin cannot pad the DLL file for NMAS for use with the AAVerify 

command.

Action: To use features for AAVerify, install NMAS.
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-362: BROKER_NMAS_LEGACY_RELOGIN_NOT_FOUND
Possible Cause: SecureLogin could not find the NMAS relogin function in the DLL for NMAS.

Action: Install the latest version of NMAS.

-363: BROKER_STANDARD_VARIABLE_REQURED
Possible Cause: A ? variable has been used and this command requires a $ variable.

Action: Provide a $ variable.

-364: BROKER_LDAP_LOGIN_CANCELLED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-365: BROKER_LDAP_INIT_FAILED
Possible Cause: The initialization of the LDAP SSL layer failed.

Action: Contact NetIQ Support.

-367: BROKER_REG_AUTH_CACHE_MISMATCH
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-368: BROKER_LDAP_TOKEN_DELETED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-369: BROKER_CRED_LIST_NOT_NULL
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-370: BROKER_CRED_LIST_NULL
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-371: BROKER_NO_MORE_CRED_SETS
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.
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-372: BROKER_ACCESS_IS_DENIED
Possible Cause: For LDAP, you do not have rights to the area of the directory that you are trying 

to access.

Action: Grant user objects the correct rights.

-373: BROKER_HLLAPI-CONNECT_FAILED
Possible Cause: Terminal Launcher was unable to connect to the emulator.

Action: Make sure that the emulator has HLLAPI enabled.

-374: BROKER_DUPLICATE_ENTRIES_EXIST
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-375: BROKER_NOT_RUNNING_NT
Possible Cause: Although you are not running Windows NT, you tried to use a feature that is 

available only through Windows NT.

Action: Do not use that feature unless you are running Windows NT.

-376: BROKER_WINNT_CACHE_AUTH_REG_FAILED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-377: BROKER_WINNT_CACHE_AUTH_REG_WRONG_USER
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-378: BROKER_INVALID_PIPE_STRING_FOUND
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-379: BROKER_HEX_LENGTH_INCORRECT
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-380: BROKER_HLLAPI_NOT_CONNECTED_TO_PS
Possible Cause: Terminal Launcher tried to use a HLLAPI function. However, the HLLAPI DLL is 

not connected to the emulator presentation space.
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Action: Make sure that Terminal Launcher is set up correctly with the emulator.

-381: BROKER_HLLAPI_SPECIFYING_PARAMETERS_ERROR
Possible Cause: Incorrect parameters were given to a command that uses a HLLAPI function.

Action: Contact NetIQ Support.

-382: BROKER_HLLAPI_INVALID_PS_POSITION
Possible Cause: An attempt was made to move the cursor or read text from an invalid (out of 

bounds) position on the emulator presentation space.

Action: Correct the positioning parameter in the application definition.

-383: BROKER_HLLAPI_SYSTEM_ERROR
Possible Cause: Terminal Launcher is not configured correctly for the emulator.

Action: Make sure that Terminal Launcher is set up correctly with the emulator and that 
the emulator correctly supports HLLAPI.

-384: BROKER_HLLAPI_PS_BUSY_ERROR
Possible Cause: A HLLAPI function is being called while the emulator presentation space is 

unavailable.

Action: Make sure that the emulator is not being used by another HLLAPI application.

-385: BROKER_HLLAPI_INPUT_REJECTED
Possible Cause: The emulator rejected an attempt to input data into the emulator presentation 

space.

Action: Make sure that the emulator presentation space is not locked.

-386: BROKER_HLLAPI_ERROR_QUERYING_SESSIONS
Possible Cause: SecureLogin is unable to query available HLLAPI sessions.

Action: Make sure that the Terminal Launcher is set up correctly with the emulator.

-387: BROKER_LAST_NDS_USER_NOT_FOUND
Possible Cause: The last NDS or eDirectory user object, as stored in the registry, could not be 

read for use in an NMAS login.

Action: Make sure the last NDS or eDirectory user object is stored correctly in the 
registry.
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-388: BROKER_LAST_NDS_USER_UNWORTHY
Possible Cause: The last NDS or eDirectory user object, as stored in the registry, was not in the 

correct format. An NMAS login was unable to use the format.

Action: Make sure the last NDS or eDirectory user object is stored correctly in the 
registry.

-389: BROKER_NMAS_DISCONNECTED_LOGIN_NOT_FOUND
Possible Cause: NMAS disconnected login function not found in NMAS.DLL.

Action: Make sure that the correct NMAS.DLL is installed.

-390: BROKER_LDAP_SSL_INIT_FAILED
Possible Cause: SecureLogin could not initialize the LDAP SSL libraries.

Action: Contact NetIQ Support.

-391: BROKER_LDAP_SSL_ADD_CERT_FAILED
Possible Cause: SecureLogin could not open the certificate you supplied for LDAP over SSL. 

Either the file does not exist or it is in the incorrect format. If the certificate file 
specified ends in .DER, then SecureLogin uses Distinguished Encoding Rule 
(DER) format. Otherwise SecureLogin uses B64 format.

Action: Make sure that the path to the certificate is correct and that it is in DER format.

-392: BROKER_BUILTIN_VARIABLE_NOT_FOUND
Possible Cause: A built-in variable such as ?sysversion was not found.

Action: Check that the format of the variable name is ?SysVersion(system).

-393: BROKER_SCRIPT_NOT_PURELY_INDEXED
Possible Cause: While working with Web modules, you mix indexed and nonindexed commands. 

For example, you entered the following:

Type $Username #1 

Type $Password 

Action: Make sure that all commands use indexes, or remove all indexes. 

-394: BROKER_LDAP_PASSWORD_INCORRECT
Possible Cause: The password supplied to log in to LDAP was incorrect.

Action: Check the password.
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-395: BROKER_LDAP_USER_NON_EXISTANT
Possible Cause: The user name that you used to log on to LDAP does not exist.

Action: Make sure that the user name exists in the directory and that the LDAP context 
is correct.

-396: BROKER_LDAP_SERVER_DETAILS_INCORRECT
Possible Cause: One or more of the LDAP server parameters supplied was incorrect. 

Action: Check the LDAP server address and port number.

Make sure that the LDAP server you are connected to is running.

-398: BROKER_WIZ_CP_WRONG_SCRIPT_TYPE
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-399: BROKER_DIVIDE_BY_ZERO_IS_BAD
Possible Cause: Using the Divide command, you attempted division by zero.

Action: Do not attempt division by zero.

-400: BROKER_WRONG_SECTION_NAME
Possible Cause: You manually edited a wizard-generated application definition.

Action: When editing an application definition, do not edit the specially generated 
comments. Only edit the actual commands. If this error occurs, you will no 
longer be able to use the wizard for that application definition.

-401: BROKER_INVALID_GLOBAL_WIZARD_CONFIG
Possible Cause: You manually edited a wizard-generated application definition.

Action: Do not edit the specially generated comments in an application definition. Only 
edit the actual commands. If this error occurs, you will no longer be able to use 
the wizard for that application definition.

-402: BROKER_LDAP_ATTRIBUTE_DOES_NOT_EXIST_IN_SCHEMA
Possible Cause: Either of the following:

 You are running LDAP on eDirectory, but have not correctly mapped the 
LDAP attributes.

 You are running LDAP on a platform other than eDirectory. However, the 
schema is not extended for that platform.

Action: Check your LDAP attribute mappings. Extend the LDAP schema.
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-403: BROKER_AAVERIFY_DLL_NOT_AVAILABLE
Possible Cause: SecureLogin was unable to load SL_AAVERIFY.DLL.

Action: Make sure that you have the correct DLLs installed for AAVERIFY.

-404: BROKER_AAVERIFY_FUNCTION_NOT_FOUND
Possible Cause: You are using the incorrect version of SL_AAVERIFY.DLL.

Action: Check the version of SL_AAVERIFY.DLL.

-405: BROKER_AAVERIFY_CONSISTENCY_FAILURE
Possible Cause: You are using the incorrect version of SL_AAVERIFY.DLL.

Action: Check the version of SL_AAVERIFY.DLL.

-406: BROKER_AAVERIFY_ERROR
Possible Cause: You are using the incorrect version of SL_AAVERIFY.DLL.

Action: Check the version of SL_AAVERIFY.DLL.

-408: BROKER_DES_KEY_DATA_CORRUPT
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-409: BROKER_OPERATION_ABORTED_BY_USER
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-410: BROKER_NOT_A_STRING_ATTRIBUTE
Possible Cause: You are using % variables, but the attribute you are reading is not a plain string 

attribute (SYN_CE_STRING or SYN_CI_STRING on eDirectory).

Action: Check the schema definition of the attribute to confirm that the syntax is 
SYN_CE_STRING or SYN_CI_STRING.

-411: BROKER_LDAP_INVALID_DN_SYNTAX
Possible Cause: The format of your LDAP user name was invalid.

Action: Check the format of the user name that you entered.
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-412: BROKER_INVALID_OPTION_COMBINATION
Possible Cause: An invalid combination of options was passed to an application definition 

command. 

For example, you passed –Right and –Raw to the Click command.

Action: See the appropriate application definition command. 

-413: BROKER_AAVERIFY_SLOGIN_DOES_NOT_EXIST
Possible Cause: SL_AAVERIFY.DLL generates these errors. There is a problem connecting to 

the SecureLogin server.

Action: Troubleshoot service location problems by reviewing documentation on 
SecureLogin Advanced Authentication.

-414: BROKER_AAVERIFY_ERR_SLOGIN_NOT_RUNNING
Possible Cause: SL_AAVERIFY.DLL generates these errors. There is a problem connecting to 

the SecureLogin server.

Action: Troubleshoot service location problems by reviewing documentation on 
SecureLogin Advanced Authentication.

-415: BROKER_AAVERIFY_ERR_LOAD_LIB_SLPAM
Possible Cause: SL_AAVERIFY.DLL generates these errors. There is a problem connecting to 

the SecureLogin server.

Action: Troubleshoot service location problems by reviewing documentation on 
SecureLogin Advanced Authentication.

-416: BROKER_WI_GETEXENAME_ERR
Possible Cause: The wizard was unable to retrieve the executable name for the window you 

selected.

Action: Do not use the wizard for this application.

-417: BROKER_ADS_PUT_OCTET_INSUFFICIENT_RIGHTS
Possible Cause: You do not have sufficient rights to Microsoft Active Directory/ADAM to perform 

the current operation.

Action: Ask the directory administrator to assign you additional Microsoft Active 
Directory/ADAM system rights.

-418: BROKER_ADS_CLR_OCTET_INSUFFICIENT_RIGHTS
Possible Cause: You do not have sufficient rights to Microsoft Active Directory/ADAM to perform 

the current operation.
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Action: Ask the directory administrator to assign you additional Microsoft Active 
Directory/ADAM system rights.

-420: BROKER-_SLAASSO_ERR_CRYPTO_KEY_NOT_SET
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-421: BROKER_SLASSO_ERR_UNKNOWN_DATA
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-422: BROKER_SLASSO_OUT_OF_MEMORY
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-423: BROKER_ERROR_INITIALISING_DATA_STORES
Possible Cause: SecureLogin was unable to initialize either the primary or secondary datastore.

Action: Contact NetIQ Support.

-424: BROKER_UNABLE_TO_LOAD_SLOTP_DLL
Possible Cause: SLOTP.DLL could not be loaded. This DLL is required for synchronizing one-

time password to LDAP directories.

Action: Review documentation for one-time passwords.

-425: BROKER_LDAP_NO_SUCH_ATTRIBUTE
Possible Cause: You have used a % variable on LDAP. However, the requested attribute does not 

exist.

Action: Check the spelling of the attribute name against the LDAP schema.

-426: BROKER_SYS_VARIABLE_NOT_AVAILABLE
Possible Cause: A system variable, for example, ?syspassword, was requested but was not 

available. SLINA.DLL, SLNMAS.DLL or SLCREDMAN.DLL must be correctly 
installed for these variables to function.

Action: Make sure that either SLINA.DLL, SLNMAS.DLL or SLCREDMAN.DLL is 
installed.

-427: BROKER_USERNAME_UNSUITABLE_FOR_READING_SLINA_CREDS
Possible Cause: Data has become corrupted, or the software is not working as intended.
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Action: Contact NetIQ Support.

-428: BROKER_NO_EXCEPTION_HANDLER_DEFINED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-429: BROKER_EXCEPTOPN_RAISED
Possible Cause: Data has become corrupted, or the software is not working as intended.

Action: Contact NetIQ Support.

-430: BROKER_MUST_BE_CALL_OR_GOTO
Possible Cause: When using the OnException command, the second parameter must be Call 

or GoTo. 

Action: Make sure that Call is used with the OnException command.

-442: BROKER_CHAR_UCASE_NOT_IN_REQUIRED_POSITION
Possible Cause: There is not an uppercase character in a position where one is required.

Action: Check the password for compliance with the Password Policy.

-443: BROKER_CHAR_LCASE_NOT_IN_REQURED_POSITION
Possible Cause: Raised by the Password Policy code if there is not a lower case character in a 

position where one is required.

Action: Check the password for compliance with Password Policy.

-444: BROKER_PUNCTUATION_NOT_IN_REQUIRED_POSITION
Possible Cause: There is not a punctuation character in a position where one is required.

Action: Check password for compliance with Password Policy.

-477: BROKER_UNABLE_TO_GET_REGISTRY_DATA
Possible Cause: The SecureLogin application definition GetReg command could not read the 

required registry information.

Action: Contact NetIQ Support.

-478: BROKER_ERROR_PARSING_PARAMETER
Possible Cause: The registry entry name passed to the SecureLogin application definition 

GetReg command was incorrect.
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Action: Make sure that the name begins {HKCR, HKCC, HKCU, HKLM, or HKU} and 
corresponds to one of the Windows registry hives. Also, it must contain the path 
to the desired registry entry within the node.

-481: BROKER_AUTH_QUERY_ON_WRONG_OBJECT_TYPE
Possible Cause: SecureLogin has attempted to load data from a directory object of an incorrect 

type.

Action: Contact NetIQ Support.

-482: BROKER_VERSION_NO_ROLL_BACK
Possible Cause: The SecureLogin datastore version cannot be returned to an older datastore 

version after it has been set to version 6.0.

Action: Contact NetIQ Support.

-483: BROKER_SECURE_CONNECTION_REQUIRED
Possible Cause: SecureLogin cannot load sensitive data from the server over insecure 

connections.

Action: Contact NetIQ Support.

-500: BROKER_ERROR-ACCOUNT-EXPIRED
Possible Cause: SecureLogin was unable to authenticate your Active Directory account because 

your user account has expired.

Action: Contact your system administrator.

-501: BROKER_ERROR_ACCOUNT_DISABLED
Possible Cause: SecureLogin was unable to authenticate your Active Directory account because 

your user account has been disabled.

Action: Contact your system administrator.

-502: BROKER_ERROR_ACCOUNT_LOCKED
Possible Cause: SecureLogin was unable to authenticate your Active Directory account because 

your user account has been locked.

Action: Contact your system administrator.

-503: BROKER_ERROR_PASSWORD_EXPIRED
Possible Cause: SecureLogin was unable to authenticate your Active Directory account because 

your password has expired.

Action: Change your Active Directory password or contact your system administrator.
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-600: BROKER_NONFIR_INVALID_TARGET
Possible Cause: A non-directory datastore is unable to load the local rule that contains the 

required data for an object. This could be because of the following:

 Insufficient user permissions.
 File failed to download.
 File has been deleted.

Action: Contact your system administrator.

-2147016656: Error opening specified object
Possible Cause: Microsoft Active Directory code error message (value 0x80072031): There is no 

such object on the server.

Action: You have entered an incorrect object or container definition when assigning 
user rights. Reenter the correct object or container definition.
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B BSchema Updates

 Section B.1, “Schema Attributes,” on page 241
 Section B.2, “Active Directory Environments,” on page 241
 Section B.3, “LDAP Environments,” on page 244
 Section B.4, “Security Rights Assignments,” on page 246

B.1 Schema Attributes
SecureLogin adds six schema attributes to the directory. The attributes are added during installation 
using the appropriate schema extension tool, depending on your choice of directory for SecureLogin 
data storage. In Active Directory and Active Directory with LDAP environments, adsschema.exe is 
used. For Novell NDS or eDirectory environments, ldapschema.exe and ndsschema.exe is used. 

These attributes are required for the encryption and storage of SecureLogin data against directory 
objects such as user objects and organizational units. The following descriptions include the type of 
data stored for each attribute and the security rights required to permit the data to be saved for the 
SecureLogin client.

Before installing SecureLogin, you need to extend the directory schema. For information about 
extending the schema, see “Configuring and Deploying in an eDirectory Environment”in the 
SecureLogin CE 24.3 (v9.2) Installation Guide.

Run the schema tool while upgrading SecureLogin to ensure that not only the schema is extended 
properly but also the appropriate rights are set for objects accessed by SecureLogin.

B.2 Active Directory Environments
In Active Directory environments, adsschema.exe is used.

 Section B.2.1, “Protocom-SSO-Auth-Data,” on page 241
 Section B.2.2, “Protocom-SSO-Entries,” on page 242
 Section B.2.3, “Protocom-SSO-Entries-Checksum,” on page 242
 Section B.2.4, “Protocom-SSO-Profile,” on page 242
 Section B.2.5, “Protocom-SSO-Security-Prefs,” on page 243
 Section B.2.6, “Protocom-SSO-Security-Prefs-Checksum,” on page 243

B.2.1 Protocom-SSO-Auth-Data
This attribute contains all user-specific authentication data, such as the passphrase.

Attribute Name Protocom-SSO-Auth-Data
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B.2.2 Protocom-SSO-Entries
This attribute contains the following:

 All the user's login credentials, including passwords.
 Specific preferences and application definitions at the user object.
 Corporate application definitions and preferences at the container and organizational unit 

objects.

B.2.3 Protocom-SSO-Entries-Checksum
This attribute stores a checksum so that the single sign-on client can easily determine whether a 
complete reload of single sign-on adapter information is required.

B.2.4 Protocom-SSO-Profile
This attribute stores the address of the organizational unit to be redirected to.

Classes assigned to User

Syntax Octet String

Optional Flags Synchronize

X.500 OID 1.2.840.113556.1.8000.60.2

Attribute Name Protocom-SSO-Entries

Classes assigned to Container

Organizational Unit

User

Syntax Octet String

Optional Flags Synchronize

X.500 OID 1.2.840.113556.1.8000.60.1

Attribute Name Protocom-SSO-Entries Checksum

Classes assigned to Container

Organizational Unit

User

Syntax Octet String

Optional Flags Synchronize

X.500 OID 1.2.840.113556.1.8000.60.5
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B.2.5 Protocom-SSO-Security-Prefs
This attribute stores the data required for advanced passphrase policies, including administrator set 
passphrase questions and passphrase help information and settings.

B.2.6 Protocom-SSO-Security-Prefs-Checksum
A checksum used to optimize reading of the Security Preference attribute.

Attribute Name Protocom-SSO-Profile

Classes assigned to Container

Organizational Unit

User

Syntax Distinguished Name

Optional Flags Synchronize

X.500 OID 1.2.840.113556.1.8000.60.7

Attribute Name Protocom-SSO-Security-Prefs

Classes assigned to Container

Organizational Unit

User

Syntax Octet String

Optional Flags Synchronize

X.500 OID 1.2.840.113556.1.8000.60.3

Attribute Name Protocom-SSO-Security-Prefs-Checksum

Classes assigned to Container

Organizational Unit

User

Syntax Octet String

Optional Flags Synchronize

X.500 OID 1.2.840.113556.1.8000.60.6
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B.3 LDAP Environments
In LDAP environments, ldapschema.exe is used.

 Section B.3.1, “Protocom-SSO-Auth-Data,” on page 244
 Section B.3.2, “Protocom-SSO-Entries,” on page 244
 Section B.3.3, “Protocom-SSO-Entries-Checksum,” on page 244
 Section B.3.4, “Protocom-SSO-Profile,” on page 245
 Section B.3.5, “Protocom-SSO-Security-Prefs,” on page 245
 Section B.3.6, “Protocom-SSO-Security-Prefs-Checksum,” on page 245
 Section B.3.7, “Protocom-SSO-Connections,” on page 246
 Section B.3.8, “Protocom-SSO-ConnectionLimit,” on page 246
 Section B.3.9, “Protocom-SSO-ConnectionTimeToLive,” on page 246

B.3.1 Protocom-SSO-Auth-Data
This attribute contains all user-specific authentication data, such as the passphrase.

B.3.2 Protocom-SSO-Entries
This attribute contains the following:

 All the user's login credentials, including passwords.
 Specific preferences and application definitions at the user object.
 Corporate application definitions and preferences at the container and organizational unit 

objects.

B.3.3 Protocom-SSO-Entries-Checksum
This attribute stores a checksum so that the single sign-on client can easily determine whether a 
complete reload of single sign-on adapter information is required.

Attribute Name Protocom-SSO-Auth-Data

Classes assigned to User

OID 2.16.840.1.113719.2.26.4.1.1

Attribute Name Protocom-SSO-Entries

Classes assigned to Container

Organizational Unit

User

OID 2.16.840.1.113719.2.26.4.2.1 
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B.3.4 Protocom-SSO-Profile
This attribute stores the address of the organizational unit to be redirected to.

B.3.5 Protocom-SSO-Security-Prefs
This attribute stores the data required for advanced passphrase policies including administrator set 
passphrase questions and passphrase help information and settings.

B.3.6 Protocom-SSO-Security-Prefs-Checksum
A checksum used to optimize reading of the Security Preference attribute.

Attribute Name Protocom-SSO-Entries Checksum

Classes assigned to Container

Organizational Unit

User

OID 2.16.840.1.113719.2.26.4.5.1 

Attribute Name Protocom-SSO-Profile

Classes assigned to Container

Organizational Unit

User

OID 2.16.840.1.113719.2.26.4.17.1 

Attribute Name Protocom-SSO-Security-Prefs

Classes assigned to Container

Organizational Unit

User

OID 2.16.840.1.113719.2.26.4.4.1

Attribute Name Protocom-SSO-Security-Prefs-Checksum

Classes assigned to Container

Organizational Unit

User

OID 2.16.840.1.113719.2.26.4.6.1
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B.3.7 Protocom-SSO-Connections
This attribute stores the connection information, ie., the ip address along with the timestamp.

B.3.8 Protocom-SSO-ConnectionLimit
This attribute stores the configuration parameter indicating the number of concurrent connections 
that are allowed for the user.

 The value of this parameter can be set between 0 and 32.
 The default value is 0, where 0 indicates that unlimited connections are allowed and the feature 

is disabled for the user.

B.3.9 Protocom-SSO-ConnectionTimeToLive
This attribute stores the configuration parameter that indicates how long the connection 
information will be stored. The value is stored in minutes.

 The value of this parameter can be set between 0 and 65536 (Slightly more than 45 days).
 The default value is 65536. This indicates that any entry in the Protocom-SSO-Connections 

attribute that is older than 45 days is considered outdated and hence will be removed.

B.4 Security Rights Assignments
 Section B.4.1, “User-Based Attributes,” on page 246
 Section B.4.2, “Container-Based Attributes,” on page 247

B.4.1 User-Based Attributes
The directory user objects for people using the SecureLogin requires the following attribute rights 
against their own objects.

Attribute Name Protocom-SSO-Connections

Classes assigned to User

OID 2.16.840.1.113719.2.26.4.7.1

Attribute Name Protocom-SSO-ConnectionLimit

Classes assigned to User

OID 2.16.840.1.113719.2.26.4.7.2

Attribute Name Protocom-SSO-ConnectionTimeToLive

Classes assigned to User

OID 2.16.840.1.113719.2.26.4.7.3
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B.4.2 Container-Based Attributes
In addition, users require the following directory attribute rights against all container objects.

Attribute Name Entry Rights Required

Protocom-SSO-Auth-Data Read/Write

Protocom-SSO-Entries Read/Write

Protocom-SSO-Entries-Checksum Read/Write

Protocom-SSO-Profile Read/Write

Protocom-SSO-Security-Prefs Read/Write

Protocom-SSO-Security-Prefs-Checksum Read/Write

Protocom-SSO-Connections Write/Public Read

Protocom-SSO-ConcurrentConnectionLimit Public Read

Protocom-SSO-ConcurrentConnectionTimeToLive Public Read

Attribute Name Entry Rights Required

Protocom-SSO-Entries Read

Protocom-SSO-Entries-Checksum Read

Protocom-SSO-Profile Read

Protocom-SSO-Security-Prefs Read

Protocom-SSO-Security-Prefs-Checksum Read
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